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警告： 
 

高电压 
本设备运行时会使用高电压。 

 

如果您没有采取所有安全预防措施， 
测量端子上可能存在接触致命电压！ 

 
 

● 当红色指示灯亮起时，表示测量端子处可能出现致命电压（±10 kV 
直流/脉冲）。 

● 通常使用联锁功能 
 

● 除非工作空间周围有熟悉仪器操作和危险或进行急救的其他人员，

否则不得操作仪器。 

● 在某些条件下，低于 ±500 V 的电势可能导致死亡。因此，必须始终

采取充分的预防措施！ 
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简介 
Keysight B1505A 功率器件分析仪/曲线追踪仪是测量和表征功率器件的强大

工具。 

本快速入门/自定进度演示指南适用于高达 1500A 和 10 kV 的高功率器件，

以分步说明的方式介绍了 B1505A 的高功率测量能力和独特功能。 

本指南中包含的每个测试都包含测试器件的电缆连接和测试参数设置的分

步说明，您只需遵循指南即可轻松设置和执行测试。 

本 B1505A 演示指南的目标系统配置是新引入的超大电流单元 (UHCU)、 
高压中电流单元 (HVMCU) 和超高压单元 (UHVU)。 

 

分步演示指南包括： 

● 从仪器到器件端子的电缆连接， 

● 测量参数的测试设置和数据提取方案， 

● 对 EasyEXPERT 软件的测试执行和分析，该软件位于 B1505A 中，提供

对 B1505A 的所有控制。 
 
 

测量高功率器件有时需要掌握器件和测量仪器的专业知识。 
例如，UHCU 和 HVMCU 在输出端口中具有串联电阻器，就像市场上所谓的

曲线追踪仪一样，与输出规定的确切电压/电流值的 SMU 相比，其输出电压/ 
电流特性略有不同。 
在脉冲测试中，测量电缆的寄生电感和测量电缆之间的杂散电容容易使超

大电流测量中的电压和电流波形失真。有时，器件在大电流工作区域中非

常容易振荡。由于这些影响，可能会出现意外或可疑的测试数据。 

B1505A 中有许多功能可以克服这些挑战，本演示指南将介绍这些主题。 

您可以按照本演示指南中的设置步骤和测量说明进行精确测量。 
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第 1 章. B1505A 的基本知识 
 
 
 
 
 
 
 
 
 
 

N1268A 超高压扩展器 

B1505A 功率器件分析仪/曲线追踪仪           N1265A 超大电流扩展器/夹具 

 
 

目标： 本章提供了与 B1505A 相关的基本信息，在开始使用 B1505A 之前最好先了解

这些信息。 
B1505A 需要相对复杂的系统配置来充分利用其高功率量程。 

本章的目的是了解 B1505A 测试组件的基本信息，这些信息对于成功进行测

量和理解测量结果至关重要。 
 

本章包含以下主题： 

1. Keysight B1505A 功率器件分析仪/曲线追踪仪 
- B1505A 测试模块信息 
- B1505A 的总输出电压/电流量程 
- 每个测试模块的输出电压/电流量程 

2. Keysight N1265A 超大电流扩展器/夹具 
- 内置测试模块选择器 

3. UHCU 和 HVMCU 输出电阻器的影响 
- 输出电阻器的影响 
- SMU 之间的差异（无输出电阻器） 

4. EasyEXPERT 软件 
EasyEXPERT 软件提供以下四种测试模式。这些测试模式各有独特之处，

本指南将介绍其要点。 

● 追踪仪测试 

● 应用测试 

● 经典测试 

● 快速测试 

N1266A HVSMU 电流扩展器 
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第 1 章. B1505A 的基本知识 
 

 

 

1-1. Keysight B1505A 功率器件分析仪/曲线追踪仪 
 

Keysight B1505A 功率器件分析仪/曲线追踪仪设计用于测量 1500 A 至 10 kV 
的最先进的高功率器件，B1505A 上的 EasyEXPERT 测量软件是专门设计用于 
MS Windows® 的应用程序。 

B1505A 主机可以测量范围广泛的功率器件，从 10 fA 到 1500 A，2 µV 到  
10 kV，具有 3,000 V CV 测量功能。 
使用 N1265A 超大电流扩展器、N1266A HVSMU 扩展器和 N1268A 超高压扩

展器，输出量程可扩展至 1500 A 和 10 kV。 

位于 B1505A 上的 EasyEXPERT 软件提供实时曲线追踪仪界面和直观灵活的数

据管理和分析环境。 
 
 
 

B1505A 测试模块： 
 

B1505A 有 10 个模块插槽，支持以下模块  

B1510A 高功率 SMU (HPSMU) 10 fA~1 A/2 µV~200 V 

B1511A 中功率 SMU (MPSMU) 10 fA~100 mA/0.5 µV~100 V 

B1512A 大电流 SMU (HCSMU) 10 pA~1 A/200 nV~40V（直流）或 10 pA~20 A/ 
200 nV~20 V（脉冲） 

B1513B 高压 SMU (HVSMU) 10 fA~4 mA/200 µV~3000 V 或 10 fA~8 mA/ 
200 µV~1500 V 

B1514A 中电流 SMU (MCSMU) 10 pA~100 mA/200 nV~30V（直流）或  
10 pA~1 A/200 nV~30V（脉冲） 

B1520A 多频 CMU (MFCMU) 1 fF~10 nF（在 1 MHz 时），具有 0~3000 V  
直流偏压，使用高压偏置三通和 HVSMU。 

 
 

通过添加以下扩展器盒，可以扩展 B1505A 的输出电压和电流。 

N1265A 超大电流扩展器/夹具 (UHCU) 500 µA~1500 A/100 µV~60 V（仅限

脉冲） 

N1266A HVSMU 电流扩展器 (HVMCU) 200 nA~110 mA/3 mV~2200V（直流）

或 4 µA~2.5 A/3 mV~2200 V（脉冲） 

N1268A 超高压扩展器 (UHVU) 10 pA~10 mA/10 mV~10 kV（直流）或  
10 pA~20 mA/10 mV~10 kV（脉冲） 

 
注意： 

使用两个 MCSMU 控制每个扩展器。如果 B1505A 中安装的 MCSMU 
不足，则在扩展器之间共享 MCSMU。 

 
注意：Windows、Windows NT、MS Windows 和 Windows Vista 是  
Microsoft Corporation 在美国和/或其他国家/地区的商标或注册商标。 
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输出电压和电流量程概况如图 1-1 所示。 

每个模块的输出和测量量程的详细信息如图 1-2 所示。 
 

图 1-1. 使用扩展器的 B1505A 输出量程。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* 按 exp(-PW/(0.22 µF x (Ro + R load) 的比值从时间

零值下降 

其中，PW：脉冲宽度，Ro：600 Ω 或 2 k Ω。 
 
 

图 1-2(a). 输出和测量量程（第 1 部分）。 
 

(A) HPSMU 输出和测量量程  

电流 

(B) MPSMU 输出和测量量程 

电流 

 
 
 
 
 
 

电压 
 

 

直流模块的电压电流量程 
10000 HPSMU 

直流 HCSMU 

100
 

脉冲 HCSMU 脉冲 
 
HVSMU 

10
 MPSMU 

10 MCSMU 
 
MCSMU 脉冲 

1 
 
 
0.

 

UHCU 
/1500A 
HVMCU 
/2.5 A 30 µs* 
HVMCU 
/1.1 A 30 µs* 
UHVU 

0.0
 UHVU 

脉冲 

0.00
 1 10 100 

电压 (V) 
1000 10000 

1 A 

500 mA 

125 mA 

-200 V 200 V 
-100 V 

100 V 

-1 A 
40 V 

20 V 

100 mA 

 
50 mA 

-100V 

20 mA 
电压 

100 V 

-100 mA 40 V 

20 V 

电
流

 (A
) 
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1 A 

脉冲 
 
直流 

100 mA 
电 

-30 V -100 mA 30 V 

-1 A 

1500 A 

500 
 

电 
-60 V 60 V 

-500 A 

-1500 A 

500 A 量程 
1500 A 量程 

图 1-2(b). 输出和测量量程（第 2 部分）。 
 

(C) HCSMU 输出和测量量程 (D ) MCSMU 输出和测量量程 

电流 电流 

 
 

 
 

 
 
 

电压 压 

 
 
 
 
 
 
 
 

(E) HVSMU 输出和测量量程 
 
 

电流 

 
(F) UHCU 输出和测量量程（仅限脉冲） 

电流 

 
 
 

 
电压  

压 
 
 
 

 
 
 

(G) HVMCU 输出和测量量程 

电流 

2.5 A 
 

 
1.1 A 

 
 
 
 
脉冲

直流 

(H) UHVU 输出和测量量程 
 
 

电流  

20 mA 

10 mA 

 
 
 
 

脉冲 

直流 

 

 
-2200 V 

-1500 V 
 

110 mA 
 
 

-110 mA 

 

 
1500 V 

 

 
2200 V 

 
电压 

-10 kV  
 
 

- 10 mA 

 
 

10 kV 

 
电压 

 
 
 

-2.5 A 

-1.1 A  

1.1 A/2200 V 量程 
2.5 A/1500 V 量程 

 
- 20 mA 20 mA 量程 

10 mA 量程 

20 A 
脉冲 

10 A 直流 

1A 

-40 V -20 V -1A 20 V 40 V 

-10 A 

-20 A 

8mA 
 
4mA 

-3000V -1500V 

1500V 3000V 
- 4mA 
 
- 8mA 

1500V 量程 
3000V 量程 
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1-2. Keysight N1265A UHC 扩展器/夹具 
 

图 1-2 所示的 Keysight N1265A UHC 扩展器 
(UHCE)/夹具用于测量封装的功率器件，它基本

上可以覆盖 B1505A 的最大输出量程，即 1500 A 
和 10 kV。 

UHCU 是 N1265A 中的内置测试单元，它自动出

现在配置中。 

其他测量单元连接至 N1265A UHCE/夹具，用于

进行封装功率器件测试。 

我们使用 N1259A 选件 020 高压偏置三通进行

电容测量。 
 

 
图 1-2. Keysight N1265A UHC 扩展器/夹具。 

 
漏极/集电极电源在模块之间自动切换 

N1265A 包括如图 1-3 所示的内置选择器，漏极/集电极电源可在 UHCU、
HVSMU/HVMCU 和 MPSMU/HPSMU 之间切换。因此，测量可以在不改变每

个测量单元之间接线的情况下继续进行，并且消除了与电缆重新连接有关

的任何错误，还减少了测试时间。 

在 HVSMU 路径中，可以插入 100 kΩ 串联电阻器以进行击穿测试。 

在栅极通道中，可以从 0 Ω、10 Ω、100 Ω和 1 kΩ 中选择一个串联电阻器来

控制测量的稳定性。 

 
 

 

图 1-3. N1265A 扩展器/夹具内置选择器的连接示例 
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最大 I = Vcomp/Rout 

If 

Rout 
Hi Force 

Rcbl 
Im 

Vcomp 
Hi Sense 

Vm DUT 
Lo Sense 提示： 

测量的电压是准确的，

因为感测到 DUT 端子处

的实际电压并将其用于

绘制曲线。 

最大 I = Vcomp/Rout 

Vcomp 

1-3. UHCU 和 HVMCU 输出电阻器的影响 

如图 1-4(a) 所示，电压源 (Vcomp) 外部的 UHCU 和 HVMCU 的高压 Force 输
出中有一个输出串联电阻器 (Rout)。电缆电阻 Rcbl 也串联到 Rout 上。 
由于没有机制来补偿这些电阻的压降，在 DUT 端子上出现的电压与用户设

置的 Vcomp 值不同。 

图 1-4(b) 显示了由图 1-4(a) 所示的电路测量的典型测量曲线。每个栅极阶跃

的漏极扫描终点在由 Vcomp/Rout 或 Vcomp/(Rout+Rcbl) 确定的直线上对齐。 
 

如果您只是想检查曲线，这通常不是问题，但如果您想执行以下操作，则会

有问题： 

- 在不知道电流值的情况下添加特定电压 

- 测量大电流，但不想施加高电压（接近 Vcomp），如图 1-4(b) 所示。 
 
 
 

图 1-4. 输出电阻器的影响。 
 
 
 
 
 
 
 
 
 
 
 
 

Lo Force 0 V 

图 1-4 (a). 简化框图 
 

图 1-4(b). Rout 下的典型测量曲线。 



第 1 章. B1505A 的基本知识 

13 

 

 

1 2 

HP/MP 
SMU 

If 

Force 
Im Rcbl 

Vf 
Rs Sense  

V
 

DUT 
2 反馈 

GNDU GNDU Force 0 V 

0 V 
3 

GNDU Sense 

参考信息： 

◆ SMU 情况 

图 1-5(a) 显示了 HP SMU 和 MP SMU 的简化框图。 
这些模块的输出块中的阻性组件（包括测试电缆中的电阻）位于 Sense 回
路内部（参见图 1-5 的        和       ），DUT 端子处出现精确的设定电压。 

图 1-5(b) 显示了 SMU 的典型 Id-Vd 测量示例。 
每个次栅极阶跃参数的扫描终点在扫描结束电压处垂直对齐。 

这意味着，在 SMU 的情况下，您可以在特定电压下进行测量，该特定电

压是您根据负载条件独立设置的。 

这与图 1-4(b) 中的结果相比有很大的差异，其中扫描结束电压根据负载电

流和输出电阻而变化。 

注意：由于当 DUT 击穿或 SMU 侧突然短路时，没有无源阻性组件作为保

护组件，因此这种结构可能不是高功率应用中的最佳选择。 
 

图 1-5(a). HP/MPSMU 的简化框图。 
 

 

图 1-5(b). SMU 的典型 Id-Vd 示例。 
 

1 
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1-4. EasyEXPERT 软件 

有四种测试模式 
 

EasyEXPERT 软件用作 B1505A 的图形用户界面 (GUI)，提供了四种可用的测试模

式：追踪仪测试、应用测试、经典测试和快速测试。 

每种测试模式都有其独特的功能。根据您的测试需求选择合适的测试模式对于

更快获得更准确的结果非常重要。下面简要介绍 B1505A 的测试模式。 
 
 

1. 追踪仪测试模式 

在需要超过 20A 的高功率测试应用中，UHCU 是主要的测量模块。 
如果在几百个电压下最大电流为 1 ~ 2 A，那么在测量中可以选择 HVMCU。 

如果您使用 UHCU 或 HVMCU，追踪仪测试模式绝对是测试模式的首选。 
图 1-6 中示例所示的追踪仪测试模式提供了一个交互式曲线追踪仪界面，允

许在测量期间使用 B1505A 的前面板旋钮实时修改参数。例如，Id-Vd 扫描的

漏极电压可以通过旋转 B1505A 的旋钮来手动改变，就像旋转曲线追踪仪的

电压标度盘一样。 
其他参数也可以在测量时进行动态更改，您可以快速确定测试条件和结果。 

追踪仪测试包括以下功能来支持您的测试： 
 

● 用于典型测量的 MOSFET、二极管、IGBT 和 BJT 的样本设置。您只需填写

测量参数即可开始测量。 

● 示波器视图，可用于监测所选测量点的电压和电流的脉冲波形。 

● 停止条件，当满足设定条件时，测量将自动中止。此功能对于击穿测试

非常有用。 

● 显示在测量显示背景中的参考轨迹，您可以比较参考轨迹和当前测量轨

迹之间的变化。 

● 回放轨迹功能可回调过去的测量轨迹。例如，您可以回调过去的测量轨

迹，直到器件分解并被销毁为止。 

● 在指定值后限制主扫描阶跃 (VAR1) 的合规性 
- 功率合规性 
- 电流合规性 
- 电压合规性 

● 标记和线功能 
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5 
6 4 

1 

2 

3 

追踪仪测试样本菜单 追踪仪测试 GUI 的说明： 

以下编号显示了开始测量的基本步骤。 

1. Tracer Test 选择选项卡 
2. 追踪仪测试样本菜单 
3. 通道定义区域 
4. 测量参数设置区域 
5. 单次/重复测量按钮 
6. 控制扫描/测量参数的旋钮 

图 1-6. 追踪仪测试模式 GUI 示例。 
 

 

Tracer Test Sample 菜单： 

Tracer Test Sample 菜单是创建高功率器件测试设置的良好起点。如果您从菜

单中选择测试样本，则该样本已由反映 B1505A 配置的默认测试设置和参数

填充。因此，您可以从这里开始编辑测试设置，并更快地开始测量。您可以

按照图 1-6 中所示的步骤编号来优化测试设置。 
 

提示： 

还有另一种方法可以使用追踪仪测试模式。 
由于追踪仪测试设置可以轻松转换为经典测试设置，因此您可以使用追踪

仪测试模式作为简单的测试设置和测试调试工具。 

示例测试设置将自动创建一个复杂的测试设置，交互式曲线追踪仪界面有助

于优化最终的新测试设置。 
然后，您可以将完成的设置转换为经典测试，以重复使用固定的测量参数，

或添加额外的显示轨迹和分析功能，如自动标记或线。 
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2. 按 Measure 按钮 1. 输入测试参数 

2. 应用测试模式 

应用测试模式包括一个预定义测试库，无需手动设置大多数仪器参数即可进

行常见的器件测试（如 Ic-Vce 测量）。用户可以通过直观的“填空”过程进

行测量。只需单击测量按钮即可执行测量并自动提取参数。 
 
 

图 1-7 中所示的应用测试模式是 B1505A 附带的预定义测试库，它包括基本且

常用的测试，例如 Id-Vd 测量。用户只需键入测量参数即可开始测量，并且只

需按下测量按钮，即可显示包含由测量自动提取的适当数据的测试结果。 

它很简单，很容易添加像示例这样的修改。您可以参考应用说明 B1500A-4
“Customizing Keysight B1500A EasyEXPERT Application Tests”，是德科技部

件号：5989-5167EN。 

总之，如果应用测试满足您的要求，它就是最佳选择。如果不是，则有两

种选择：一个是修改现有的应用测试定义，另一个是转到经典测试模式。 

 
图 1-7. 应用测试 GUI。 
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3. 经典测试模式 

通过经典测试模式可完全访问 EasyEXPERT 软件的所有测量和分析功能。 
在追踪仪测试模式中创建的测量设置可以导入到经典测试模式中，并且可以

在其中添加自动分析计算。然后，生成的经典测试设置可以交互使用，也可

以用于自动测试。 
 

使用经典测试模式可以覆盖应用测试库中未包含的任何应用。 

图 1-8 显示了一个示例经典测试设置窗口，其中显示 

1. Channel Setup 页面， 

2. Measurement Setup 页面和 

3. 可选的 SMU 参数设置子面板以及 

4. Display setup 页面，这是开始测量前必须填写的基本页面。 
 

图 1-8. 经典测试测量参数设置面板示例。 
 

1. 

2. 

3. 

4. 
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将按顺序执行选定

的测试。 

与预定义的应用测试相比，设置新的经典测试定义需要更多的知识，如 
B1505A 的器件和 SMU 之间的连接以及 SMU 的功能设置，如图 1-8 所示。 
一般来说，与应用测试相比，用户在经典测试中可以更直接地与 SMU 控件

交互，应用测试对用户来说有点像黑盒，只有潜入应用测试定义才能了解内

部设置。 
 
 
 

4. 快速测试模式 
 

快速测试模式提供了一种简便的方法，可以在追踪仪测试、应用测试或经典

测试模式中自动创建测试设置，而无需进行任何编程。您可以使用 EasyEXPERT 
提供的晶圆探头驱动程序使整个晶圆的测试夹具和晶圆上测试的测试序列实

现自动化。 
 
 

图 1-9. 快速测试按顺序执行选定的测试。 
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第 2 章. 测量准备工作 
 

目标： 第 2 章介绍了开始 B1505A 测量之前对 B1505A 进行的以下准备工作。 

1. 使用 B1505A 之前 

2. 演示中使用的仪器和附件 

3. 演示中使用的器件 

4. B1505A 和扩展器/夹具之间的电缆连接 

5. 启动 B1505A 

6. 更新 EasyEXPERT 版本 A.05.00 的应用测试库 
 

本章的目的是启动 B1505A 并设置 EasyEXPERT，为测量做准备。 

 
2-1. 使用 B1505A 之前 

 

警告 Keysight B1505A 的 Force、Sense 和 Guard 端子存在潜在危险电压（UHVU 
为 10 kV，HVSMU 为 3 kV，HVMCU 为 2.2 kV，HPSMU 为 200 V）。为了防

止发生电击，在使用 B1505A 期间必须遵守以下安全预防措施。 
 

● 使用三芯交流电源线将机柜（如果使用）和 B1505A 连接到电气接地

线（安全接地线）。 

● 必须在 B1505A 和测试夹具之间连接联锁电缆。 

● 定期检查以确认联锁功能可正常运行。 

● 请勿修改联锁电路。 

● 请勿使用延长电缆将 DUT 连接到测试夹具外部，但提供测试夹具同等

安全性的晶圆探头除外。 

● 在接触 Force、Sense 和 Guard 端子的连接之前，应关闭 B1505A 并将

任何电容器放电。如果不关闭 B1505A，请执行以下所有操作，不论 
B1505A 设置如何。 

- 按 Stop 键可关闭模块输出。 

- 确认“高压”指示灯没有点亮。 

- 打开屏蔽盒检修门。 

- 将连接到 SMU 的任何电容器放电。 
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2-2. 测量示例中使用的仪器和附件 
 

我们在测量示例中使用以下 B1505A 配置， 
 

 
图 2-1. 示例中使用的 B1505A 配置。 

 
 

 
 
至 N1265A 选择器输入 

或 
N1266A HVMCU 输入的漏极/集电极 
 

 
特殊要求的额外模块。（未在标准演示

配置中使用。） 
 
 

至 N1265A/N1266A/N1268A 扩展器的

电压/电流控制输入 
 

    至栅极 

    用于电容测量 
 

    至 N1265A 选择器输入的漏极/集电极 
 
 
 

Keysight B1505A 功率器件分析仪/曲线追踪仪配置： 

标准 B1505A 演示配置包括以下测试模块。 

● 1 X HVSMU (B1513B) 高压 SMU 

● 1 X HCSMU (B1512A) 大电流 SMU 

● 4 X MCSMU (B1514A) 中电流 SMU 

● 1 X MFCMU (B1520A) 多频 CMU 

● 1 x MPSMU (B1511A) 中功率 SMU 

● 1 x GNDU 接地单元（在 B1505A 主机中提供） 
 
 

演示中使用的扩展器和电缆： 

图 2-2 显示了 N1265A UHC 扩展器/夹具、N1266A HVMC 扩展器和 N1268A UHV 
扩展器。 

图 2-3 显示了用于连接扩展器/夹具和 B1505A 的电缆。 

图 2-4 显示了测试夹具内使用的测试导线/电缆。 

MCSMU 

MCSMU 

GNDU 

MPSMU 

MFCMU 

MCSMU 

MCSMU 

HCSMU 

HVSMU 
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N1265A UHC 扩展器/夹具 

图 2-2. Keysight N1265A UHC 扩展器/夹具、N1266A HVMC 扩展器和 N1268A UHV 扩展器。 
 
 
 
 
 
 
 
 
 

 

N1266A HVMC 扩展器 N1268A UHV 扩展器 
 

图 2-3. 用于连接 B1505A 和 N1265A/N1266A/N1268A 扩展器/夹具的电缆。 

   
16493T 高压三轴电缆 

 

16493S HCSMU 电缆 

16493L GNDU 三轴电缆 
 
 

16493V UHV 电缆： 
高压侧 

16494A 三轴电缆 
 
 

16493V SHV 电缆： 

 

 

N1300A CMU 电缆 16493J 联锁电缆 16493G 数字 I/O 电缆 
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图 2-4. 用于连接夹具内部的电缆/导线。 
 

 

集电极/漏极和发射极/源极 
Force 导线 

 
 

通用 Force/Sense 导线 
 

N1265A-041 
热电偶 

用于电容测量的 SHV 电缆和 SHV 
香蕉适配器 

 

UHVU 测试电缆 

 
 

 
 

N1260A 高压偏置三通 



第 2 章. 测量准备工作 

23 

 

 

 

2-3. 测量示例中使用的器件 
在本指南的测量中使用了以下器件。 
选择器件类型以覆盖 B1505A 的最大输出量程，如 

- 大电流 MOSFET (HCMOS)：IRFP4004 覆盖超过 500A。 
- 高压 MOSFET (HVMOS)：IXTH1N250 覆盖超过 2500 V。 
- IGBT：FGA180N33ATD 覆盖中电压和电流（330 V，450 A） 
- 高压二极管：GP-02-40 覆盖 4 k ~ 8 kV（2 个串联）。 

 

图 2-4. 本指南中使用的器件。 
 

 

IRFP4004 
HC MOS 

IXTH1N250 
HV MOS 

FGA180N33ATD 
IGBT 

GP02-40 
4 kV 二极管 

 

演示器件的典型规格 

1. 大电流电源 MOSFET：IRFP4004Pbf 
o VDSS：40 V 
o Rds(on)：在 Vgs=10 V，Id=195 A 时典型值为 1.35 mΩ（最大值 1.70 mΩ） 
o ID 最大值：在脉冲为 100 µs，VD=10V 时为 350A 

在 Vd=2.5 V 时为 1390 A 
o SOA：在 Tc=25 °C，脉冲为 100 µs 时为 3.5 kW 
o Vth：在 Id=250 µA 时为 2~4 V 
o Coss：在 Vd=25 V 时为 2360 pF 典型值 

2. 高压功率 MOSFET：IXTH1N250 
o VDSS：2500 V 
o Rds(on)：最大 40 Ω 
o ID 最大值：在脉冲为 100 µs 时为 6 A，在 Tc=25 °C 时为 5 kW 
o SOA：在 Tc=25 °C，脉冲为 100 µs 时为 3 kW 
o Vth：在 Id=250 µA 时为 2~4 V 
o Coss：在 Vd=25 V 时为 77 pF 典型值 

3. IGBT：FGA180N33ATD 
o VCES：330 V 
o VCE(sat)：在 Ic=180A 时典型值为 1.68 V 
o ID 最大值：在脉冲为 100 µs，VC=16V 时为 450 A 
o SOA：在 Tc=25 °C，脉冲为 100 µs 时为 7.5 kW 
o Vth：在 Ic=250 µA 时为 2.5~5.5 V（典型值=4 V） 
o Coss：在 Vc=30 V 时为 305 pF 典型值 

4. 超高压二极管：GP02-40 
o VRRM：4,000 V 
o IF (AV)：0.25 A 
o 在 4 kV 时的 IR：在 25 °C 时为 5 µA 
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2-4. 用于基本直流演示的 B1505A 和夹具/扩展器之间的电缆连接 
 

在开始测量之前，连接 B1505A、N1265A 超大电流扩展器 (UHCE)/夹具和 
N1266A HVSMU 电流扩展器 (HVCE) 之间的电缆。 

本部分所示的连接对于使用 N1265A UHCU 的所有直流测量都是通用的。 

注意： 
使用 UHVU 的超高压演示配置和电容测量演示使用不同的配置。它们分别

在演示部分中显示。 
 
 

图 2-5. B1505A 和扩展器的背面视图。 
 

B1505A 标准演示配置（背面） 
 

 
N1265A（背面） 

 
 
 
 
 
 
 
 
 
 
 
 

N1266A（背面） 
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1 

2 

接线框图 
 

图 2-6 显示了 B1505A 和 N1265A UHCE 以及 N1266A HVCE 之间的基本接线

框图。 
 
 

注意： 
在演示设置中，我们基本上只在 N1266A HVCE 和 N1265A UHCE 之间共享

两个电压/电流控制  MCSMU。因此，用于控制  N1265A UHCE 的两个 
MCSMU 中的四条电缆连接线以实线显示（参见      ）。 
到 N1266A HVCE 的四条虚线（参见       ）表示它们在 N1265A UHCE 之间切

换，但此时未连接。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
图 2-6. UHCU 和 HVMCU 的基本接线框图。 

 

 
联锁 N1265A（内置选择器） 

数字 I/O 电缆（N1265A 附带） 
数字 I/O 电缆（N1266A 附带） 

B1505
 输入 

16493T 
用于漏
极 高

 

输入 
HVSMU 

输出 

输出 
高 

输入    输出 
16493T 

HVSMU 

用于 HVCE 
 
用于 HVCE 

MC 
MC 

F 
S 
F 
S 

16494A 
电压控制 F 
电压控制 S 
电流控制 F 
电流控制 S 

2 

 

MCSMU 在 HVMCE 的配置和 
UHCE 的控制输入之间共享。 

16494A 
HVCE 

N1266A 1 
用于 UHC 
 
用于 UHC 

MC 
MC 

F 
S 
F 
S 

UHC 输入 
电压控制 

电流控制 

栅极 F 
栅极 S 
选择器 SMU F 
选择器 SMU S 

16493L 16493L 
GNDU 输出 

低 GNDU GND 

F 
S 
F 
S 

MC 
MP 

用于栅极 
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N1265A、N1266A 后面板 
N1265A 

Force 

11 Sense Sense Sense Sense 

10 

9 
8 7 

12 
6 

N1266A 

HVSMU 

5 
HCSMU 6 

Force Sense 

MCSMU 5 
4 

MCSMU 4 

3 MCSMU 3 

B1505A 
后面板 Force Sense MCSMU 2 

MFCMU 
2 

联锁 Sense 
MPSMU 1 

12 1 
数字 I/O 13 GNDU 

按照图 2-7 中的步骤 1 至 13 连接 B1505A 和扩展器之间的电缆，如图 2-7 所示。 

图 2-9 显示了各步骤电缆图和接头位置的细节。 
 

图 2-7. N1265A UHCE 和测试夹具的电缆连接。 
 

 
 

步骤 1： 
使用 16493L GNDU 电缆，将 B1505A 上的 GNDU 连接到 N1266A 上的 
GNDU 输入。 

步骤 2： 
使用 16494A 三轴电缆，将下部 B1511A MPSMU (SMU1) 上的 Force 
和 Sense 接头连接到 N1265A 上选择器输入上的相应接头。 

步骤 3： 
使用 16494A 三轴电缆，将底部第二个 SMU (MCSMU2) 上的 Force 和 
Sense 接头连接到 N1265A 的“栅极连接”输入接头。 
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步骤 4： 
使用 16494A 三轴电缆，将底部第三个 SMU (MCSMU3) 上的 Force 和 
Sense 接头连接到 N1265A UHC 输入的“电压控制”接头。 

步骤 5： 
使用 16494A 三轴电缆，将底部第四个 SMU (MCSMU4) 上的 Force 和 
Sense 接头连接到 N1265A UHC 输入的“电流控制”接头。 

步骤 6： 
使用 16493T 高压三轴电缆，将 B1513A HVSMU 上的 Force 接头连接到 
N1266A 的 HVSMU 输入。 

提示： 
确保用手将接头牢固地拧入到端点中，直到您感到有阻力为止。 

步骤 7： 
使用 16493L GNDU 电缆，将 N1266A HVMCU 的低压输出连接到 N1265A 
的 GNDU 输入。 

步骤 8： 
使用 16493T 高压三轴电缆，将 N1266A 的高压输出接头连接到 N1265A 
选择器输入的 HVSMU 接头。 

步骤 9： 
使用 16493J 联锁电缆，将 B1505A 上的联锁连接到 N1265A 上的联锁。 

提示： 
连接联锁电缆时，先握住黑色塑料部件，再向仪器侧的联锁接头方向

按压接头并转动它，如图 2-8 所示。 
断开联锁电缆时，先握住金属部件，再转动接头以将其拉开。 

 

图 2-8. 联锁连接。 

连接： 断开连接： 
 

按压并       转动  
拉动并 转动 

 
 

步骤 10： 
使用 16493G 数字 I/O 电缆，将 B1505A 上的数字 I/O 接头连接到 N1265A 
UHCE/夹具上的数字 I/O 输入接头。 

步骤 11： 
使用 16493G 数字 I/O 电缆，将 N1265A 上的数字 I/O 输出接头连接到 
N1266A HVCE 上的数字 I/O 输入接头。 

步骤 12： 
将电源线连接到 B1505A、N1265A 和 N1266A。 
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N1265A 侧 

图 2-9. 
 
 
 

步骤 1 

 
 

B1500A 侧 

 
 
 

N1265A/N1266A 侧 

 
 
 
 
 

步骤 2 
 
 
 
 
 

步骤 3 
 
 
 
 
 

步骤 4 
 
 
 
 
 

步骤 5 
 
 
 
 

步骤 6 
 
 
 
 
 

步骤 7 
 
 
 
 
 

步骤 8 

MCSMU 3 

三轴 SMU 电缆 N1265A 

MCSMU 4 

三轴 SMU 电缆 N1265A 

MPSMU 1 

三轴 SMU 电缆 N1265A 

GNDU 

GNDU 电缆 N1265A 

MCSMU 2 

三轴 SMU 电缆 N1265A 

N1266A HVSMU 

N1265A 
HV 三轴电缆 

N1266A GNDU 

N1265A 
GNDU 

GNDU 电缆 

B1500A 
HVSMU 

HV 三轴电缆 N1266A 
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步骤 9 
 
 
 
 
 

步骤 10 
 
 
 
 
 

步骤 11 
 
 
 
 
 

步骤 12 将电源线连接到所有 B1505A、B1265A 和 B1266A 

 
 
 
 

键盘和鼠标：步骤 13： 
启动 B1505A 之前，务必连接键盘和鼠标。 

 

键盘 鼠标 

联锁 N1265A 

联锁电缆 

N1265A 
数字 I/O 

输出 

数字 I/O 电缆 N1266A 输入 

B1500A  
数字 I/O 

输入 

数字 I/O 电缆 N1265A 
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2-5 启动 B1505A 

2-5-1 启动 B1505A 

本节介绍了以下操作。 

步骤 1. 打开 Keysight B1505A。 
步骤 2. 启动 EasyEXPERT 软件。 
步骤 3. 准备 EasyEXPERT 工作区中的用户特定工作区。 

 
步骤 1. 打开 Keysight B1505A 

收到 B1505A 后，执行以下设置。 

1. 确保待机开关设置为关闭。 

2. 在 B1505A 后面板上，确保电路公共端子通过短路棒连接

到机架接地端子。 

3. 将 Keysight 16444A-001 USB 键盘和 16444A-002 USB 鼠标

连接到 B1505A 的 USB 端口。 

4. 将 B1505A 的电源线连接到交流电源插座中。 

5. 打开测量端子（断开连接的测量器件），然后按下待机

开关（前面板右下角）以打开 B1505A。 
Windows、测量模块初始化和自我校准将启动。 

6. 默认 Windows 设置由“Keysight B1500 用户”自动登录

到 Windows，该用户应为 B1505A 的默认用户。 
 

注意： 
如果您是是德科技出厂的 B1505A 的第一个用户，则需要

执行 B1505A Windows 操作系统的初始设置。 
 

步骤 2. 启动 EasyEXPERT 

登录后，单击 Start EasyEXPERT 按钮。 
等待 EasyEXPERT 激活。 

 

 
 

注意： 
如果关闭 Start EasyEXPERT 窗口，可以通过单击 Windows 桌面上的以

下 Start EayEXPERT 快捷方式再次运行该窗口。 
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从 File 菜单中选择 Close Workspace，
关闭工作区，然后返回 EasyEXPERT  
工作区管理窗口。 

从此页面转到两页后的步骤 3f， 
创建一个新的工作区供演示使用。 

Windows 初始化后，EasyEXPERT 启动窗口将打开，并出现以下三种情况之一。 
按照说明设置 EasyEXPERT 演示工作区。 

 

情况 1：首次使用 
 
 
 
 
 
 

 
 

 
情况 2：一个现有工作区 

 
 

工作区管理窗口 

单击 Close Workspace 会
将面板更改为“情况 2”
工作区管理窗口。 

 
 
 

 
 
 
 

情况 3：两个以上的现有工作区 
 

选中 No, I want to start a new session 
单选按钮。 

转到下一页的步骤 3，创建一个新的

工作区供演示使用。 
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3b
 

3c
 

步骤 3. 准备 EasyEXPERT 的用户特定工作区 

步骤 3a. 选择 No 单选按钮并单击 Next 

 
 
 
 
 
 
 

步骤 3b. 将显示以下工作区配置程序。 
我们将创建一个新的工作区，这个工作区将在演示 B1505A 退回

时被删除。 
 

在新工作区输入字段中输入“Demo Workspace XX”作为新工作

区的唯一名称。 

步骤 3c. 单击 OK。 
 

 

转到下一页的“步骤 3d”。 
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Demo Workspace XX 

（续：演示工作区设置） 

步骤 3d. 单击新的“Demo Workspace XX”将其突出显示。 

步骤 3e. 单击 Continue。 
 
 
 
 
 

 
转到下一页的“步骤 3j”。 

 
 
 
 
 
 
 
 
 

步骤 3f. 创建新工作区。 

如果已经存在两个或多个工作区，B1505A 将显示以下工作区配置程序。 
 

步骤 3g. 单击 Create a new 
3i Workspace 单选按钮 

 
3g 步骤 3h. 在新工作区输入字段中输入 
3h  “Demo Workspace XX”作为 

新工作区的唯一名称。 
 

步骤 3i. 单击 Continue 
 

转到下一页的“步骤 3j”。 
 
 
 
 

注意： 

工作区是指在 Keysight B1505A 的内部硬盘驱动器中创建的空间，用于存储

测量设置、测量结果数据等。可以为每个用户创建和分配工作区。 

3e 

3d 
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步骤 3j. 将打开以下新的 EasyEXPERT 初始窗口。 
 

 
 
 
 
 
 
 

现在，创建了新的“Demo Workspace XX”，并完成了用户演示设置。 
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2-5-2 电源线频率设置 
 

在信号电压或电流较低的情况下，电源线频率设置对于确保测量的准确性和

稳定性非常重要。 
 

请检查演示 B1505A 的线频率设置。 

如果线频率设置与您所在地区的线频率不同，请按照以下步骤进行正确设置。 
 

● 更改的步骤： 

1. 单击 Configuration 按钮。

Configuration 窗口将打开。 

2. 单击 Line frequency 按钮打开线频率列表。 
选择 50Hz 或 60Hz。 

3. 单击 Close 按钮。 
 
 
 
 

1 

2 

3 
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2-5-3 联机帮助 
 

EasyEXPERT 提供联机帮助。 

选择 Help > EasyEXPERT Help 菜单以显示联机帮助窗口。 
 

联机帮助提供以下信息。 

● 简介 

● 使用 EasyEXPERT 

● 功能详细信息 

● 内置编程工具 

● 遇到问题的情况 
 

◆ 显示帮助的步骤： 

按照以下步骤显示联机帮助。 

1. 选择 Help > EasyEXPERT Help 菜单。 

2. Help 窗口将打开。 
 
 
 

1.  

2
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2-6. 更新 EasyEXPERT 版本 A.05.00 的应用测试库 
 

早期的演示 B1505A 系统需要修改和添加以下 EasyEXPERT 应用测试库，

以满足演示条件。 
 

添加： 

● Id-Vgs for Expanders (A.05.01) 

● Ic-Vge for Expanders (A.05.01) 

修改： 

● Vth Vgs(off)：Vth 或 Vgs(off) 测量 (A.05.00) 

● Vth Vge(off)：IGBT Vth 或 Vge(off) 测量 (A.05.00) 
 

您可以按以下方式检查 EasyEXPERT 版本。 

1. 单击 Configuration 按钮。

Configuration 窗口将打开。 

2. 请在此处查看 EasyEXPERT 版本。 
如下图所示，如果前 5 个字母为“A.05.00”，请转到“附录 1”，

并进行必要的更改。 
 

注意： 
如果是“A.05.01”或更大，则不需要额外操作。 

 
3. 单击 Close 按钮。 

 
 
 
 

1 

2 

3 
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第 3 章.演示 1：Vth 测量 
熟悉 B1505A 和 EasyEXPERT 测试操作 

 
目标： 

 
 
 
 
 
 
 
 
 
 
 

 
特性： 

 
 
 
 
 
 
 
 
 

使用的器件： 

本章包含以下主题。 

1. N1265A 夹具上的接线和器件设置。 

2. 扩展器的 EasyEXPERT 配置。 

3. 使用栅极电阻器防止振荡（提示）。 

4. 使用应用测试进行 Vth 测量 (Vd=Vg) 

5. 使用应用测试进行 Vth 测量 (Vd=Const) 
 

本章的目的是通过按照上述主题所述，使用应用测试库来测量演示器件的 
Vth。 

 

通过使用应用测试模式，您可以了解以下特性： 

● 基于 GUI：轻松理解器件连接。 

● 只需测量参数：通常，只要有测试条件参数就足以开始测量了。通常

不需要硬件设置。 

● 自动分析：通常，测量包括器件参数的自动分析结果。 
 
 
 

演示 1 使用以下器件： 

● IPFP4004 PbF HC MOSFET 

● FGA180N33ATD IGBT（可选） 

● IXTH1N250 HV MOSFET（可选） 
 
 
 

 
注意： 

如果您的 EasyEXPERT 版本为 A.05.00，则必须在开始 Vth 测量之前修改

应用测试定义。 
如果尚未修改 Vth 应用测试定义，请参考第 2-6 章。 
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1 2 3 

2 3 

3-1. N1265A 夹具内部的接线和器件设置 
 

图 3-1 显示了 N1265A UHC 扩展器/夹具内部的接线。 
如图所示，在 N1265A 测试夹具的输出端子面板和直插式封装插座模块之间

布线。 
 
 

图 3-1. N1265A 夹具内部的接线。 
 
 
 
 
 
 
 
 
 
 
 

 
 

5 
3 2 

6 7 
 

4 
 

3. 发射极/
源极 

 
 
 
 
 

集电极/漏极和发射极/ 
源极 Force 导线 

 
Force Sense 

2. 集电极/ 
漏极 

1 

Force Sense 
 
 
 
 

基极       集电极    发射极  
栅极 漏极 源极 

 
Force Sense 

 
1. 基极/
栅极 

 
 

2 3 

通用 Force/Sense 导线 

直插式封装插座（3 针） 
 
 
 

按照图 3-1 中的编号，执行以下步骤以设置夹具内的导线。 

注意： 

对于         和        ，使用能够承受 1500 A 的粗导线。对于其他连接，使用

较细的导线。 
 
 

步骤 1. 确保将 3 针直插式插座模块设置到 N1265A 夹具。 
如果没有，如图 3-1 所示设置插座模块，并通过固定插座模块四个

角上的四个销来紧固模块。 

步骤 2. 将选择器输出的低压 Force 端连接到直插式封装插座上的端子 3 低
压 Force 端（发射极/源极）。 

步骤 3. 将选择器输出的高压 Force 端连接到直插式封装插座上的端子 2 高
压 Force 端（集电极/漏极）。 
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步骤 4. 将选择器输出的低压 Sense 端连接到直插式封装插座上的端子 3 低压 
Sense 端（发射极/源极）。 

步骤 5. 将选择器输出的高压 Sense 端连接到直插式封装插座上的端子 2 高压 
Sense 端（集电极/漏极）。 

步骤 6. 将栅极输出的低压端连接到直插式封装插座上的端子 3 低压 Sense 端
（发射极/源极）。 

步骤 7. 将栅极输出的高压端连接到直插式封装插座上的端子 1 Force 端 
（基极/栅极）。 

 
 

注意： 
本部分所示的连接对于使用 N1265A UHCU 和 1266A HVMCU 的所有直流测量

都是通用的。 
 
 
 

3-2. 测试器件设置 
 

如图 3-2 所示设置测试器件 (DUT)。 

这里我们将设置大电流 MOSFET：IRFP4004Pb。 

将 MOSFET 插入 3 针插座（从左起为栅极、漏极和源极）。 
 

图 3-2. DUT 设置。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IRFP4004 
HC MOS 

G：栅极 
D：漏极 
S：源极 
C：集电极 
E：发射极 

器件 

G D S 
G C E 

 
 
 
 
 
 
 

G   D S 
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3-2. 扩展器的 EasyEXPERT 配置 
 

 配置 UHCU 的步骤： 

每个扩展器必须在通电后、在使用前进行配置。 
 

注意：在进行配置之前，确保电缆连接正确，如图 2-7 所示 

按照图 3-3 所示步骤完成后面说明的操作。步骤 1.单击 Configuration 图标。 

步骤 2. 单击 UHC Expander / Fixture 选项卡。 

步骤 3. 单击并选中 Enable Ultra High Current Unit 复选框。 

步骤 4. 在电压/电流控制 SMU 的下拉列表中选择与您在 B1505A 接线部分配

置的完全相同的控制 SMU。 
即，对电压控制 SMU 选择 SMU3:MC，对电流控制 SMU 选择 SMU4:MC。

步骤 5. 单击并选中 Enable Selector 复选框。 

步骤 6. 如果尚未在 HVSMU Current Expander 选项卡中配置 HVSMU，则将 
HVSMU 留空。 
注意：对 HVSMU 选择 SMU5:HV（如果可用）。 

步骤 7. 对 SMU 选择 SMU1:MP。 

步骤 8. 单击并选中 Enable Gate Control 复选框。 

步骤 9. 对栅极控制 SMU 选择 SMU2:MC。 

步骤 10. 将栅极控制 SMU 的输出设置为 100 欧姆作为默认值。 
可以选择 0、10、100 和 1000 欧姆。 
注意：选择 0 欧姆使器件容易发生振荡，因此不建议使用。 

图 3-3. UHCE/夹具配置。  
 

 

2. 
1. 

3. 
4. 

5. 
8. 

12. 
6. 
7. 

9. 
 
10. 

13. 

11. 14. 

16. 
15. 
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步骤 11. 单击 Apply 按钮。 
检查配置，然后执行步骤 12。 

步骤 12. 字段 12 和 13 根据之前的 EasyEXPERT 设置自动填充。 
电源指示灯从橙色变为黄色，选择器输出指示灯显示当前活动的单

元，如编号 15 所示。 

步骤 13. 您可以在此处更改默认输出模块。 
在此部分中将 SMU1:MPSMU 设置为默认值。 

 
注意：当从默认值切换到 UHC 时，此设置将产生切换继电器声音。 

步骤 14. 单击 Apply 按钮以更新活动的选定模块。 

步骤 15. N1265A 前面板的选择器指示灯变为当前选择器状态：SMU。 

步骤 16. 单击 Close 按钮关闭 Configuration 窗口。 
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3-3. 使用栅极电阻器防止振荡（提示）。 

N1265A UHC 扩展器/夹具的栅极控制中有三个内置可切换栅极电阻器和一个

短路路径，如图 3-4 所示。 

该电阻器用于防止器件振荡，并且在选择电阻器值时要考虑电路稳定性（振

荡余量）、脉冲宽度以及功率 MOSFET 的漏极栅极和 IGBT 的集电极栅极之

间的器件电容器分量。 

一般来说，当电容器分量较大且脉冲宽度较短时，需要较小的栅极电阻器。 
 

注意： 

我们通常在演示中使用 100 Ω，除非在演示说明中指定了其他值。 
 
 
 
 
 

图 3-4. 栅极电阻器。 
 
 

栅极控制 模块选择器 
 
 
 
 
 
 

100 Ω 在演示

中用作标准栅

极电阻器。 
 
 
 

F：Force 
S：Sense 

 
 
 

 
内置可切换串联电阻器，

避免器件振荡 
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在 Vd = Vg 时的 Vth 

在 Id= 250 uA 时
  

演示 1. 使用应用测试进行 Vth 测量 
 

功率器件测量的第一步是知道栅极阈值电压 (Vth) 或截止电压。 
Vth 测量开启漏极/集电极到源极/发射极通道的栅极电压，并且可作为设置

功率 MOSFET/IGBT 的栅极参数的参考点。 

可使用几种方法测量和表征 Vth，如图 3-5 所示。 

在功率器件测量中，传统的 Vth 测量方法是将栅极和漏极/集电极连接在一

起，以克服传统曲线追踪仪的测量资源限制。 
因此，功率 MOSFET 的数据表规范通常使用这种测试方法进行 Vth 提取。 

但是这种方法需要在栅极和漏极/集电极引脚之间进行额外的连接，这使测

试设置变得更为复杂。 

B1505A 可以用同样的方法进行测量，但我们有更好的方法。通过使用两个 
SMU 模拟该测量，我们可以在不改变器件的电缆连接的情况下提取准确的 
Vth，而不手动改变电缆连接的能力是测量器件参数的重点。 

我们使用两个 SMU 演示 Vth 提取。 
 
 
 
 

图 3-5. Vth 测量。 
 
 
 

 
传统的 Vth 测量方法是使用传统的曲线追踪仪

将漏极和漏极连接在一起。必须更改栅极连接！ 
 

 
 

但是，B1505A 可以通过同步扫描栅极来测量与漏

极完全相同的电压。 
 无需重新连接电缆。 

 
 
 

通过 B1505A 提取 Vth 
 
 
 

通过同步两个 SMU，可

在相同的电势扫描栅极

和漏极电压。 
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. 

2. 
6. 

4. 5. 

3. 

演示 1-1. Vth Vgsoff 应用测试 
使用应用测试进行 Vgsoff 测量（在 Vd=Vg 时） 

 

演示 1-1 演示了 Vth Vgs(off) 应用测试的 Vgs(off) 测试。该测试在相同电

压下扫描栅极和漏极。 

按照图 3-6 的编号，执行以下步骤以测量 IRFP4004 大电流功率 MOSFET 的 
vgs(off)。 

步骤 1. 单击 Application Test 模式选项卡。

步骤 2. 单击 PowerMOSFET 类别。 

步骤 3. 在搜索字段中输入“Vth”。 

步骤 4. 单击 Vth Vgs(off) 应用测试，然后单击 Select。

步骤 5. Vth Vgs(off) 应用测试定义 GUI 将打开。 
在 GUI 中输入或选择以下测试参数。 

 

MeasMode Vgsoff 漏极 SMU1:MPSMU 
IntegTime SHORT Vd 1 V 
栅极 SMU2:MCSMU IdLimit 10 mA 
VgStart 1 V Vth_Vgsoff 时的 Id 250 uA 
VgStop 5 V  

VgStep 20 mV 源极 GNDU 
 

注意：Vd 设置在 Vgsoff MeasMode 中被忽略，栅极项将应用于漏极。 
 

图 3-6. Vth Vgs(off) 应用测试。 

7. 8. 
1 
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步骤 6. 单击 Extended Setup。 
Extended Setup 窗口将打开。 
按下图所示设置相同的参数。 

 

 
步骤 7. 将设置名称更改为 Vgs(off)。 

步骤 8. 单击 Single measure  按钮。 
测量将开始。 

步骤 9. 测量结果显示在 Data Display 窗口中，其中包含标记的自动分析（参

见编号 11）和参数区域中的 Vgoff 参数提取（参见编号 12）。 

步骤 10. Test Result Editor 将打开。 
您可以添加备注、标记并选择 Save/Delete 决定。 
单击 OK 以反映您的决定。 
当您执行任何其他操作时，此编辑器的默认设置为 OK，数据将自动

保存在 Result 区域中（EasyEXPERT GUI 的底部）。 

 
注意：您可以在 Run Options 按钮中设置保存选项。 

步骤 11. 对于线性 Y1 轴和对数 Y2 轴，标记自动位于 
Id=250 µA。 

步骤 12. 显示在标记位置（内插）测量的 Vgsoff：3.23 V。 

图 3-7. Vgs(off) 应用测试结果。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. 

9. 

12. 

11. 
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5. 1. 

6. 2. 3. 

4. 

测量完成之后，如果您对结果满意，可保存测试设置以供将来使用。 
 

按照图 3-8 中的编号，执行以下步骤以保存测试设置。 

步骤 1. 单击 My Favorite Setup。 

步骤 2. 单击 Preset group。 

步骤 3. 单击 Add New Preset group。 

步骤 4. 输入组名，例如“Demo”。 
新的预设组名称显示在 My Favorite Setup 组中。 

 
注意：您可以导出或导入带有预设组单元的测试设置。 

 
步骤 5. 单击 Save 将使用 Setup name: 字段中的名称保存测试设置。 

步骤 6. 可选 

如果滚动测试参数 GUI 的垂直条，Vgs(off) GUI 的虚线连接表示

栅极和漏极 SMU 在扫描中是同步的。 
 

回顾： 

● 在 Id=250 µA 测量得到的 Vgsoff 是 3.23 V。 
规格在 2 至 4 V 之间，测量结果是合理的。 

● 如果应用测试定义满足要求，那么应用测试非常方便。 
 
 

 
图 3-8. 将设置保存到 My Favorite Setup。 
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演示 1-2. Vth Vgsoff 应用测试 
使用应用测试进行 Vth 测量（在 Vd=恒定时） 

 

此演示使用与演示 1-1 相同的设置，但 Vd 设置为恒定电压，为 1 V。 

按照以下步骤和图 3-9 所示的编号更改演示 1-1 设置。 

步骤 1. 将 MeasMode 更改为“Vth”。

步骤 2. 将设置名称更改为“Vth”。 

步骤 3. 将测试设置保存到 Demo 预设组。 

步骤 4. 设置已保存。 

步骤 5. 按 Single Measure 按钮。 
测量将开始。 

 
图 3-9. Vth Vgs(off) 应用测试：Vth 测量。 

2. 5. 

 

3. 

1. 4. 
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测试结果如图 3-10 所示。 

Vth 被提取为 3.23 V，虽然 Vd 固定为 1 V，但结果与图 3-7 所示几乎相同。 

● 保存测试结果。 
 
 

图 3-10. Vth 测试结果。 
 

 
回顾： 

一般来说，如果在饱和区域进行 Vth 测量，则 Vth 测量或 Vgs(off) 测量显示

几乎相同的数据。通常 Vd=1 V 满足此条件。 
 
 
 

演示的其他任务： 

● 尝试对 IGBT 和 HV-MOSFET 进行 Vth 或 Vgs(off) 测量。 
- IGBT：使用 Vth Vge(off) 应用测试定义。 
使用与演示 1 相同的测试参数。 

- HV MOSFET：使用在演示 1 中使用的相同应用测试和参数。 
 

提示： 

● 对于 Id-Vd 或 Id-Vg 测量，最好将 Vg 起始电压设置为 Vth 的接近值。 
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第 4 章. 演示 2：UHCU 追踪仪测试 
使用 UHCU 通过追踪仪测试模式进行超大电流测量 

 
 

目录： 4-1. N1265A 夹具内部的接线和器件设置  

4-2. 扩展器的 EasyEXPERT 配置 

4-3. 什么是追踪仪测试执行模式？ 

4-演示 2-1. Id-Vd 追踪仪测试 

4-演示 2-2. Id-Vd 追踪仪测试：示波器视图  

4-演示 2-3. Rds-ON 特性 

演示 2-3-1. Rds ON 特性（Rds On 与 Id 的关系） 

演示 2-3-2. Rds ON 特性（Rds On 与 Vg 的关系） 

4- 演示 2-4. Ic-Vc (IGBT) 追踪仪测试 

4-演示 2-5. Vce-sat (IGBT) 测试 
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第 4 章. 演示 2：UHCU 追踪仪测试 
使用 UHCU 通过追踪仪测试模式进行超大电流测量 

 
目标： 

 
 
 
 
 
 
 
 
 
 
 

 
特性： 

 
 
 
 
 
 
 
 
 
 
 
 

使用的器件： 

本章包含以下测试。 

1. Id-Vd (HC MOSFET) 

2. 示波器视图 

3. Rds on (HC MOSFET) 

4. Ic-Vc (IGBT) 

5. Vcesat (IGBT) 
 

本章的目的是通过使用追踪仪测试模式执行上述测试并了解 B1505A 特有的

测量功能。 
 

这一部分包含以下 B1505A 特性： 

● 通过 500 A 测试进行 1500A 测量（电流受测试夹具容量限制） 

● 电流和电压两种合规性模式 

● 电源合规性模式 

● 算术运算函数（Rds 提取） 

● I Force（Vce-sat 测量） 

● 示波器视图 

● 回放轨迹 
 

演示 2 使用以下器件： 

● IPFP4004 PbF HC MOSFET 

● FGA180N33ATD IGBT 
 
 

4-1. N1265A 夹具内部的接线和器件设置 
 

使用 3-1 部分和图 3-1 的相同设置。 
 
 

图 4-1. DUT 设置。 
 
 
 
 
 
 
 
 
 
 

IRFP4004 
HC MOS 

 
 
 
 
 
 

FGA180N33ATD 
IGBT 

G：栅极 
D：漏极 
S：源极 
C：集电极 
E：发射极 

 
 
 
 
 
 

G   D   S 
G   C   E 

器件 

 
 
 
 
 
 
 

G   D S 

 
 
 
 
 
 
 

G  C  E 
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4-2. 扩展器的 EasyEXPERT 配置 

 配置 UHCU 的步骤： 

每个扩展器必须在通电后、在使用前进行配置。 
 

注意：在进行配置之前，确保电缆正确连接，如图 2-7 所示。 

按照图 4-2 所示步骤完成后面说明的操作。 

注意：如果 SMU3:UHC 在步骤 12 中处于活动状态，则可以跳过以

下步骤 1 到步骤 12，然后从下一页的步骤 13 开始。 

 
步骤 1. 单击 Configuration 图标。 

步骤 2. 单击 UHC Expander / Fixture 选项卡。

步骤 3 至 10： 

如果来自演示 1，设置应该是相同的。 
否则，请按照 3-2 部分所示步骤设置配置。 

步骤 11. 单击 Apply 按钮。 

步骤 12. SMU3:UHC1 显示为活动模块。 
 
 

图 4-2. UHCE/夹具 
配置 1。 

 
 

 
1. 

2. 

3. 
4. 

5. 
8. 

12. 
6. 
7. 

9. 
 
10. 

11. 
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15. 
13. 

14. 

16. 

请参考图 4-3 执行以下步骤。 

步骤 13. 将输出默认 SMU 从“SMU1:MP”更改为“SMU3:UHC1” 

步骤 14. 单击 Apply 按钮以更新活动的选定模块。 

步骤 15. N1265A 前面板的选择器指示灯变为当前选择器状态：UHCU。 

步骤 16. 单击 Close 按钮关闭 Configuration 窗口。 
 

图 4-3. UHCE/夹具 
配置 2。 
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4-3. 什么是追踪仪测试执行模式 
 

追踪仪测试模式提供了传统和熟悉的曲线追踪仪功能，只需进行最少的测量

设置工作，就可以快速表征器件。 

使用示波器视图可以 2 µs 分辨率监测脉冲测量波形。 
施加到集电极的大电流信号可能会由于寄生组件（如测试装置的电缆电感）

而失真，这些寄生组件可能导致意外的测量结果。 
示波器视图可提供准确的波形形状以及集电极和栅极信号的相对位置，有助

于防止出现这种情况。您还可以调整计时参数，以实现最佳的测量条件。 

创新的自动记录功能可防止数据丢失，即使被测器件 (DUT) 被意外损坏。 

除了这些令人印象深刻的测量功能外，直观的 EasyEXPERT 软件环境使数据分

析变得轻而易举。您还可以轻松地将数据导出到基于 PC 的工作环境中，并使

用这些数据生成演示文稿和报告。 

追踪仪模式的预定义设置菜单使 IV 测试设置更加简单，尤其是在脉冲测量等

复杂设置中。 
此设置可以转换为经典测试模式测试定义，它是从头开始创建经典测试的便

捷方法。 
 

执行追踪仪测试的步骤： 
 

步骤 1：单击 Tracer Test 选项卡。 
将打开下图所示的 Tracer Test 模式屏幕。 

步骤 2：定义源和测量通道。 
步骤 3：设置源输出参数。 
步骤 4：连接 DUT，然后单击 Single 按钮开始单次测量。 
步骤 5.注意：重复测量用于在测量过程中更改测量参数。 
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演示 2-1：使用追踪仪测试进行 Id-Vd 测量 
 

目标： 
 
 
 
 
 
 

 
 

演示 2-1-1. 

了解以下主题： 

● 如何设置测试 

● 如何执行交互式扫描 

● 电流和电压合规性模式 

● 电源合规性模式 

● 回放轨迹 
 

演示器件 
 

如下图所示，将 IRFP4004PbF 设置为 3 针直插式插座。 
 
 
 
 
 

G：栅极 
D：漏极 
S：源极 
C：集电极 
E：发射极 

 
IRFP4004 
HC MOS 

 
下面显示了 SOA 区域的简要信息以及器件的电容信息。请参考 2-3 部分了解

器件规格。 
 
 

Vdss 40 V 

Rds (on) 典型值 

最大值 

1.35 mΩ 

1.70 mΩ 

Id（脉冲） 1390 A * 

* Tj<175 °C 
 
 
 
 
 
 
 
 
 
 
 

由于从漏极到栅极的反馈电容器 (Cdg) 很大，

所以栅极最好使用脉冲驱动而不是直流。 
栅极电压由来自漏极脉冲的电荷过度驱动，

如果栅极由直流驱动，则过量的 Id 可能在 
Vd 脉冲上升时流动。 

最大安全工作区 

10000 

1000 

1 sec 
100 

1 msec 

1
 

1 
1 10 

Vds (V) 
100 

 单脉冲  
5 °C Tj=17 

°C Tc=25 

µ 00 

 
 
 
 
 
 

G D S 
G C E 

器件 

 
 
 
 
 
 
 

G   D S 

电容与 Vds 的关系 

100000 

10000  

 Cdg 
1000 Crss 

- 

100 
1 10 

Vds (V) 

100 

 Coss 

 

电
容

 (p
F)

 

Id
s (

A)
 

Crss 
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演示 2-1-2. 演示设置： 
 

按照下面显示的步骤和图 4-4 中的编号设置 IRFP4004PbF 的 Id-Vd 追踪仪

测试设置。 
 

设置 SMU 资源的步骤： 
 

步骤 1. 单击 Sample setups 菜单。该菜单随即弹出。 

步骤 2. 选择 MOSFET 类别将打开 MOSFET 追踪仪测试定义菜单。 

步骤 3. 单击 ID-VDS 设置。将显示 ID-VDS 设置。 

步骤 4. 确保 SMU 设置如图所示。 
如果不同，请相应地重新分配漏极和栅极 SMU。 

步骤 5. 单击 Mode 列表，在列表中将 VGS 模式从 V 更改为 VPULSE。其他参

数应与图 4-4（或下表）所示参数相同。 
 

● SMU 的设置参数： 

按如下所示设置 SMU 名称、模式和函数。 
 

单元 V 名称 I 名称 模式 函数 

SMU2：MC VGS IG VPULSE VAR2 
SMU3：UHC VDS ID VPULSE VAR1 

 

图 4-4. SMU 资源的 Id-Vd 追踪仪测试设置。 
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图 4-5.X-Y 标度和 VAR1 参数的 Id-Vd 追踪仪 
测试设置。 a 

b 

展开 
VAR1 菜单 

拖动无标记区域可以轻松 
滚动菜单栏（即除以外的 
区域。） 
 

e 

c 
 d 

4. 5. 

3. 

 

电流合规性设置为不超过测试
夹具的最大电流限制。 
 
 

输出电压合规性设置为不超过

测试器件的最大电压限制。 

1. 
X-Y 最
小值 

设置脉冲延迟：Var1 为  
10 µs，用于调整栅极信号的
缓慢上升。 

将脉冲宽度设置为 60 µs ~  
100 µs 之间的值。 

2.  

准确地单击字符才能
弹出标度输入框。 

设置 X-Y 标度的步骤： 
 

按照以下步骤和图 4-5 中的编号进行操作。 

设置 X 轴的步骤： 

步骤 1. 单击最大 X 标度值。 

注意：检测触摸的焦点区域非常窄。准确地单击字符区域才能弹出

标度输入框。 

步骤 2. Horizontal Max. 输入框将弹出。 
- 输入 60 V，然后单击输入框的 X 标记或按 Enter 键。 
注意：单击其他区域将取消您的输入。 

- 水平最大标度更改为 60 V。 

设置 Y 轴的步骤： 

步骤 3. 单击最大 Y 标度值。 

步骤 4. Vertical Max. 输入框将弹出。 

- 输入 500 A，然后单击输入框的 X 标记或按 Enter 键。 
- 垂直最大标度更改为 500 A。 

设置 X-Y 最小值的步骤： 
对于最小标度，也重复上述步骤。 
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设置 VAR1 的步骤： 
步骤 5. 设置 VAR1 参数： 

a. 单击向下箭头图标  。

VAR1 字段将展开。 

b. 设置以下参数： 
 

模式 起始 停止 NOS 隔行 合规性 功率补偿 
输出电压 

补偿 

LIN-SGL 0 V 5 V 21 1 501 A OFF 39 V 

 
脉冲

基底 
脉冲

延迟 
脉冲

宽度 
双极性  

保持时间 

0 V 10 µs 100 µs OFF 0 s 
 

提示：滚动测量参数输入字段的步骤： 

c. 聚焦（指向）参数输入字段，将显示“拖动以滚动”符号（参见编号 d）。 

e. 拖动菜单栏，鼠标光标将变为“手”标记，您可以滚动查看菜单栏的

隐藏部分。 
 

设置 Var2 
 

按照以下步骤和图 4-6 中的编号进行操作。 

步骤 6. 设置 VAR2 参数 

f. 单击向下箭头图标  。

VAR2 字段将展开。 

 

起始 停止 NOS 合规性 
功率 
补偿 

脉冲 
基底 

脉冲 
延迟 

脉冲 
宽度 

保持时间 

3.5 V 6 V 6 100 mA OFF 0 V 0 s 120 µs 0 s 

g. 设置以下参数： 

注意： 

- 通过拖动菜单栏可向上滚动，如图 4-5 所示。 

- 对于 VAR2 START：输入在实验室 1 中测量的 Vth 值。 
以 0.5 V 单位舍入 Vth。例如，如果 Vth=3.1 V，则输入 3.5 V。 

- 对于 VAR2 STOP，在起始电压上加 2.5 V，使阶跃电压变为 500 mV。 
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图 4-6. VAR2 和测量时间参数的 Id-Vd 追踪仪 
测试设置。 f 

展开 
VAR1 菜单 

 
- 对于 VAR2 START： 
输入在实验室 1 中测量的 Vth 值。 
以 0.5 V 单位舍入 Vth。例如，如果 
Vth=3.1 V，则输入 3.5 V。 

 
- 对于 VAR2 STOP，在起始电压上加 

2.5 V，使阶跃电压变为 500 mV。 

g 

6. 

 

将栅极脉冲宽度设置为比

漏极脉冲宽度长 20~50 µs。 
 

8. 

7. 

h 

设置测量时间和脉冲周期的步骤： 
步骤 7. 设置测量时间（积分时间）和脉冲周期： 

h. 设置以下参数。 
 

测量 
时间 

脉冲 
周期 

10u~50us AUTO 

 
步骤 8. 将测试设置保存为唯一名称，如“ID-VD Pulse G”，表示具有栅极脉

冲的 Id-Vd 测量。 
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演示 2-1-3. 开始 Id-Vd 重复测量的步骤： 

按照图 4-7 中的编号执行以下步骤，开始重复测量。 

步骤 1. 开始测试前，关闭测试夹具盖。d 这对于防止大电流和高电压造成

任何危险尤其重要。 

步骤 2. 单击 Repeat Measure 按钮。

步骤 3. 重复测量将开始。 

步骤 4. 选中 VAR1 Stop 输入字段，并使其处于活动状态。 

步骤 5. 向右旋转旋钮以增加 VAR1 扫描电压。 
轨迹是如何改变的？ 

步骤 6. Id-Vd 实时扫描轨迹如图 4-7 所示。 

 
图 4-7. Id-Vd 追踪仪测试重复测量。 

 
1. 

 
3. 

 
关闭测试夹具的盖子 

 
 
 

 
6. 

4. 

5. 

2
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执行交互式扫描的步骤： 

按照以下步骤执行 Id-Vd 交互式扫描。 

步骤 1. 测量在中途进行，在停止电压处，即 30 V。 
- 输出电压合规性设置为 39 V，最大扫描点限制为超过该电压的一

个额外测量阶跃。 
- 每个 VAR2 扫描阶跃的 VAR1 的最终扫描点被限制在由 UHCU 的输

出电阻和 30 V 输出电压决定的最大负载线上。 

步骤 2. 该图显示 VD 处的 Id-Vd 曲线增加到 45 V。d VAR2 阶跃 1 的最大扫

描电压由于输出电压合规性限制在约 40 V。 

步骤 3. 现在 VD 增加到 50 V。d 您可以在 VAR2 阶跃 2 和 3 中看到接近击穿

曲线。 

步骤 4. 这是在 VD 停止电压处（即 60 V）进行的测量，即 UHCU 的最大 
功率。 

步骤 5. 注意，VAR2 阶跃 1 扫描在 MOSFET 最大 VD 规格的大约 40 V 处停止。 
如果没有输出电压合规性功能，MOSFET 将会损坏。 

步骤 6. 另外要注意的是，Vd=60 V 时的负载线超过了 Tc=25 °C 时 MOSFET 
100 µs SOA 限值。 

如果继续以此电平测量，MOSFET 很快就会永久损坏。 

以此电平测量时，切勿超过几秒钟，或者避免以此电平进行测量。 

尝试在增加 3.5 kW 功率合规性后进行测量，而不是执行此测量。 
图 4-8. Id-Vd 交互式 
扫描。 

下一部分将对功率合规性进行测量。 

1 
1. VD=30 V 

3 

3. VD=50 V 
输出电压 
合规性 

 

Vd 的最大

额定值 

接近 
击穿 

4 

2 2.VD=45 V 
100 µs 时的 SOA 线 

4.VD=60 V 
Var2 
step6 

Var2 阶跃 
 

负载线，其 
在 500 A 量程处输
出电阻 = 120 mΩ 

。 
6 

输出电压 

 
    

SMU 功率 
Var2 阶跃 3 放大器输出

电压 
Var2 阶跃 2 

Var2 step1 
 

 

 

由于输出电压合规

性，Id 会增加， 
但不会超过最大  
Vd 限值。 
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1.VD=30 V 

负载线，其在量程为 
1500 A，停止电压=40 V 时， 
输出电阻 = 40 mΩ 
。 

501 A 电流 
合规性限值 

输出电压 
合规性 请勿 

超过 30 V。 

Vd 的最大 
额定值 

超过 500A 电流 
合规性，量程变

为 1,500A。 

30 V 40 V 

SOA 100 µs 线 

 

在 Vd=40 V 时，要保护 DUT， 
脉冲宽度需要小于 30 µs。 

注意：在 1,500 A 量程内进行此测试极有可能损坏器件。 
◆ 为防止器件损坏： 

● 将最大停止电压保持在 30 V！ 

注意：40 V 停止电压的数据仅供参考！ 
 

使用 1,500 A 量程： 

如果漏极 UHCU 电流合规性值超过 500 A，例如 501 A，则电流量程变为 
1,500 A 量程。 

UHCU 的输出电阻变为 40 mΩ，与 500 A 量程相比，最大允许电流增加了

三倍。 
 

图 4-9 中的红线显示了 100 µs 脉冲宽度下操作的安全工作区 (SOA)。 
正如您所看到的，Id-Vd 曲线的某些部分超过了 SOA。 

请将最大停止电压保持在 30 V，以免损坏演示器件。 
 

下一页显示了器件因超出 SOA 限制而损坏的示例。 
 

图 4-9. Id-Vd 交互式扫描。 
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3 
5 

6 
2 

4 

1 

回放轨迹  

演示 2-1-4. 使用回放轨迹功能显示器件损坏轨迹的示例： 

您可以记录测量轨迹，并使用回放轨迹功能回调它们。 
图 4-10 是回放轨迹的示例，它是在因施加上一页所示的过高功率而使 
IRFP4004PgF MOSFET 损坏的瞬间记录的。 

使用回放轨迹的步骤： 

在扫描停止后，按照以下步骤使用回放轨迹功能。 

步骤 1. 单击 Replay Traces 图标。 

步骤 2. Replay Traces 窗口将打开。 

步骤 3. 通过移动滑动条，您可以回调记录的轨迹。 
您可以将记录保存到文件中，如果保存了记录，则可在以后回调它。 

以下步骤解释了器件损坏的轨迹。（仅作为示例。） 

步骤 4. 该轨迹显示了在 VD=38.7 V 和 ID=365 A 时 

器件损坏时的扫描。（参见标记数据） 
请注意，即使在回放轨迹中也可以使用标记功能。 

注意：器件损坏时的功率为 38.7 V x 365 A = 14 kW，远高于 100 µs 
脉冲中允许的 3.5 kW。 

步骤 5. 可能是接头被热量损坏，器件短路了。 
该点的电流和电压分别为 1,200 A 和 5.3 V。 
电流合规性不能限制电流，因为击穿速度太快了！ 

步骤 6. 将显示下一个扫描轨迹。 
很明显，MOSFET 在短路模式故障中损坏了。可能是短路模式故障。 

 

图 4-10. 捕捉器件损坏瞬间的回放轨迹示例。 
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演示 2-1-5. 设置功率合规性：3.5 kW 

在上一页中，显示了器件损坏的示例，即使在脉冲测量中，由于施加的功

率过大，MOSFET 也会被损坏。 

如果在测量设置中设置了适当的功率合规性，则可以避免超过 SOA 限值，

并可能防止器件损坏。 

图 4-11 显示了设置功率合规性和 3,500 W 功率合规性的测量曲线的示例。 

正如您所看到的，100 µs 脉冲的 SOA 区域与 3.5 kW 功率限制测量曲线重叠，

它还被限制在 40 mΩ 负载线内。 

 
◆ 如何设置功率合规性： 

- 在 VAR1 参数字段中设置功率补偿，如图 4-11 所示。 
 
 

电流合规性、功率合规性和电压合规性的影响： 

图 4-11 显示了三种合规性设置：电流合规性、功率合规性和电压合规性。 
 

● 输出电压合规性： 
您可以在大电流和低电压下测量器件，但还必须考虑在低电流测量区域

的最大电压限制，因为输出电阻器处的压降较小，因此会施加较高的电

压。输出电压合规性可限制低电流区域的高电压。 

● 电流合规性： 
电流合规性确保不会超过器件的最大额定电流。 

图 4-11. 3.5 kW 功率合规性、输出电压合规性和电流合规性。 
 
 

1. VD=30 V 
 
 
 
 
 

501 A 电流 
合规性限值 

输出电压

合规性 

 
3.5 kW 功率 
合规性 

（=SOA 100 µs 线） 

Vd 的最大

额定值 

 
 
 
 

功率合规性 
设置为 3.5 kW 
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演示 2-2 使用示波器视图进行 Id-Vd 追踪仪测试测量 
 
 

目标： 
 
 
 
 
 
 
 
 
 
 

演示 2-2-1. 
 
 
 
 

演示 2-2-2. 

示波器视图演示的目的是能够使用示波器视图功能并解释示波器视图波

形，以判断脉冲设置参数是否合适。 

如果发现任何问题，最好能够采取纠正措施。 

包含下列主题： 

● 如何设置示波器视图 

● 如何使用示波器视图中的结果 
 
 
 
演示器件和演示设置 

我们使用和“演示 2-1. Id-Vd 测试”相同的器件和设置。 
 
 
 
什么是示波器视图 

EasyEXPERT（版本 5 及更高版本）支持 B1505A 上的示波器视图（参考图 
4-12），用于以 2 µs 分辨率监测脉冲测量波形。 

它具有以下功能： 

● 同时显示电流/电压曲线和脉冲波形。 

● 可在任何点监测波形测量脉冲。 

● 可以使用标记线读取电压和电流。 

● 可在测量期间更改脉冲测量条件，并且可以实时验证生成的波形。 

施加到漏极/集电极的大电流信号可能会由于寄生组件（如测试装置的电

缆电感）而失真，这些寄生组件可能导致意外的测量结果。 
 

示波器视图可提供准确的波形形状以及漏极和栅极信号的相对位置，有助

于防止出现这种情况。您还可以调整计时参数，以实现最佳的测量条件。 
示波器视图减少了调试时间，同时也提高了测量数据的质量。 
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2 
3 

5 
4 

标记线 

示波器视图 

演示 2-2-3. 如何设置示波器视图： 

图 4-12 显示了 Id-Vd 追踪仪测试测量的示波器视图示例。 
您可以监测指定测量点上输出电压和电流的波形。 

在脉冲测量中，检查脉冲波形、脉冲电流以及脉冲信号中测量点的关系对

保证测量质量至关重要。 
 

 监测脉冲波形的步骤： 

步骤 1. 单击 Oscilloscope View 图标。 

步骤 2. Oscilloscope View 窗口将打开。 

您可以通过单击示波器视图参数来更改大多数参数。 

步骤 3. 可通过视图菜单选择采样参数和设置参数。 

步骤 4. 标记字段显示标记位置的时间和读数。步骤 5.显示每个参数的标度。 
 

图 4-12 的示波器视图显示了电流/电压曲线上标记的第三个 Var2 阶跃

的第 16 个 Var1 扫描点的 VDS 波形 
 
 
 

图 4-12. 脉冲 Id-Vd：示波器视图示例。 
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1
 

 

◆ 如何设置示波器视图参数： 

要设置示波器视图，请按照图 4-13 中的编号执行以下步骤。 

步骤 1. 单击 Data 菜单。 

步骤 2. 单击一个参数以在示波器上查看。 

步骤 3. 弹出菜单一次关闭一个，选定的参数将添加到标记视图字段中。 
重复编号 2 和编号 3 操作，将所有参数设置到视图中。 

步骤 4. 标度参数也显示在此区域中。 

步骤 5. 单击标记视图字段可设置采样点参数。 

步骤 6. 单击 s/div 字段可以更改时间标度。 

步骤 7. 单击时间原点编号可以更改时间原点。 

步骤 8. 如果单击编号 4 字段或 Setup 菜单中的一个参数，将弹出一个

垂直标度设置窗口。 
每个参数窗口从顶部显示垂直标度、中心参考电平和线颜色。 
单击每个参数可以设置这些垂直标度参数。 

图 4-13. 如何设置示波器视图参数。 

1 6 

2 
4 

3 8 

一次选择一个 

5 

7 
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◆ 如何使用示波器视图或波形监测器。 

图 4-14 显示了如何使用示波器视图的示例。 

按照以下步骤和图 4-14 中的编号显示波形。 

步骤1. 编号 1 中显示了示波器视图参数。 

步骤2. 要查看的数据点显示在编号 2 中，即第 7 个 Var2 阶跃的第 27 个 
Var1 扫描点。 

步骤3. 数据点显示在图上。（参见编号 3） 

步骤4. Var1 脉冲延迟和宽度分别为 10 µs 和 80 µs。 

步骤5. 示波器视图显示 VDS、ID 和 VGS。 

步骤6. 示波器视图可以放大，如图所示（参见编号 5） 

a. 显示轨迹颜色和标记点值。 

b. 单击该值可以更改水平标度。 

c. 单击该值可以更改水平中心时间。 

d. 单击图上的任意点可以设置标记。 

e. 绿色线表示测量时间窗口。 

f. 该区域显示每个参数轨迹的幅度和偏移（测量曲线的偏移）。 
 

 
图 4-14. 如何使用示波器视图？ 

3 

4 

5 
6 

b
 

a. 
 
- 参数颜色指示 
- 标记已读出 

标记线 

d. f. 
- 每个参数的

幅度和偏移 

g. 
-30 µs 

e. 
0 µs c. 

7 

1 

2 

h. 
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g. 指示实际采样开始时间（= 在编号 2 窗口中设置的延迟）。 

h. 可选： 
如果将 Var2 阶跃更改为“EACH”，则波形监测器将刷新指定 Var1 
扫描点的每个 Var2 阶跃。 

步骤7. 您可以以文本和图形格式保存示波器视图数据。 
 

设置数据保存在测试设置数据中。 
 

注意：遗憾的是，没有独立的保存-回调功能。 
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4 5 

-30 µs 0 µs 

演示 2-2-4. ◆ 提示：如何将示波器视图波形用于 Var1 脉冲延迟设置  

图 4-15 显示了使用波形设置 Var1 脉冲延迟时间的示例。 

按照以下步骤和图 4-15 所示的编号进行操作。 

步骤 1. Var1，漏极脉冲延迟从 10 µs（图 4-14 设置）更改为 0 µs（由于

栅极脉冲延迟设置为 0 µs，因此相对于栅极脉冲没有延迟）。 
脉冲宽度是相同的。 

步骤 2. 用于查看波形的数据点显示在图中。（参见编号 2） 

步骤 3. 显示放大的示波器视图。 

注意：可以从 Oscilloscope view 菜单 -> Window 或通过拖动窗口来

更改大小。 

步骤 4. 漏极电压脉冲（绿色）比栅极脉冲更快达到由红色圆圈包围的波

附近的 Vth。 
因为流动的电流相对较小（小于 100 A 的数量级），所以 UHCU 
输出电阻器之间的压降较小，这导致施加到漏极的电压较高。 

步骤 5. 漏极电压逐渐降低到由 UHCU 输出电阻器的负载线、UHCU 输出

电压 (45.5V) 和 MOSFET 阻抗确定的电压，直到预期的大漏极电流

稳定下来。 

步骤 6. 尝试更改延迟（可能 < 20 µs），并检查波形如何变化。 

这样，您就可以通过控制脉冲参数来控制施加到器件的电压了。 

在本例中，您可以避免施加意外的大瞬态电压而损坏器件。 

图 4-15. 如何使用示波器视图波形？ 
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两种方法提取 Rds_on： 
• Rds = Vds/Id，如果 R 与 Id 是线性关系 

或 
• Rds = delta Vds/delta Id，如果 R 与 Id 是非线性关系 

SMU2：UHCU 

SMU1：MCSMU 

2 
通过将电流补偿设置为大于 501 A 

   
Vd： 
Var1 

3 

Vg： 
Var2 

Vd 扫描条件： 
• 假设： 

- 总电阻 = 50 mΩ 
- Id 最大值 = 300 A 

1 IRFP4004PbF： 
在 Id = 195 A，Vg=10 V 时的 

Rds(on) 典型值 1.34 mΩ， 
最大值 1.7 mΩ 

Vd 最大值 = 50 mΩ x 300 A 
= 15 V 

 

预期 Rds < 2 mΩ 

演示 2-3 Rds ON 特性 
演示 2-3-1 Rds ON 特性（Rds On 与 Id 的关系） 
演示 2-3-2 Rds ON 特性（Rds On 与 Vg 的关系） 

 

目标： Rds ON 演示的目的是了解以下信息： 

● UHCU 可以输出电流源，Rds ON 测量通常使用漏极的电流源。 

● 算术运算函数可实时计算 Rds，Rds 可显示在曲线追踪仪显示器上。 

注意： 
使用传统的曲线追踪仪不可能施加恒定电流，因为它只有电压源模式。

以前，这种测量只能使用非常昂贵的生产功率器件测试仪进行。 
然而，B1505A 的 UHCU 可以轻松地执行此测量。 

 

◆ 如何测量 Rds ON 特性： 

可使用两种方法计算 Rds，如图 4-16 所示。 

本演示通过以下计算提取 Rds 导通电阻：Rds= Vds/Id（图 4-16 所示的第一

种方法）。 

我们使用一个新的算术运算函数来计算 Rds。 

注意： 

1. 第二种使用 delta 函数的方法在追踪仪测试模式中不受支持。 

2. delta 函数可以在经典测试模式中使用。 
您可以轻松地将追踪仪测试设置转换为经典测试定义。有关详

细信息，请参考第 10 章。 
 
 

图 4-16. Rds ON 特性。 
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单击目标以进行更改。 
5 

3 
6 

2 
10 

8 

4 

7 9 

1 

手动扫描从 500 mV 至 > 10 V 

◆ 演示器件： 

我们在本演示中使用了 IRFP4004 PbF 功率 MOSFET。 

Rds(on) 规格显示在第 2-3 节和第 4 节中。演示 2-1，在 Vgs=10 V 和 Id=195 A 
时，最大值为 1.7 mΩ。 

 

演示 2-3-1. Rds ON 特性（Rds On 与 Id 的关系） 

◆ Rds ON 与 Id (Rds_on - Id) 追踪仪测试设置和测量 

为了测量 Rds on 与 Id 特性的关系，我们对漏极源使用电压 Force 扫描测量。

由于 UHCU 内置有输出电阻器，因此实际电压和漏极电流是由 MOSFET 的 
导通电阻决定的。 

 

按照图 4-17 中的编号，完成后面说明的操作以设置测试。 

步骤 1. Sample setups 菜单使用 MOSFET -> Id-Vds。 

步骤 2. 如图 4-17 所示或在以下 VAR1 列表中设置 VAR1 参数。 
 

模式 起始 停止 NOS 隔行 合规性 功率补偿 
输出电压 
补偿 

LIN-SGL 500 mV 10 V 21 1 501 A 3.5 kW 2 V 
 

脉冲 

基底 

脉冲 

延迟 

脉冲 

宽度 

双 

极性 

 

保持时间 

0 V 0 s 100 µs OFF 0 s 

图 4-17. 设置 Rds ON - Id 测试。 
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2 

3 

标记读数： 
• 在 Id= 195 A 时 

Rds(on) = 1.65 mohm 

1 73 

步骤 3. 如图 4-17 所示或在以下 VAR2 列表中设置 VAR2 参数： 
 

起始 停止 NOS 合规性 功率补偿 

10 V 10 V 1 100 mA OFF 

 
步骤 4. 设置测量参数： 

- 测量时间为 50 µs。 

步骤 5. 单击 Tool bar menu -> Option -> Arithmetic Operation -> Operation 1。 
将显示 Arithmetic Operation 1。 

步骤 6. 设置以下方程式： 
RDSon [ohm] = VDS / ID 
单击目标以编辑名称或更改运算。 

步骤 7. 将 Y 轴更改为 RDSon，将 X 轴更改为 ID。

步骤 8. 将 Y 轴最大值更改为 2m（欧姆）。 

步骤 9. 将 X 轴最大值更改为 250 A。 

步骤 10. 将设置名称更改为“RDS0n ID-VGS”。 

步骤 11. 按下 Single Measure 按钮开始测量，或手动扫描。 
应获得类似于图 4-18 的测量曲线。 

 

测量后，按照图 4-18 中的以下步骤提取 Rds。 

步骤 1. 单击 Marker。 

步骤 2. 标记出现在测量开始位置上，并显示标记数据。 

步骤 3. 将标记移动到 Id=195 A 附近。 

步骤 4. Rds(on) 可以从标记读数中读取。 

注意：如果通过增加 VAR1 阶跃设置更多测量点，则可以读取更接近

目标 195 A 的数据。 

图 4-18. Rds_on 与 Id 特性的关系。 
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注意：（参见编号 4） 
起始电压不应为零伏特，因为理论上电阻器会变为无穷大，因为 R=V/I，
其中在 V=0 V 时 I=0 A。 

 
此外，考虑到 SMU 的偏移电压和偏移电流，最好将起始电压设置为停

止电压的 1/10，以将测量误差减小到可以忽略不计的水平。 
 

回顾： 

● 测量得到的导通电阻为 1.65 mΩ，并且在最大规格限值 1.7 mΩ。 
 

● 将 MOSFET 的插入高度更改为夹具插座，尝试进行另一种测量。 
如果将引线插得更深，则电阻器应显示更低的电阻，因为测量值包括漏

极和源极端子的引线电阻。 

 
注意：夹具插座使用开尔文连接，夹具插座和 MOSFET 引线之间的接触

电阻影响应该是最小的。 
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单击目标以进行更改。 
5 

3 
6 

2 
9 

8 

7 
4 

1 

演示 2-3-2. Rds ON 特性（Rds On 与 Vg 的关系） 

功率 MOSFET 的数据表通常通过 Rds ON 与 Vg 来进行 Rds ON 表征。 

此部分演示了这种测试方法。 

 
◆ Rds ON 与 Id (Rds_0N - Vg) 追踪仪测试设置和测量 

为了测量 Rds on 与 Vg 特性的关系，我们对漏极使用 I Force 模式并扫描栅极。

由于 UHCU 可以驱动电流，因此可以很容易地进行测量。 
 

按照图 4-19 中的编号，完成后面说明的操作以设置测试。 

步骤 1. Sample setups 菜单使用 MOSFET -> Id-Vgs。 

步骤 2. 如图 4-19 所示或在以下 VAR1 列表中设置 VAR1 参数。 
 

模式 起始 停止 NOS 隔行 合规性 功率补偿 
输出电压 

补偿 

LIN-SGL 0 V 10 V 51 1 100 mA OFF OFF 
 
 
 
 

图 4-19. 设置 Rds ON - VGS 测试。 
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算术运算 
2 

Id=50 A 

Id=100 A 

Id=150 A 

Id=200 A 标记读数： 
• 在 Id=50 A ~ 200 A 时 

Rds(on) = 1.625 mΩ 
标记 

3 

1 

步骤 3. 如图 4-19 所示或在以下 VAR2 列表中设置 VAR2 参数： 
 

 
起始 

 
停止 

 
NOS 

 
合规性 

 
功率补偿 

V 
合规性 

50 A 200 A 4 30 V OFF OFF 

脉冲

基底 
脉冲

延迟 
脉冲

宽度 
保持时间 

 

0 A 0 s 1 ms 0 s 

 
步骤 4. 设置测量参数： 

- 测量时间为 500 µs。 

步骤 5. 单击 Tool bar menu -> Option -> Arithmetic Operation -> Operation 1。 
将显示 Arithmetic Operation 1。 

步骤 6. 设置以下方程式： 
Rd [ohm] = VDS / ID 
单击目标以编辑名称或更改运算。 

步骤 7. 将 Y 轴更改为 Rd。 

步骤 8. 将 Y 轴最大值更改为 10 m（欧姆）。

步骤 9. 将设置名称更改为 Rd-VGS。 

步骤 10. 按下 Single Measure 按钮开始测量，或手动扫描。 
应获得类似于图 4-20 的测量曲线。 

 
 

图 4-20. Rd-VGS 特性。 
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测量后，按照以下步骤提取 Rds。步骤 1.单击 Marker。 

步骤 2. 标记出现在测量开始位置上，并显示标记数据。 

步骤 3. 将标记移至 VGS=10 V。 

步骤 4. Rd on 可以从标记读数中读取：1.625 mΩ。 
在本例中，对于 50、100、150 和 200 A 的四个 Id 电流，在 Vg=10 V 时，

Rds on 值几乎相同。 
 
 
 
 

回顾： 

● Rd-Vg 图表明，MOSFET 在 Vg=5.5 ~ 6 V 左右时导通， 
这取决于漏极电流。 

● 当 Vg 增加到 10 V 时，Rd on 收敛到约 1.6 mΩ。 
 

测量结果与演示 2-3-1 和数据表规格的结果一致。 
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演示 2-4 使用追踪仪测试进行 IGBT Ic-Vc 测量 
 

目标： 了解 IGBT 测试与演示 2-1 中所示的功率 MOSFET 演示相同。 

查看第 4-4 节的演示 2-1 了解详情。 

 
演示之前： 

确保测试模块与 B1505A、EasyEX-PERT 配置设置之间的电缆已连接。 

 
◆ 设置演示器件 

 

如下图所示，将演示 IGBT 设置到夹具上。 
 

 

FGA180N33ATD 
IGBT 

 
 

下面显示了 SOA 区域的简要信息、电容信息和器件的饱和特性。请参考第 
2-3 节了解器件规格。 

 
 
 
 
 
 
 
 

G  C  E 
G C E 

器件 

电容与 Vce 的关系 
6000 

 
5000 

 
4000 

 
3000 

 
2000 

 
1000 

 
0 

1 10 30 
Vce (V) 

 
 

饱和电压与 Vge 的关系 
2
0 
 

1
6 
 

1
2 
 

8 
 

4 
 

 

0 4 8 12 16 20 

Vge (V) 

180 A 

共用发射极 
Tc=25 °C 

 
 
 
 
 
 
 
 
 
 
 
40 A 

 
 
 
 

Coss 

Crss 

Ciss 

最大安全工作区 

1,000.0 

100.0 

10.0 

1.0 

Tj=150 
单脉冲 

0.1 
1 10 100 1000 

Vce (V) 

 
°C 

C 25 ° Tc= 
 注释： 

sec 1 m 

 100 µsec 

c se 10 µ 

Ic
e 

(A
) 

Vd
e 

(V
) 

电
容

 (p
F)

 



第 4 章. 演示 2-4：Ic-Vc 追踪仪测试 (IGBT) 

79 

 

 

1. 

2. 3. 

IC-VCE 设置示例 5. 

4. 

演示设置： 
 

FGA180N33ATD IGBT 的 Ic-Vc 追踪仪测试设置与演示 2-1 中的大电流功率 
MOSFET 几乎相同。 

除了下面所示的 IGBT 设置的独特部分外，基本上可参考演示 2-1。 
 

◆ 设置 SMU 资源的步骤： 
 

步骤 1. 单击 Sample setups 菜单。该菜单随即弹出。 

步骤 2. 选择 IGBT 类别将打开 IGBT 追踪仪测试定义菜单。 

步骤 3. 单击 IC-VCE 设置。将显示 IC-VCE 设置。 

步骤 4. 确保 SMU 设置如图所示。 
如果不同，请相应地重新分配漏极和栅极 SMU。 

步骤 5. 单击 Mode 列表，在列表中将 VGE 模式从 V 更改为 VPULSE。 
其他参数应与下图所示的参数相同。 

 

 
 

◆ 设置 X-Y 标度的步骤： 
 

按照演示 2-1 中的图 4-5 设置 X-Y 图形。 
 

◆ 设置 VAR1 和 VAR2 参数的步骤： 
 

设置 VAR1、VAR2 和测量时间参数，如下列表所示。 
 

VAR1 
 

模式 起始 停止 NOS 隔行 合规性 功率补偿 
输出电压 

补偿 
LIN-SGL 0 V 5 V 21 1 501 A 7 kW OFF 

 

脉冲 

基底 

脉冲 

延迟 

脉冲 

宽度 

双 

极性 

 
保持时间 

 

0 V 20 µs 80 µs OFF 0 s 
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7 kW 功率线 40 mΩ 负载线（在 VC=50 V 时） 

VAR2 
 

 
起始 

 
停止 

 
NOS 

 
合规性 

 
功率补偿 

脉冲 

基底 

脉冲 

延迟 

脉冲 

宽度 

 

保持时间 

6 V 11.5 V 7 200 mA OFF 0 V 0 s 150 µs 0 s 
 

测量 

延迟 

测量 

时间 

脉冲 

周期 
AUTO 6 µs AUTO 

注意： 
对于 VAR2 起始和停止电压，在测量时根据演示 IGBT 的 Vth 进行调整。 

 
 
 

测量和结果： 

1. 单击 Single Measure 按钮。 

2. 测量后，您将获得如图 4-21 所示的输出。 
 

◆ 回顾： 

1. 无需设置电压合规性，因为演示 IGBT 的击穿电压为 330 V，并且远高于 
UHCU 的最大电压 (= 60 V)。 

2. 演示 IGBT 的 SOA 在 100 µs 宽度的脉冲集电极电流下约为 7 kW， 
与 RFP4004 MOSFET 相比，您可以演示 UHCU 的更大功率量程。 

 
图 4-21. IC-VCE 特性。 

 

120 mΩ 负载线（在 VC=60 V 时） 
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演示 2-5 Vce(sat) 特性 
 
 

目标： Vce(sat) 演示的目的是了解以下信息： 

● UHCU 可以输出电流源，Vce(sat) 测量通常使用集电极的电流源。 

● B1505A 可轻松测量 Vce(sat) 参数。 
 

注意： 
使用传统的曲线追踪仪不可能施加恒定电流，因为它只有电压源模式。

以前，这种测量只能使用非常昂贵的生产功率器件测试仪进行。 
然而，B1505A 的 UHCU 可以轻松地执行此测量。 

 

◆ 如何测量 Vce(sat) 特性： 

扫描栅极时施加恒定电流。 
由于 UHCU 的输出中有一个内置的输出电阻器，因此在测量之前需要获

得最大电压合规性值。 

图 4-16 显示了这样一个示例计算。 
 

我们使用 500 A 量程驱动恒定电流，在这种情况下，UHCU 的输出电阻为 
120 mΩ。 

图 4-16 右下栏显示 UHCU 的最大电压要求为 32 V，以使集电极电流在 180 A 
的规格条件下勉强达到 250 A 左右。 

 
 
 
 
 

图 4-16. Rds ON 特性。 V 
 

 
UHCU 

Ic Force 

Vg 

 

I Force 
Rc：120 mΩ 

量程为  
500 A 时 

 
 

Ic-Vc 测量 

 
 

时间 

 
 

MCSMU 
 
 

GNDU 

或 I 
测量 Vc 

测量条件： 
- Ic=40 A，Vge=15 V Vce-sat 最大值=1.4 V 
- Ic=180A，Vge=15 V Vce-sat 典型值=1.68 V 

Ic SMU 测量条件：Vc 补偿 
- Vc：2 V 最小值 
- Rc：120 mΩ 
- 电流最大扫描： 250 A (>180 A) 

Vc 补偿 = 2 V + 0.12 Ω x 250 A 
>= 32 V 
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◆ 演示器件： 

我们在本演示中使用了 FGA180N33ATD IGBT。 

Vce(sat) 规格显示在第 2-3 部分和第 4 部分中。演示 2-4，
VCE(sat)：在 Ic=180A 时典型值为 1.68 V。 

 
演示 2-5. Rds ON 特性（Rds On 与 Id 的关系） 

◆ Vce(sat) 追踪仪测试设置和测量 

按照以下步骤和图中所示的编号进行操作。 

步骤 1. 选择 Sample Setups -> IGBT -> IC-VGE。 

步骤 2. 更改 SMU3:UHC 模式：从“VPULSE”更改为“IPULSE”。 

步骤 3. 如图 4-17 所示或在以下 VAR1 列表中设置 VAR1 参数。 
 

模式 起始 停止 NOS 隔行 合规性 功率补偿 
输出电压 

补偿 

LIN-SGL 0 V 10 V 51 1 100 mA OFF OFF 

步骤 4. 如图 4-17 所示或在以下 VAR2 列表中设置 VAR2 参数。 
 

 
起始 

 
停止 

 
NOS 

 
合规性 

 
功率补偿 

V 
合规性 

40 A 180 A 3 60 V OFF OFF 

脉冲

基底 
脉冲

延迟 
脉冲

宽度 保持时间 
 

0 A 0 s 200 µs 0 s 

图 4-17. Vce(sat) 设置。 9 

3 4 

8 10 

7 
6 

1 

5 1b. 

1c. 
2 



第 4 章. 演示 2-5：Vce(sat) 特性 (IGBT) 

83 

 

 

1

 

132. 
 标记 

121. 
 

步骤 5. 设置测量时间为 100 µs。 

步骤 6. 将 Y 轴显示参数从 IC 更改为 VCE。 

步骤 7、8. 将 X 轴和 Y 轴的最大标度更改为 20 V。 

步骤 9. 单击 Repeat Measurement 按钮。 

步骤 10. 单击 Var1 停止值以激活参数更改。 
逐渐增加栅极电压至 20V。 
可获得如图 4-18 所示的 Vce-sat 曲线。 

 

◆ 分析 Vce-sat 电压的步骤： 

步骤 11. 单击 Marker 按钮。标记将显示在扫描起点上。 

步骤 12. 将标记移动到顶线 (VAR2=180 A) 的 15 V， 

这是该 IGBT 的 Vce-sat 测量条件。 

步骤 13. 读取 Vce-sat。 
在本例中，它约为 1.736 V，非常接近 IC=180 A 时的典型值 (1.68 V)。 

 

回顾： 

Vce(sat) 图表明，当栅极电压变高，即使超过了规定的 15 V 时，饱和电压

也会变低。 
注意：最大 Vge 的规格为 30 V。 

 

测量所得的曲线与此部分开头所示的数据表曲线一致：演示 2-4. 
 

图 4-18. Vce(sat) 分析。 
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演示 2 摘要 
 

在演示 2 中，包含下列主题： 

演示 2-1：Id-Vd 追踪仪测试 

● 用大电流 MOSFET 进行 Id-Vd 追踪仪测试。 

● 如何设置测试夹具上的电线和器件。 

● 如何在 EasyEXPERT 配置窗口中配置 UHCU。 

● 如何使用样本菜单设置追踪仪测试。 

● 如何执行交互式追踪仪测试模式扫描。 

● 如何使用三种合规性模式： 

- 电流合规性 

- 电压合规性 

- 功率合规性 

● 如何使用回放轨迹功能。 

演示 2-2. 示波器视图： 

● 如何设置和使用示波器视图。 

● 可对电压和电流波形同时进行四通道波形监测，这一独特功能仅在 
B1505A 中的曲线追踪仪模式下适用。 

演示 2-3. Rds ON 特性和演示 2-5 Vce(sat) 特性： 

● 这些使用电流源模式的测量仅适用于 B1505A。 

● 演示中的最大电流约为 200 ~ 300 A，但如果客户准备了这样的器件和

测试插座，则可以扩展到 1000 A 以上。 

演示 2-4. Ic-Vc 追踪仪测试 (IGBT)： 

● 该演示显示，除了从 IGBT 样本菜单中选择测试设置示例外，测量几乎

与功率 MOSFET 相同。 

● 市场上的 IGBT 模块是 1500 A UHCU 的一个很好的目标，它可以通过使

用带有 N1265A 垫圈插头的测试引线进行连接。 
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第 5 章. 演示 3：Id-Vgs 和 Ic-Vge 传输特性 
使用 UHCU 通过应用测试模式进行超大电流测量 

 
 

目录： 
 
 
 
 

 
目标： 

 
 
 
 
 
 
 
 
 

特性： 
 
 
 
 
 
 
 
 

使用的器件： 

5-1. 演示设置和传输特性 

5- 演示 3-1. Id-Vg 传输特性（应用测试） 

5-演示 3-2. Ic-Vg 传输特性（应用测试） 

 
本章包含以下测试。 

1. Id-Vg 应用测试 (HC MOSFET) 

2. Ic-Vg 应用测试 (IGBT) 
 

本章的目的是通过使用应用测试模式执行上述测试并了解 B1505A 的测试

序列编程能力。 
 

● Id-Vg 或 Ic-Vg 测量需要漏极或集电极电源中的恒定电压源。 
但在曲线追踪仪模式 (UHCU) 下很难实现，因为电源的输出电阻器存在

压降。电阻器的压降是未知的，因为在测量之前无法确定流向电阻器的

电流。 

● B1505A 提供的 EasyEXPERT 应用测试定义通过使用应用测试模式的编程功

能解决了这个问题。 
 

演示 3 使用以下器件： 

● IPFP4004 PbF HC MOSFET 

● FGA180N33ATD IGBT 
 

N1265A 夹具内部的接线和器件设置 
 

使用 3-1 部分和图 3-1 的相同设置。 
 
 

扩展器的 EasyEXPERT 配置 
 
 

使用第 4-2 节或演示 2 的相同配置。 
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Vg 

测量所得的 Id 

Vd 

时间 Vd 脉冲（恒定） 
Rd：量程为 1500 A 时为 40 mΩ 

（Id 补偿>501 A）量

程为 500 A 时为 120 mΩ 
（Id 补偿<=500 A） 

UHCU 

1 
Var1

 

Vg 
MCSMU 

GNDU 

5-1. 如何进行 Id-Vg 传输特性测量？ 
 

图 5-1 显示了使用 UHCU 测量 Id-Vgs 的基本测量框图和测量结果。 

固定 Vd 下的 Id-Vgs 是一项重要的测试，便于您检查功率 MOSFET 的增益

（从栅极电压到漏极电流的传输特性）。 

演示 3 显示，您可以使用样本应用测试定义，利用固定的 Vd 进行 Id-Vgs  
测试。 

下面将说明隐藏在“Id-Vgs for Expanders”应用测试下的基本思想。 
（不过，您可以跳过该说明。） 

 

按照图 5-1 中的相同编号执行以下步骤编号以理解该说明： 

步骤 1. 遗憾的是，UHCU 输出中有一个串联输出电阻器，如果存在未知 
的集电极电流，则无法在 UHCU 输出处产生恒定电压。这是因为 
UHCU 的输出电阻器 Rd 中存在压降。 

步骤 2. Id-Vgs 曲线等同于 Id-Vds 测量曲线的 Vds 处的（接步骤 3） 

步骤 3. 采样点的重绘点。 

步骤 4. UHCU 输出电压实际上通过遵循由 Rd、UHCU 设置电压和 IGBT 输出

阻抗确定的负载线施加到集电极。 
 

 
图 5-1. 扩展器 Id-Vg 应用测试的内部操作。 

 

电压 
 
 
 
 

 
 
 
 

3 在 Vd 是恒定电压时 
重绘 Id-Vds 采样。 
 
 

 

Id Vg-4 

Vg-3 

 
Vg-2 

 
 
 

2 
 

Vg 
 
 
 

 
Vg-1 

Vds扫描 1 扫描 2 扫描 3 

6 7 
在扫描 1 起始电压处的 Rd 负载线 5 Rd 的压降 

8 

4 

I
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步骤 5. 在集电极引脚处设置到 UHCU 的电压与通过 Rd 下降的电压不同。 

步骤 6. 通过从 Id-Vds 测量曲线中任意 Vg 阶跃搜索恒定 Vds 处的 Id，可以提

取目标 Vds 处的 Id。 

步骤 7. 如图 5-1 所示，通过对不同的 Vg 进行重复 Id-Vgs 扫描，可以很容易

地进行准确的 Id-Vgs 测量，尽管它比用 SMU 进行的目录测量 Id-Vg 测
试要花费更多的时间。 

步骤 8. B1505A 通过使用这种方法进行 EasyEXPERT 应用测试。 
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演示 3-1：Id-Vgs 传输特性 
 

目标： 
 
 
 

演示 3-1-1. 

● 理解即使在电源中有输出电阻器，也可以使用恒定 Vd 的 Id-Vg 传
输特性。 

● 要进行体验，您可以在数据显示（输出数据）窗口中添加分析。 

演示器件 

如下图所示，将 IRFP4004PbF 设置为 3 针直插式插座。 
 
 
 
 

G：栅极 
D：漏极 
S：源极 
C：集电极 
E：发射极 

 
IRFP4004 
HC MOS 

 

演示 3-1-2. 演示设置： 

按照下面显示的步骤和图 5-2 中的编号设置 IRFP4004PbF 的 Id-Vg 应用测试。 

步骤 1. 单击 Application Test 选项卡。 

步骤 2. 选择 IGBT 和 PowerMOSFET 类别  

步骤 3. 在搜索字段中输入“Ex”。 

只有带有“ex”的应用测试定义才会显示在 Library 字段中。 

步骤 4. 单击并选择 Id-Vgs for Expanders。 
应用测试 GUI 将显示。 

 

图 5-2. Id-Vgs 应用测试。 

 
 
 
 
 
 

G D S 
G C E 

器件 

 
 
 
 
 
 
 

G   D   S 

IGBT 和功率 MOSFET 
2 类别 

1 

4 

3 

按“Ex”筛选 



第 5 章. 演示 3：Id-Vg 和 Ic-Vg 测量 

89 

 

 

1 5 

2 

4 
 

通过设置 Debug: On，
可以监测中间 Id-Vd 
搜索扫描。 

3 

演示 3-1-3. 测试参数设置： 

按照图 5-3 中的编号，完成后面说明的操作以设置测试。 

步骤 1. 参考图 5-3 所示的输入位置，输入以下表中列出的测试参数。 

器件参数： 
 

Polariy Y1AxisIdMin Y1AxisIdMax Y2AxixGfsMin Y2AxixGfsMax 
Nch 0 A 500 A 0 S 500 S 

 
测试参数：Gate SMU2:MC 

 

VgsStart VgsStop VgsStep IgLimit VgsBase VgsWidth VgsDelay 
3V 8 V 200 mV 1A 0 V 100 µs 0 s 

测试参数：Drain SMU3: UHC 
 

 
Vds 

 
IdLimit 

 
VdsBase 

 
VdsWidth 

 
VdsDelay 

Pulse P 

模式 

Man P 

周期 

Meas 

时间 

Pulse Ave 

Count 

10 V 501 A 0 V 70 µs 10 µs AUTO 100 ms 10 µs 1 

 
步骤 2. 单击 Extended Setup 

Extended Setup 窗口将打开。 
 
 
 

图 5-3. Id-Vg 应用测试参数。 
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6 

8 

7 

步骤 2. 单击 Extended Setup 
 Extended Setup 窗口将打开。 

步骤 3. 输入以下参数。 
保持其他参数不变。 

 

VsrchLimit Debug 

40 V Off 
 

步骤 4. 注意 
通过将 Debug 字段设置为 On，可以监测中间 Id-Vd 搜索扫描测量。 
请参考图 5-1 步骤 6 至 7。 

步骤 5. 单击 Single Measure 按钮。 
Display Data 窗口将打开，测量将开始。 

 

注意：由于在一个 Id-Vg 点测量之间运行一个或多个搜索扫描， 
因此需要一段时间才能完成整个 Id-Vg 扫描。 

 

最后，测量所得的 Id-Vg 和 Gfs 曲线如图 5-4 所示。 

步骤 6. 单击 Marker 图标。 
标记显示在第一个测量点上。 

步骤 7. 将标记移动到适当的数据点。 
例如，单击 Y2 轴后，Marker Maximum 图标会将标记跳转到 Gfs 最大

位置。 

步骤 8. 可以从左侧读取标记数据，分别是 X 值、Y1 值和 Y2 值。 
 

图 5-4. Id-Vgs for Expanders 应用测试结果。 
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1. 
6. 

8. 

2. 
3. 

4. 7. 

5. 

◆ 后期分析： 

您可以在 Data Display 窗口中添加后期分析。 
在此部分中，可以尝试在 Y2 轴上添加 Log Id 曲线。 

 

● 添加其他标度参数的步骤： 

参考图 5-5 中的编号，按照以下步骤进行操作。 

步骤 1. 单击 View 菜单。 

步骤 2. 单击 Display setup。 

步骤 3. Display setup 窗口将打开。 

步骤 4. 添加其他参数；对数标度中的示例 Id，最小值 = 1 A，最大值 = 1 kA。 

步骤 5. 单击 OK 将在图形显示中添加新的 Log ID 参数（Y3 轴以绿色线条 
显示）。 
单击右侧 Y 轴可以切换 Y2、Y3。 

步骤 6. 可以添加线条的图例。 

步骤 7. 您可以在 List Display 中看到 VDS 为恒定 10 V 的测试条件。 

步骤 8. 单击 Y2 轴可在 Y2 和 Y3 之间切换 Y2 轴 
 
 
 
 
 

图 5-5. Data Display 窗口中的后期分析。 
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演示 3-2：Ic-Vge 传输特性 
 
 

演示 3-2-1. 演示器件 

如下图所示，将 FGA180N33ATD IGBT 设置到 3 针直插式插座。 
 

 
 

FGA180N33ATD 
IGBT 

 
演示 3-2-2. 演示设置： 

 

按照演示 3-1-1 的相同说明操作。 

在步骤 4 中，单击并选择 Ic-Vge for Expanders 以设置应用测试 GUI。 

 
演示 3-2-3. 测试参数设置： 

输入测试参数的步骤与演示 3-2-3 部分中的功率 MOSFET 相同。 
 

步骤 1. 输入下列表中列出的测试参数。 

器件参数： 

Polariy Y1AxisIdMin Y1AxisIdMax Y2AxixGfsMin Y2AxixGfsMax 
Nch 0 A 500 A 0 S 100 S 

测试参数：Gate SMU2:MC 

VgeStart VgeStop VgeStep IgLimit VgsBase VgeWidth VgeDelay 
4V 10 V 250 mV 1A 0 V 100 µs 0 s 

测试参数：Drain SMU3: UHC 
 

 

Vce 
 

IcLimit 
 

VceBase 
 

VceWidth 
 

VceDelay 
Pulse P 
模式 

Man P 
周期 

Meas 
时间 

Pulse Ave 
Count 

20 V 501 A 0 V 70 µs 10 µs AUTO 100 ms 10 µs 1 

扩展参数： 
 

VsrchLimit Debug 
60 V Off 

 
 

步骤 2. 单击 Single Measure 按钮。 
Display Data 窗口将打开，测量将开始。 

结果如图 5-6 所示。 

 
 
 
 
 
 
 
 

G  C  E 
G C E 

器件 
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1. 
2. 3. 5. 

7. 

6. 

4. 

◆ 后期分析： 

要在 Gfs 的峰上显示标记，可参考图 5-6 中的编号按照以下步骤进行操作。 

步骤 3. 单击 Marker 图标。 
标记显示在第一个测量点上。 

步骤 4. 单击 Y2 轴。 
控制图形分析的焦点移到了 Y2 轴。 

步骤 5. 单击 Marker Maximum 图标。 

步骤 6. 标记将跳到 Gfs 最大测量点。 

步骤 7. 可以从左侧读取标记数据，分别是 X 值、Y1 值和 Y2 值。 
 
 
 
 
 
 
 
 
 
 

图 5-6. IGBT Ic-Vge for Expanders 应用测试结果。 
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演示 3 摘要 
 

在演示 3 中，包含下列主题： 

● 演示了两个应用测试。 
- Id-Vgs for Expanders 
- Ic-Vce for Expanders 

● 这两种测试都很容易测量传输特性。 
在引入 B1505A 的 UHCU 之前，在超大电流区域进行这些测试并不容易。 

● 这些测试等效地为漏极/集电极电源提供恒定电压，同时扫描栅极电压。 

● 在测量后可以轻松添加后期分析。 
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第 6 章. 演示 4：使用 HVSMU 和 HVMCU 进行高压测量 
Idss/Vdss 和高压中电流 Id-Vd 特性 

 
 

目录： 
 
 
 
 

目标： 
 
 
 
 
 
 

特性： 
 
 
 
 

使用的器件： 

6-1. 演示设置 

6- 演示 4-1. 使用 HVSMU 的 IDSS 和 BVDSS 演示 

6-演示 4-2. 使用 HVMCU 的 Id-Vd 1.1 A/2.2 kV 和 2.5 A/1.5 kV 演示 
 

本章的目的如下： 

● 使用 HVSMU 和 HVMCU 进行高压测试。 

● 了解 100 kΩ 内置串联电阻器的影响。 

● 了解高压和窄脉冲测量中 HVMCU 的操作和提示。 
 

● HVSMU 的最大电压为 3 kV 

● HVMCU 的最大输出为 1.1 A/2.2 kV 或 2.5 A/1.5 kV 
 
 
 

演示 4 使用以下器件：IXTH1N250 高压

功率 MOSFET 
- MOSFET：IXTH1N250 

o VDSS：2500 V 
o Rds(on)：最大 40 Ω 
o ID 最大值：在脉冲为 100 µs 时为 6 A，在 Tc=25 °C 时为 5 kW 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

N1265A 夹具内部的接线和器件设置： 

使用 3-1 部分和图 3-1 的相同设置。 

电容与 Vds 的关系 
10000 

1000 

100 

10 
0 10 20 

Vds (V) 

30 40 

Coss 

 Ciss 

- 由于从漏极到栅极的反馈电容器很

小，因此考虑漏极脉冲对栅极的注

入电荷的影响就不那么重要了。 
Crss 

电
容

 (p
F)
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1 

6-1. 用于 HVMCU 的 B1505A 和夹具/扩展器之间的电缆连接 
 

在演示系统中，HVMCU 配置和 UHCU 配置之间共享两个 MCSMU，如图 6-1 
所示。 

MCSMU 电缆应连接至电压/电流控制输入的 HVCE 接头（参见图 6-1 的 ）。 
这些电缆在两个模块（UHCE 和 HVCE）之间共享，必须从 N1265A UHCE 切
换到 N1266A HVCE 接头的相同名称的输入端，如图 6-1 所示。 

 

在此部分中，我们假设已完成了 UHCE 的电缆连接。 

因此，此部分将介绍如何从 N1265A UHCE 切换到 N1266A HVCE。 
 

注意：如果您从 HVCE (HVMCU) 开始 B1505A 系统设置，则参考第 2-4 节进行

电缆设置，然后按照下面的步骤继续进行 HVCE 控制 VI 电缆连接。 
 
 

图 6-1. UHCU 和 HVMCU 的基本接线框图。 
 

 
联锁 N1265A（内置选择器） 

数字 I/O 电缆（N1265A 附带） 
数字 I/O 电缆（N1266A 附带） 

B1505A 
输入 

16493T 
用于漏极 高

 

输入 
HVSMU 

输出 

输出 
高 

输入       输出 
16493

 HVSMU 

用于 HVCE MC 
MC 

F 
S 
F 
S 

1 16494A 

用于 HVCE 

电压控制 F 
电压控制 S 
电流控制 F 
电流控制 S 

MCSMU 在 HVMCE 和 UHCE 的 
控制输入配置之间共享。 

2 
16494A 

HVCE 
N1266A 

用于 UHC 
 
用于 UHC 

F 
MC S 

F 
MC S 

用于栅极 

UHC 输入 
电压控制 

电流控制 

栅极 F 
栅极 S 
选择器 SMU F 
选择器 SMU S 

16493L 16493L 
GNDU 输出 

低 GNDU GND 

F 
S 
F 
S 

MC 
MP 
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N1265A、N1266A 后面板 
N1265A 

Force 3 7 
 
Sense      1  Sense  5 Sense Sense 

4 8 

N1266A 
2 6 

HVSMU 

HCSMU 6 

Force Sense 

MCSMU 5 

MCSMU 4 

MCSMU 3 

B1505A 
后面板 Force Sense MCSMU 2 

MFCMU 

联锁 Sense 
MPSMU 1 

数字 I/O GNDU 

◆ 将 N1265A 的电压/电流控制电缆切换至 N1266A： 

按照以下步骤和图 6-2 所示的相应编号重新布置电压/电流控制电缆。 

步骤 1. 拆除连接至 N1265A 输入的“电压控制”接头 Sense 端的 16494A 三
轴电缆。 

步骤 2. 将拆下来的电缆连接至 N1266A 输入的“电压控制”接头 Sense 端。 

步骤 3. 拆除连接至 N1265A 输入的“电压控制”接头 Force 端的 16494A 三轴

电缆。 

步骤 4. 将拆下来的电缆连接至 N1266A 输入的“电压控制”接头 Force 端。 

步骤 5. 拆除连接至 N1265A 输入的“电流控制”接头 Sense 端的 16494A 三
轴电缆。 

步骤 6. 将拆下来的电缆连接至 N1266A 输入的“电流控制”接头 Sense 端。 

步骤 7. 拆除连接至 N1265A 输入的“电流控制”接头 Force 端的 16494A 三轴

电缆。 

步骤 8. 将拆下来的电缆连接至 N1266A 输入的“电流控制”接头 Force 端。 
 

图 6-2. 从 N1265A UHCE 和夹具切换的 N1266A HVCE 的电缆连接。 
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N1265A 夹具内部接线和器件设置 
 

使用 3-1 部分和图 3-1 的相同设置。 
 
 

测试器件设置 
 

如下图所示设置测试器件 (DUT)。 

我们在演示 4 中使用 HV MOSFET: IXTH1N250。 

将 MOSFET 插入 3 针插座（从左起为栅极、漏极和源极）。 

 

 
IXTH1N250 

HV MOS 

 

注意： 
插座的最大电压 
限制为 3 kV！ 

G   D   S 
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6-2. 使用 HVSMU/HVMCU 的扩展器的 EasyEXPERT 配置 

 重新配置 UHCU 配置（前提条件）的步骤： 

在配置 HVSMU/HVMCU 之前，必须重新配置 UHCU 配置以释放电压/电流控制 
MCSMU，因为这些 SMU 在两个扩展器模块之间共享。 

 

按照图 6-3 所示步骤完成后面说明的操作。 

步骤 1. 单击 Configuration 图标。 

步骤 2. 单击 UHC Expander / Fixture 选项卡。 

步骤 3. 单击并禁用 Enable Ultra Current Unit 复选框，如图所示。 
此操作将停用控制 SMU，即用于电压控制 SMU 的 SMU3 以及用于

电流控制 SMU 的 SMU4:MC。 

步骤 4. 将默认输出从 UHC 更改为没有选择（空白）  

步骤 5. 单击 Apply 按钮。 
UHCU 在配置中被禁用。 

 
 
 
 
 
 
 
 
 

图 6-3. 重新配置 UHC 扩展器以释放 UHCU 控制 SMU。 
 
 
 
 
 

1. 
2. 

3. 

4. 

5. 
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7
 

6. 8. 

4. 
5. 

◆ 配置 HVSMU 电流扩展器 (HVSMU/HVMCU)的步骤： 

按照图 6-4 所示步骤完成后面说明的操作。 

步骤 1. 单击 Configuration 图标。 

步骤 2. 单击 HVMCU Expander 选项卡。 

步骤 3. 单击并选中 Enable High Voltage Medium Current Unit 复选框。 

步骤 4. 在 HVSMU Input 选择框中选择 SMU5:HVSMU。 

步骤 5. 在电压/电流控制 SMU 的下拉列表中选择与您在 B1505A 接线部分

配置的完全相同的控制 SMU。 
即，对电压控制 SMU 选择 SMU2:MC，对电流控制 SMU 选择 SMU3:MC。

步骤 6. 单击 Apply 按钮。 
检查并应用配置。 

步骤 7. 将默认输出更改为 SMU2: HVMCU。 

步骤 8. 单击 Apply 按钮更新活动的选定模块。 

步骤 9. 前面板上的 N1266A 选择器指示灯显示当前选择器状态。 
示例设置指示 HVMC LED。 

 
 

图 6-4. 配置 HVSMU 电流扩展器 (HVSMU/HVMCU)。 
 

9. 
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2. 3
 

4. 

5. 

6
 

N1265A 夹具选择器配置的设置： 

最后，我们将设置 N1265A 夹具的选择器配置。 

图 6-5 显示了选择器设置的最终配置。 

 
◆ N1265A 选择器的最终设置： 

按照图中所示步骤完成后面说明的操作。 

步骤 1. 单击 UHC Expander / Fixture 选项卡。 

步骤 2. 在输入中为 HVSMU 设置 HVSMU。 

步骤 3. 在选择器的默认输出中设置 HVSMU。 

步骤 4. 从列表中选择 100 ohm 电阻器。 

步骤 5. 单击 Apply 按钮。 

步骤 6. 单击 Close 按钮关闭 Configuration 窗口。 
 

将 HVSMU/HVMCU 配置为与 N1265A 夹具的选择器一起使用的过程到此结束。 

N1265A 的指示灯中的 HVSMU LED 应点亮，如下图所示。 
 

图 6-5. 将 HVSMU 设置到 N1265A 选择器的最终配置。 
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图 6-6. Idss 追踪仪测试设置。 
7 

10 2 

6 

9 

8 5 4 

3 

1 

演示 4-1. 使用 HVSMU 的 IDSS 和 BVDSS 演示 

演示 4-1-1.IDSS 测量 

◆ 设置和测量 IDSS 追踪仪测试的步骤： 

按照以下步骤和图 6-6 所示的相应编号进行操作。 

步骤 1. 我们使用样本测试设置。 
单击 sample setups，然后选择 MOSFET -> ID(off)-VDS。

步骤 2. 如下表所示设置 VAR1 扫描参数。 
按照数据表中指定的值设置停止电压。(=BVDSS * 0.8 = 2,000 V) 

 
 

模式 
 

起始 
 

停止 
 

NOS 
 

隔行 
 

合规性 
 

功率补偿 
输出电压 

补偿 
保持时间 

LIN-SGL 0 V 2 kV 101 1 1 mA OFF OFF 1 s 
 

步骤 3. 如图所示设置测量时间和阶跃时间（默认值）。 
测量时间 - 20 ms，阶跃时间 = 20.1 ms。 
如果设置的测量时间非常快，则测量会产生噪音，并可能显示更

高的泄漏电流。 

步骤 4. 将 SMU 2 的 CONST 设置为 0 V，将合规性设置为 100 mA。

步骤 5. 将 X 轴最大值更改为 3 kV。 

步骤 6. 将 Y 轴最大值更改为 100 uA（25 °C 时的最大规格为 25 µA）。 

步骤 7. 单击 Single Measure 按钮。 
测量轨迹显示在显示屏上。 
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13 
14 

15 
11 

步骤 8. 单击 Marker 按钮。标记显示在 0 V 处。 

步骤 9. 将标记移至 2.0 kV。 

步骤 10. 在 2,000 V 时，将标记值读取为 IDSS。 
该示例的读数在 2,000 V 时显示 -6 nA，但该值可被视为 HVSMU 的 
1 mA 量程的噪声电平。 
由于规格限值为 25 µA，示例器件显示出非常低的泄漏电流。 

 

◆ 检测粗 BVdss 的步骤： 

按照图 6-7 的相应编号，继续执行以下步骤以计算击穿电压。 

步骤 11. 将测量时间和阶跃时间分别更改为 1 ms 和 1.1 ms。 
注意：如果这些时间太长，则通过旋钮更改停止电压后的响应时

间会变得非常缓慢。 
最快测量时间是 500 µs。 

步骤 12. 单击 Repeat Measure。 

步骤 13. 单击 Stop V 字段以激活通过旋钮更改参数。 

步骤 14. 旋转旋钮以增加最大扫描电压，以检查粗击穿电压。 

步骤 15. 在本例中，击穿电压约为 2,850 V。 
 
 
 
 
 
 
 
 

图 6-7. 使用追踪仪测试旋钮扫描进行 Bvdss 检测。 

 12 
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IGBT：FGA180N33 ATD 击穿特性 

383V/0.3 mA 

如果您的演示器件没有显示如图 6-7 所示的击穿。 
 

有时 IXTH1N250 显示非常高的电压击穿特性，如图 6-8 所示。 

在这种情况下，请尝试以下解决方法。 

解决方法 1：如果 IXTH1N250 样本在 3 kV 以下出现击穿，请尝试另一个样本。 

解决方法 2：在解决方法 1 不起作用的情况下，如果您有更多演示器件，请尝

试更多演示 1XTH1N250。 

解决方法 3：如果上述解决方法不起作用，请尝试将 HV MOSFET 改为演示 
IGBT: FGA180N33ATD。 
FGA180N33ATD 在 400 V 左右击穿（参见下图）。您只需更换器

件并将目标电压设置为大约 400 V 或最高 450 V。 
 

 

图 6-8. IXTH1N250 HV-MOSFET 高于 3 kV 击穿示例。 
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7 

2 

4 

5 

演示 4-1-2. BVDSS 测量 

◆ 设置和测量 BVDSS 追踪仪测试的步骤： 

由于我们了解击穿电压高于 2.5 kV，示例 HV MOSFET 约为 2.85 kV，因此我

们将更详细地研究 MOSFET 的击穿特性。 

 
按照以下步骤和图 6-9 的相应编号进行操作。步骤 1.将起始电压更改为  

2.5 kV，将停止电压更改为 2.6 kV。 

步骤 2. 将合规性更改为 4 mA。 

注意：HVSMU 可在 3 kV 量程内输出最大 4 mA。由于测量值非常接近 
3 kV，因此 4 mA 是我们可以用于此 MOSFET 测试的最大电流。 
注意，HVSMU 可以在 1.5 kV 量程内输出 8 mA。 

步骤 3. 将最大 ID 标度设置为 5 mA。 

步骤 4. 将最小 VDS 标度设置为 2.5 kV。 

步骤 5. 单击 Set stop condition area 图标，并使黄色信号指示灯变亮。 

步骤 6. 拖动鼠标以设置扫描停止条件区域，当测量数据到达该区域时，扫

描将停止。 

步骤 7. 单击 Repeat Measurement 按钮，并通过单击 VAR1 Stop 字段激活停

止电压字段。 
 

可以获得如图 6-10 所示的示例测试结果。 
 
 

图 6-9. Bvdss 追踪仪测试设置。 
 

单击直到黄色信号指示灯点亮。 
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步骤 8. 旋转旋钮增加电压。 

步骤 9. 当测量数据到达停止条件区域时，停止过程将开始，但在测量实际

终止之前会有一些时间延迟。 

步骤 10. 单击 Marker 图标，并检查击穿电压。 

步骤 11. 单击 Capture the reference trace 图标。 
将捕获电流轨迹以作为比较其他测量结果的参考。 

 
注意：此参考轨迹将在下一个演示中使用。 

 

回顾： 

● 当难以检测到电流突然增加的情况（如器件击穿）时，停止条件对停

止扫描非常有用。 

● 电压合规性可用于限制旋钮扫描测量中的最大电压。 
 
 
 
 
 
 
 
 

图 6-10. 通过到达停止条件区域对 BVdss 进行追踪仪测试扫描和检测。 
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1. 

2. 

3. 

4. 

演示 4-1-3. BVDSS 与 100 kΩ 串联漏极电阻器的比较。 

要进行 BVDSS 测量，可以将 100 kΩ 串联电阻器插入到 HVSMU 输出的输出端。 

通过使用 100 kΩ 电阻器，可以表征具有负电阻的器件或显示回跳特性的器件。 

下面演示 B1505A 如何使用 100 kΩ 电阻器并通过电阻器补偿电压降。 
 

◆ 设置 100 kΩ 串联电阻器的步骤： 

按照以下步骤和图 6-11 中的相应编号进行操作。 

步骤 1. 打开 EasyEXPERT 的配置，然后单击 HVSMU Current Expander 选项卡。 

步骤 2. 选中 Enable Series Resistor (100 kohm) for HVSMU 复选框。 

步骤 3. 单击 Apply 按钮。 

步骤 4. 单击 Close 按钮。 
 

注意：此外，在漏极 HVSMU 上增加 100 kΩ 串联电阻器，可以防止异常击穿

状态发生时对 DUT 造成任何潜在损坏。 
 

图 6-11. 配置 100 kΩ 电阻器。 
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◆ 使用 100 kΩ 串联电阻器进行击穿测试的步骤： 

注意：此测试是上一测试的延续。 
 

按照图 6-12 所示的步骤编号进行操作。 

步骤 1. 将停止电压设置为 3 kV。 

步骤 2. 单击 Option -> Arithmetic Operation，然后选择 Operation 1 和 
Operation 2。 

步骤 3. Arithmetic Operation 输入字段将打开。 
对运算 1 输入：Vdrp [V] = ID * 串联电阻器值。（在本例中为 98.7 kΩ） 
其中 Vdrp=电压降 * 100 kΩ 串联电阻器值。 
注意：标称 100 kohm 电阻器必须经过校准才能进行准确的击穿测量。 

步骤 4. 对运算 2 输入：VD_cmp = VDS - Vdrp 
其中 Vd_cmp 表示补偿的 VD。您可以使用 VD，因为 VD_cmp 在列

中放不下。 

步骤 5. 单击 X 轴名称字段并选择 VD_cmp。 

步骤 6. 单击 Single Measure 按钮。 
测量将开始。 

步骤 7. 扫描在 3 kV 结束，并追踪击穿曲线。 

步骤 8. 单击 Marker 按钮。标记显示在 0 V 处。 

 
 
 

图 6-12. 设置算术运算函数。 

2 
6 

3 
4 

9` 

1 

7 

9 

10 11 8 5 
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步骤 9. 将标记移动到大约 ID=0.25 mA（即击穿规格点），并将标记值读取为 
VDSS。 
在本例中，在 242 µA 时为 2.861 kV。 
在 250 µA 时，规格为最小值 2.5 kV，本例中使用的器件符合规格。 

步骤 10. 单击 Line/Dot 图标。您可以更改线型，并且可以在点线曲线显示中看

到精确的测量点，如图所示。 
正如您所看到的，不带串联电阻器的参考迹线（蓝色）的测量间隔

比带有 100 kΩ 串联电阻器的黄色迹线宽得多。 
当电流/电压曲线非常陡时，这也是使用串联电阻器的一个原因。 

步骤 11. 单击 Select reference traces 图标可打开/关闭或删除或保存参考轨迹。 
 

注意：如果增加测量点，则可以在电流读数中获得更窄的阶跃。 
 

回顾： 

● 对于电压/电流特性突然发生急剧变化（如击穿）的器件，串联电阻器

有助于精确地表征陡峭的电流/电压部分。 

● 使用串联电阻器，可以观察到具有负阻抗的击穿特性，例如回跳特性。 

● 追踪仪测试模式中的算术函数对于这种类型的测量非常有用。 
 
 
 

◆ 禁用 100 kΩ 串联电阻器的步骤： 

在进行下一个演示之前禁用 100 kΩ 电阻器。按照以下

步骤和图中的编号进行操作。 

步骤 1. 打开 EasyEXPERT 的配置，然后单击 HVSMU Current Expander 选项卡。 

步骤 2. 取消选中 Enable Series Resistor (100 kohm) for HVSMU 复选框。 

步骤 3. 单击 Apply 按钮。 

步骤 4. 注意： 
检查 N1265A LED 状态， 
确保 UHC 扩展器处于活动状态。

如果未处于活动状态，则将 UHC 
扩展器设置为活动状态。 

步骤 5. 单击 Close 按钮。 

4. 1. 

2. 

3. 

5. 
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对初始条件设置 
10 V。 
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7 
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演示 4-2. 使用 HVMCU 的 Id-Vd 1.1 A/2.2 kV 和 2.5 A/1.5 kV 演示 

演示 4-2-1. Id-Vd 1.1 A/2.2 kV 演示 

◆ 设置和测量 2.2 kV Id-Vd 特性的步骤： 

按照以下步骤和图 6-13 中的相应编号设置参数。 

步骤 1. 选择 Id-Vd 样本设置。 

步骤 2. 将 SMU2:MC 模式更改为 VPULSE。 

步骤 3. 参考图 6-13，设置 VAR1 参数，如下表所示。 
 

模式 起始 停止 NOS 隔行 合规性 功率补偿 
输出电压 

补偿 

LIN-SGL 0 V 10 V 21 1 1.1 A OFF OFF 
 

脉冲 

基底 

脉冲 

延迟 

脉冲 

宽度 

双 

极性 

 
保持时间 

 

0 V 10 µs 40 µs OFF 0 s 

步骤 4. 将初始停止电压设置为 10 V。 

步骤 5. 按如下所示设置测量时间设置。 
测量时间 = 10 µs 

步骤 6. 按如下所示设置 VAR2 参数。 
 

 
起始 

 
停止 

 
NOS 

 
合规性 

 
功率补偿 

脉冲 

基底 

脉冲 

延迟 

脉冲 

宽度 

 
保持时间 

2.8V 3.9 V 5 100 mA OFF 0 V 0 s 100 µs 0 s 

图 6-13. 使用 HVMCU 设置 2.2 kV 追踪仪测试。 
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注意：起始和停止电压可能需要根据演示 MOSFET 的 Vth 进行调整。 

步骤 7. 将 VDS X 轴最大标度设置为 2.5 kV。 

步骤 8. 将 ID Y 轴最大标度设置为 1 A。 

步骤 9. 在 1.1 A 电流合规性下，可以扫描高达 2.2 kV 的电压。HVMCU 的输出

电阻设置为 2.2 kΩ。 
白色虚线是由最大 2.2 kV 漏极电源电压和输出电阻确定的负载线。 
最大电流/电压扫描区域由这条虚线、X=0 V 线和 Y=0 A 线包围限制。 

步骤 10. 单击 Repeat Measure 按钮。 

步骤 11. 单击 Stop V 以激活修改。 
通过监测测量轨迹，旋转旋钮将最大扫描电压增加到 2.2 kV。 

注意：您可能需要更改 VAR2 起始和停止电压，以获得如图所示的

类似结果。 
您也可以通过将鼠标聚焦到这些参数来更改这些参数。 

步骤 12. 测量轨迹向箭头方向移动。 
最后，您应该获得如图 6-13 所示的类似结果。 

提示： 
注意：如果测量时间设置为 2 µs，脉冲宽度可缩小至约 30 µs。 

 
 

故障排除！ 
如果测量值停留在基线上，如图 6-14 所示。 

 

尝试以下操作来测量图 6-13 所示的图表。 

- 对于 VAR2 START：参考演示 1 设置，测量演示 IXTH1N250 HV-MOSFET 的 Vth。 
然后，通过将 Vth 舍入 0.5 V 单位来设置 VAR2 起始。例如，

如果 Vth=3.1 V，则输入 3.5 V。 

- 对于 VAR2 停止：通过向起始电压值增加 1 V 至 1.5 V 来设置 VAR2 停止。 
或者，使 VAR2 停止逐渐增加 0.5 至 1 V 阶跃，以达到最大值 6 V。 

 
 

图 6-14. VAR2 停止电压太

小时的示例。 
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◆ 示波器视图示例： 

本演示在漏极电源中使用相对较窄的脉冲 (40 µs)。 

在这种情况下，监测脉冲波形很重要。 

 
以下显示查看示波器视图波形的步骤。请参考图 6-15 所示的相应编号。 

步骤 1. 单击 Oscilloscope View 图标。 

步骤 2. Oscilloscope View 窗口将打开。 
设置示波器视图参数。 
请参考演示 2-2 来设置参数。 

步骤 3. 开始测量时将显示监测点。 

步骤 4. 将显示监测点的电压和电流值，并在示波器视图中显示波形。 
 

图 6-15. 使用 HVMCU 进行 Id-Vd 追踪仪测试的示波器视图。 
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演示 4-2-2. Id-Vd 2.5 A/1.5 kV 演示 

◆ 设置和测量 1.5 kV Id-Vd 特性的步骤： 

步骤 1. 停止电压必须小于 1.5 kV 才能使用 2.5 A 量程。 
将停止电压设置为 1.5 kV。 

步骤 2. 将合规性设置为 2.5 A。HVMCU 的输出电阻设置为 600 Ω。 

步骤 3. 将脉冲宽度更改为 30 µs。 
注意：较窄的脉冲宽度可以在 HVMCU 中产生更多的电流， 
但太短的脉冲宽度往往会增加测量不确定性。 

步骤 4. 将测量时间为 6 µs。 

步骤 5. 将 X 轴最大值更改为 1.5 kV。 

步骤 6. 将 Y 轴最大值更改为 2.5 A。 

步骤 7. 显示最大电压/电流负载线。 

步骤 8. 单击 Repeat Measure 按钮。 

步骤 9. VAR2 的起始和停止电压需要略微增加，以增加最大电流。 
以 0.1 或 0.2 伏特的步长增加电流，以便获得如图 6-16 所示的类

似测量结果。 

步骤 10. 注意：您可以更改 VAR1 的停止电压，但一旦超过 1.5 kV，电流合规

性将更改为 1.1 A，您将会看到意外的结果。 
 
 

图 6-16. 使用 HVMCU 设置 2.5 A/1.5 kV 追踪仪测试。 

8 

9 
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步骤 11. 如果从上一个演示继续，应该会出现 Oscilloscope View 窗口。 
更改垂直和水平轴标度，以正确监测波形。 

 

回顾： 

● HVMCU 涵盖了一个独特的功率量程，该量程涵盖了过去曲线追踪仪中未

涵盖的 2 A 和 2 kV 量程。 

● 该电压量程的中电流覆盖对于研究大电流条件下的击穿特性或晶圆级的 
SOA 研究非常有用。 
- HVSMU 有一个内置的输出电阻器，在器件突然击穿的情况下，对于保

护 DUT 非常有用。 

● 示波器视图适用于使用 HVMCU 进行窄脉冲测量，例如小于 30 µs 的量程 
 
 
 
 

演示 4 摘要 
 

在演示 4 中，包含下列主题： 
● 可使用 HVSMU 进行最大 3 kV 的测试。 

- 停止区域设置对于击穿测试非常有用。 
- 100 kΩ 串联电阻器和算术函数对于击穿表征非常有用。 

● HVMCU 涵盖独特的功率量程：2.5 A/1.5 kV 或 1.1 A/2.2 kV。 

● 当脉冲宽度较窄时，HVMCU 可以输出较高的电流。 
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第 7 章. 演示 5：高压 C-V 测量 
 

目录： 
 
 
 
 
 
 
 

目标： 
 
 
 
 
 

特性： 
 
 
 
 

使用的器件： 

7-1. 使用 MFCMU 和高压偏置三通进行 C-V 测量  

7-2. 演示设置 

7-演示 5-1.低电压 Cdg 测量 (40 V) 

7-演示 5-2.高压 Cdg 测量 (1.5 kV) 

7-演示 5-3.Cds、Coss 和 Cgs 测量的测试夹具连接 
 

本章的目的如下： 

● 能够使用 B1505A 进行 C-V 测量。 

● 能够使用交流保护技术测量 Cdg、Cds 和 Cgs。 
 
 
 

● 3 kV 最大直流偏置电压 

● 在超高功率直流测量仪器上集成了 C-V 测量功能。 
 
 
 

演示 5 使用以下器件： 

● IXTH1N250 高压功率 MOSFET 
 
 

电容与温度的关系（数据提取自 IXTH1N250 数据表） 
 

电容与 Vds 的关系 

10000 

1000 

100 
Coss 

10 
0 10 20 

Vds (V) 

30 40 

Crss 

 Ciss 

电
容

 (p
F)
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7-1. 使用 MFCMU 和高压偏置三通进行 C-V 测量 

7-1-1. 电容参数定义 

功率 MOS-FET 数据表中通常列出了功率 MOSFET 的下列三个电容分量。 

- Crss 反向传输电容 
- Coss 输出电容 
- Ciss 输入电容 

图 7-1 显示了功率 MOSFET 的固有电容分量，即栅极-漏极电容器 Cgd、漏极-
源极电容器 Cds 和栅极-源极电容器 Cgs。 

Crss、Coss 和 Ciss 电容分量可以通过使用 Cgd、Cds 和 Cgs 分量来计算，如图

所示。 

这一部分介绍如何测量功率 MOS-FET 的固有电容分量（Cgd、Cds 和 Cgs）。 

演示练习了 Cgd 测量。 

使用交流保护技术可以独立测量每个分量。 
 

图 7-1. Ciss：输入电容  

Ciss = Cgs + Cgd 

Coss：输出电容  

Coss = Cds + Cgd 

Crss：反向传输电容  
Crss = Cgd 

 
 

◆ MOSFET 的交流保护和电容分量测量 

下面显示了使用 B1505A MFCMU、HVSMU、N1260A 高压偏置三通和 
N1265A 夹具对每个参数进行的基本 MOSFET 电容分量测量框图。 

 
Cds 测量 N1260A/N1265A 

 
 
 
 
 

Cds 
 
 
 
 
 
 
 

该图显示 Cds 测量框图。 

直流偏压      交流信号 

~ H Cdg 
D 

Im L G 

电流表 
GND 

（交流保护） Cgs 
S 
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Im 电流表仅测量通过 Cds 分量的交流测量信号，并将其转换为 Cds。 

通过 Cdg 的交流电流在交流保护中流动，不会影响 Cds 分量。 
 
 

Cdg 测量 N1260A/N1265A 

 
 
 
 
 

Cds 
 
 
 
 
 
 
 

该图显示 Cdg 测量框图。 

Im 电流表仅测量通过 Cdg 分量的交流测量信号，并将其转换为 Cdg。 

通过 Cds 的交流电流在交流保护中流动，不会影响 Cdg 分量。 

此外，L 输入的电势几乎为 GND 电平，并且由于 Cgs 之间的电势接近零伏，

因此可以忽略分支到 Cgs 分量的 Cgd 电流。 
 

注意：由于交流保护阻抗在较高频率下会潜在增加，有时测量信号会泄漏到 Cgs 
分量，这是不可忽略的。这种影响可能会增加 Cdg 测量精度的误差。 

 
Coss 测量 N1260A/N1265A 

 
 
 
 
 

Cds 
 
 
 
 
 
 

该图显示 Coss 测量框图。 

由于栅极和源极连接在一起，所有流经 Cdg 和 Cds（等于 Coss）的电流都由 
Im 电流表测量，并转换为 Coss。 

直流偏压 交流信号 

~ H Cdg 
D 

Im L G 

电流表 
GND 

（交流保护） Cgs 
S 

直流偏压 交流信号 

~ H Cdg 
D 

Im L 

电流表 
GND 

（交流保护） Cgs 
S 
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Cgs 测量 N1260A/N1265A 

 
 
 
 
 

Cds 
 
 
 
 
 
 
 
 

该图显示了使用简单测量设置测量 Cgs 电容分量的示例配置。 

当测量 Cgs 时，一个 SMU 用于应用漏极偏置参数，它还提供交流保护能力。 

在 100 kHz 或更低的频率下，SMU 阻抗被认为非常低，并且可以用作等效的

交流保护。 

流经 Cdg 的交流信号流入 SMU，只有通过 Cgs 分量的交流测量信号由 Im 电流

表测量，并转换为 Cgs。 
 
 
 

注意： 
当频率高于 100 kHz 时，SMU 和电缆阻抗变高，不能作为交流保护。 
要在 1 MHz 下测量 Cgs，必须将一个大电容器从漏极连接到交流保护，从而

在该频率下为漏极提供等效保护。 

~ H Cdg 
D 

Im L G 

GND 
（交流保护） Cgs 

S 

MP/HP 
SMU 

F 
S 

SMU 
F 
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Hp 

Lp 
Lc 

7-2. 演示设置 
 

◆ N1260A 高压偏置三通 

为了将直流偏置电压扩展至最大 3 kV，使用了图 7-2 所示的 N1260A 高压

偏置三通。 

注意，图片被分成了两部分，以显示输入信号端子和输出信号端子。 

直流偏压由 HVSMU 通过 100 kΩ 电阻器提供。 

交流测量信号通过 110 nF 电容器提供给高输出端子。由于 110 nF 电容器

是通过与测量电容器串联来测量的，因此如果测量的电容约为 1 nF，则会

增加约 1% 的额外电容误差。 

注意：当测量的电容小于 10 nF 时，额外的误差可以大致认为是“测量的

电容/110 nF x 100%”。 
 

图 7-2. N1260A 高压偏置三通。 
 

输入侧视图 输出侧视图 
来自 HVSMU（高压三轴

接头）的偏置输入 
 
 

 
Hi 

Lo 
 
 
 
 

来自 MFCMU 的四个 
端子输入 

（BNC 接头） 

CMU 输出 
（SVH 接头） 

CMU 交流保护输出

（SVH 接头） 

 
HVSMU 

交流保护 
 

Hcur 

Hpot 

 
 
 

高 

Lpot 

Lcur 

 
 
 

低 
 
 
 
 
 
右图显示带有 N1265A UHCE/夹具的 
N1260A 配置的图像。 

 
N1260A 设置示例。 

110 nF 

10
0 

kΩ
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B1505
 N1260A 

高压偏
 

N1265A 夹具 
MFCMU 

 
HC 
HP 
LP 
LC 

HC 
HP 
LP 
LC 

H H （偏置三通） H 

L L L 

HVSMU 高
压 

GND 
（交流保护） 

MPSMU 
（对于 Cgs 测量是可选的） 

SMU1 

联锁 联锁 

（偏置三通） 

7-2-1. 高压 C-V 测量设置 

◆ N1265A、N1260A 和 B1505A 之间的连接概况 

图 7-3 显示了 B1505A 的高压 C-V 配置框图。 

B1505A 的 MFCMU 测量阻抗，HVSMU 提供最大 3 kV 直流偏压。 
这些信号被集成为 N1260A 高压偏置三通内的 C-V 测量信号，并被路由至 
N1265A 的夹具部分以与 DUT 连接。 

MFCMU 和 N1260A 高压偏置三通之间的连接使用四端子对配置。 
 

高压偏置三通和 N1265A UHCE/夹具之间的连接为双端子对配置。 
在 B1505A 通电后执行开路和短路校准，可减少与该电缆相关的误差。 

 

提供联锁电路以防止危险电压。 
 
 

图 7-3. B1505A 高压 C-V 测量框图。 
 

 
 

◆ 3 KV CV 测量配置的电缆连接 

图 7-4 显示了高压 C-V 测量配置的电缆连接概况。 

布线说明： 

按照以下步骤和图中所示的编号布置电缆。 

步骤 1. 使用 N1300A CMU 电缆，将 N1300A 的接头块侧连接到 
B1520A MFCMU。 
首先，将所有接头配对，然后将接头块插入 B1502A MFCMU 模块，

如图所示。 
安装 N1300A 接头块后，拧紧两个螺钉，将接头块牢固地安装到 
B1502A MFCMU 模块上。 
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步骤 2. 如图所示，将 N1300A CMU 电缆的四个接头的另一端连接到 N1260A 高
压偏置三通输入。 
- 将红线连接到 Hcur 
- 将橙线连接到 Hpot 
- 将灰线连接到 Lpot 
- 将黑线连接到 Lcur 接头。 
注意：保留绿线不连接。 

步骤 3. 使用 16493T 高压三轴电缆，将 B1513A HVSMU 上的 Force 接头连接到 
N1260A 的 HVSMU 输入。 

图 7-4. 高压 C-V 设置的电缆连接。 
 
 
 
 
 

5 

N1265A 4 
后面板 

Force 

Sense Sense Sense Sense 
 
 
 

B1505A 
后面板 

7 

 
 
 
 

HVSMU 

 
 
 
 

N1260A 高压偏置 
三通 
输出侧 

 
 
 

Force 

 

 
Sense 

HCSMU 6 
3 

 
MCSMU 5 

 
MCSMU 4 

 
 
 

 
输入侧 

 
 

B1505A  
后面板 

 
 

 
Sense 

1 

MCSMU 3 

MCSMU 2 2 
MFCMU 

MPSMU 1 

GNDU 
不连接 

6 
Force Sense 

数字 I/O 
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2 1 

3 

3. 发射极/ 
源极 

Force Sense Force Sense Force Sense 

2. 集电极/ 
漏极 

1. 基极 
栅极 

基极      集电极       发射极 
栅极 漏极 源极 

直插式封装插座（3 针） 

1  2  3 

步骤 4. 使用 16493V SHV 电缆，将 N1260A 的低压输出连接到 N1265A 夹具的

偏置三通输入的低压端。 

步骤 5. 使用 16493V SHV 电缆，将 N1260A 的高压输出连接到 N1265A 夹具的

偏置三通输入的高压端。 

步骤 6. 对于 Cgs 测量是可选的： 
使用 16494A 三轴电缆，将下部 B1511A MPSMU (SMU1) 上的 Force 和 
Sense 接头连接到 N1265A 上 SMU 输入 1 上的相应接头。 

步骤 7. 使用 16493J 联锁电缆，将 B1505A 上的联锁连接到 N1265A 上的联锁。 
 
 
 

7-2-2. N1265A 夹具内部的接线 
 

图 7-5 显示了用于 Cgd 测量的 N1265A UHC 扩展器/夹具内部的接线示例。 

如图 7-5 所示，在 N1265A 测试夹具的输出端子面板和直插式封装插座模块

之间布置电缆/导线。 
 
 

图 7-5. N1265A 测试夹具 Cgd C-V 测量的电缆连接。 
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◆ 接线说明：(Cgd) 

按照以下步骤和图中的编号设置夹具内的导线 
 

注意：对偏置三通输出使用 SHV 电缆，该电缆可承受高压 C-V 的 3 kV 输出。 
对其他连接使用较细的导线。 

 

步骤 1. 使用 SHV 电缆，将偏置三通输出的低压端连接到直插式封装插座上

的端子 1 Force 端 
（基极/栅极）。 

步骤 2. 使用 SHV 电缆，将偏置三通输出的高压端连接到直插式封装插座上

的端子 2 Force 端 
（集电极/漏极）。 

步骤 3. 使用通用导线，将 N1265A 夹具的 GND/（交流保护）输出连接到直

插式封装插座上的端子 3（发射极/源极）。 
 

SHV 电缆和 SHV 香蕉适配器 通用 Force/Sense 导线 
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1. 开路补偿 

2. 
从插座上取下 DUT 

7-2-3. MFCMU 开路短路补偿 

◆  对“开路”补偿执行 MFCMU 校准。 

按照以下步骤校准开路补偿。 

步骤 1. 设置测试夹具的接线。 

步骤 2. 从插座上取下任何 DUT，打开测试夹具。 

步骤 3. 执行开路校准。 
 

图 7-6. 开路补偿的设置。 
 

 
 
 
 
 

◆ 开始进行 CMU“开路”校准的步骤： 

按照图 7-7 中的编号执行以下步骤。 

步骤 1. 单击 Calibration 图标。 
Calibration 窗口将打开。 

步骤 2. 单击 CMU Calibration 选项卡。 

步骤 3. 确保对 DUT 端子进行“开路”连接。 
然后单击 Open Correction 的 Measure... 按钮  

步骤 4. 开路校正将开始。 
进行校准时，将显示 Measurement is in progress...。 

步骤 5. 校正完成后，Open Correction 复选框中会出现选中标记。 
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图 7-7. 开路校准补偿。 
 
 

1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

图 7-8. 短路补偿的

设置。 

◆ 对“短路”补偿执行 MFCMU 校准。 

按照图 7-8 中的编号执行以下步骤。 

步骤 1. 如图所示，在测试夹具插座的引脚之间使用短导线进行短接。 
如果找不到合适的导线，可使用下一步的方法。 

步骤 2. （如果跳过步骤 1，则为可选步骤。） 
如图所示，在插座模块的输入端子之间使用短电缆进行短接。 
要进行 Cgd 短路校准，可在漏极和栅极的 Sense 输入端子之间进行

短接。 

2. 

3. 

4. 

5. 

短路补偿 

2. 可选： 
将插座接头输入引脚处

的漏极栅极短接。 

1. 
将进行 Cgd 校准的漏极栅极引脚短接。 
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2. 
1. 

3. 

4. 

G D  S 

◆ 开始进行 CMU“短路”校准的步骤： 

按照图 XX 中的编号执行以下步骤。 

步骤 1. 确保对 DUT 端子进行“短路”连接。 
然后单击 Short Correction 的 Measure... 按钮开路校正将开始。 

步骤 2. 在 Measurement is in progress... 显示一段时间后， 
校正完成后，Open Correction 复选框中会出现选中标记。 

步骤 3. 单击 Close 按钮以完成 CMU 开路短路校准。 

步骤 4. 从插座模块上拆下短导线。 
将 IXTH1N250 HV MOSFET 设置到 3 端子直插式插座。 

 
 
 
 

图 7-9. 短路校准补偿。 
 

 
 

 

IXTH1N250 
HV MOS 
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3. 
8. 

4. 

1. 7. 

9. 

2. 5. 
6. 

11. 
 
 
 
 
 
 

10. 

演示 5-1. 低电压 Cdg 测量 (40 V) 
 

1. 设置 C-V 扫描测量（经典测试）的步骤： 

按照图 7-10 中的编号执行以下步骤。 

步骤 1. 单击 Classic Test 选项卡。 

步骤 2. 单击 C-V Sweep 图标。 

步骤 3. C-V 扫描设置，Channel Setup 页面将打开。 

步骤 4. 单击 Add SMU。 
New Unit 字段将打开。 

步骤 5. 单击 Unit 字段。 
下拉菜单中列出了可用模块。 

步骤 6. 单击 SMU6: HV 将 HVSMU 设置为直流扫描源。 

步骤 7. 单击 SMU1:MP 以选中单选按钮。 

步骤 8. 单击 Delete 按钮。 
SMU1:MP 字段将被删除。 

步骤 9. 重复步骤 7 和 8，保留两行用于 CMU1:MF 和 SMU6:HV。 
 
 

图 7-10. Cdg 经典测试设置 - Channel Setup 选项卡。 
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1. 

4. 

2. 

3. 

步骤 10. 按如下方式更改 SMU6:HV 参数： 
- VBias： VD 
- I Name: ID 
- Mode: V 
- Function: VAR1 

步骤 11. 将 Setup Name 更改为 Cgd-V Sweep 
 
 
 

2. 设置测量参数。 

按照图 7-11 中的编号执行以下步骤。 

步骤 1. 单击 Measurement Setup 选项卡。 

步骤 2. 如图所示，更改起始、停止、阶跃和合规性参数。 
- Start: 0 V 
- Stop: 40 V 
- Step: 200 mV 
- Compliance: 8 mA 

步骤 3. 设置 Delay 时间： 
- Delay: 200 ms 

步骤 4. 设置 Frequency： 
- List: 1 MHz 

 
 
 

图 7-11. Cdg 经典测试设置 - Channel Setup 选项卡。 
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3. 设置显示参数。 

按照图 7-12 中的编号执行以下步骤。 

步骤 1. 单击 Display Setup 选项卡。 

步骤 2. 如图所示，设置 X 和 Y1 X-Y 图形参数。 

步骤 3. 如图所示，设置 List Display 参数。 

步骤 4. 确保 HV MOSFET 插在测试模块插座中。 
单击 Single Measure 按钮。 
Cgd 扫描测量将开始，并弹出显示窗口。 

步骤 5. 图 7-13 显示了 IXTH1N250 HV MOSFET 的 Cgd 扫描测量曲线示例。 

图 7-12. Cdg 经典测试设置 - Display Setup 选项卡。 
 

4.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

图 7-13. Cdg 测量示例。 

1. 

2. 

3. 
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4. 
1. 

2. 

3. 

5. 

6. 

7. 

演示 5-2. 高压 Cdg 测量 (1500 V) 
 

◆ 测量 1500 V Cgd 特性的步骤： 

按照图 7-14 中的编号，执行以下步骤以测量高压 CV 特性。 

步骤 1. 单击 Measurement Setup 选项卡。 

步骤 2. 按如下所示更改 VAR1 参数： 
- Linier/Log:  LOG10 
- Start:  100 mV 
- Stop:  1.5 kV 

步骤 3. 按如下所示更改计时参数： 
- Delay:  500 ms 

步骤 4. 将 Setup Name 更改为 Cgd-V Log sweep  

步骤 5. 单击 Display Setup 选项卡。 

步骤 6. 按如下所示更改 X 参数： 
- Scale:  Log 
- Min:  100 mV 
- Max:  1.5 kV 

 
 

图 7-14. 修改 1500V Cdg 经典测试设置 - Measurement Setup 选项卡。 
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步骤 7. 按如下所示更改 Y1 参数： 
- Scale:  Log 
- Min:  1 pF 
- Max:  1 nF 

步骤 8. 单击 Single Measure 按钮 
1.5 kV 对数扫描测量将开始。 

 

图 7-15 显示了 IXTH1N250 HV MOSFET 的 1.5 kV Cgd 对数扫描曲线示例。 
 
 
 

回顾： 

● CV 测量可以很容易地从低电压到高电压进行。 

● 最大电压可达 3 kV。 

● 将四端子对电缆通过 N1260A 高压偏置三通直接连接到 N1265A 夹具，

可以更高精度测量更大的电容，例如超过 2 nF。 
然而，在这种情况下，最大偏置电压被限制在 25 V。 

 
 
 

图 7-15. 1500 V Cdg 对数扫描测量示例。 
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演示 5-3. Cds、Coss 和 Cgs 测量的测试夹具连接 
 

此部分提供用于其他 CV 参数测量的测试夹具连接。 
 

Cds 测量： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Coss 测量： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cgs 测量： 
 

注意： 

1. Cgs 测量需要将 SMU1:MP  连接到 
N1265A 夹具的 SMU 1 Force 输入。 
- 将 SMU 1 设置为 VAR1。 
- 将 HVSMU 设置为 Const=0 V。 

2. 最大测量频率限制为 100 kHz。 

3. 使用 MPSMU 的最大固定电流量程。 

2 1 

3 
3. 发射极/ 
源极 

Force        Sense Force        Sense Force        Sense 

2. 集电极/ 
漏极 

1. 基极 
栅极 

基极       集电极      发射极 
栅极 漏极 源极 

直插式封装插座（3 针） 

1  2  3 

2 1 

3 
3. 发射极/ 
源极 

Force        Sense Force        Sense Force       Sense 

2. 集电极/ 
漏极 

1. 基极 
栅极 

基极       集电极       发射极 
栅极 漏极 源极 

直插式封装插座（3 针） 

1  2  3 

2 1 

3 
3.发射极/ 
源极 

Force        Sense Force        Sense Force        Sense 

2. 集电极/ 
漏极 

1. 基极 
栅极 

基极       集电极       发射极 
栅极 漏极 源极 

直插式封装插座（3 针） 

1  2  3 
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演示 5 摘要 
 

在演示 5 中，包含下列主题： 
● 如何配置高压 C-V 设置。 

● 如何执行开路短路误差补偿/校准。 

● 使用 N1260A 高压偏置三通，B1505A C-V 测量的最大电压为 3 kV。 
- 我们在 1.5 kV 电压下进行了演示。 
- IXTH1N250 MOSFET 可施加最大 2.5 kV 的电压。 

● 如果允许大约 2% 的额外误差，则使用 N1260A 高压偏置三通测量的

合理最大电容约为 2 nF。 
 

注意：在电容容量特别大的情况下，单独使用 MFCMU 可提高测量准确性。 
但是，直接连接的 MFCMU 的最大直流偏置电压被限制在 25 V。 
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第 8 章. 演示 6：使用 UHVU 进行 10 kV 测量 
 

目录： 
 
 
 
 

目标： 
 
 
 
 
 
 

特性： 
 
 
 
 

使用的器件： 

8-1. 演示设置 

8-演示 6. 高压二极管击穿测试 
 
 
 

本章的目的如下： 

● 能够使用 B1505A 的 N1268A 超高压扩展器进行超高压测量。 

● 我们使用两个串联的高压二极管，并在大约 8 kV 的电压下进行击穿测量。 
 
 
 

● 10 kV 最大直流输出用于高压器件测试。 

● 为 IGBT 等器件提供从 1500 A 到 10 kV 测试的完整解决方案 
 
 
 

演示 6 使用以下器件： 

● GP02-40 高压结型整流器 
 

 
 
 
 

主要额定值和特性 
IF(AV) 0.25 A 

VRRM 4000 V 

IFSM 15 A（60 Hz 半正弦波） 

IR 5.0 µA 

VF 30 V 

Tj 最大值 175 °C 
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联锁 联锁 
N1268A UHV 扩展器 

数字 I/O 
16493V 

数字 I/O 

B1505A 
N1265A 

UHV 高 
UHV 低 
HVSMU 

UHV H 
UHV L 

选择器 
高 
低 

HC F 
S 
F 

16494A x 45 ea. 
栅极 F 栅极 H 
栅极 S 栅极 L 

用于 UHV 

用于 UHV 

用于栅极 

MC 
MC 
MC 
MC 

F 
S 
F 
S 
F 
S 

UHC 输入 
电压控制 

电流控制 

SMU 1 SMU 1 
SMU 2 SMU 2 

16493L 
GNDU GND 

8-1. 演示设置 
 
 
8-1-1. UHVU 配置：电缆连接 

◆ N1265A、N1268A 和 B1505A 之间的连接概况 

图 8-1 显示了 B1505A 的超高压扩展器配置框图。 

使用两个 MCSMU 控制 N1268A 超高压扩展器。 

UHVU 输出连接至 N1265A 夹具的 UHVU 输入。 

数字 I/O 控制通过将 N1265A 连接到 N1268A 进行串联连接。 
联锁电路以相同的方式连接，以控制 UHVU 和测试夹具的输出。 

 

图 8-1. B1505A UHVU 测量框图。 
 
 

 
 

◆ UHVU 电缆配置 

图 8-2 显示了通过 N1268A UHVU 扩展器将 B1505A 连接到 N1265A 测试夹

具的电缆连接。 

布线说明： 

按照以下步骤和图中所示的编号布置电缆。 

步骤 1. 使用 16494A 三轴电缆，将底部第三个 SMU (MCSMU3) 上的 Force 
和 Sense 接头连接到 N1268A UHV 输入的相应“Vset/Vm SMU” 
接头。 

步骤 2. 使用 16494A 三轴电缆，将底部第四个 SMU (MCSMU4) 上的 Force 
和 Sense 接头连接到 N1268A UHV 输出的相应“Irtn SMU”接头。 
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UHV 电缆：高压侧 

 

SHV 电缆：低压侧 

步骤 3. 使用 16493V UHV 电缆，将 N1268A 的高压输出连接到 N1265A 夹
具的 UHV 高压接头。 

步骤 4. 使用 16493V SHV 电缆，将 N1268A 的高压回路输入连接到 N1265A 
夹具的 UHV 低压接头。 

步骤 5. 使用 16493G 数字 I/O 电缆，将 B1505A 上的数字 I/O 接头连接到 
N1265A UHCE/夹具上的数字 I/O 输入接头。 

步骤 6. 使用 16493G 数字 I/O 电缆，将 N1265A 上的数字 I/O 输出接头连接

到 N1268A 上的数字 I/O 接头。 

步骤 7. 使用 16493J 联锁电缆，连接 B1505A 上的联锁和 N1268A 上的联锁

输入。 

步骤 8. 使用 16493J 联锁电缆，连接 N1268A 上的联锁输出和 N1265A 上的

联锁。 

步骤 9. 将电源线连接到 B1505A、N1265A 和 N1268A。 

 
 
 
 
 

图 8-2. UHVU 的电缆连接。 
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16493V SHV 电缆：低压侧 

16493V UHV 电缆：高压侧 
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1 4 

8-1-2. UHVU 配置：测试夹具 

◆ 测试夹具准备工作 

参考图 8-3 中的编号，按照以下步骤进行操作。 

步骤 1. 拆下编号 2 所示的测试夹具插座模块。 
仅拔下测试夹具侧的电缆。 

步骤 2. 可以将电缆保留在插座模块中所示的位置中。 
将电缆保留原样，在重新配置插座时就容易得多了。 

步骤 3. 图中显示背面的绝缘板必须插在夹具上才能进行 UHVU 应用。 
将绝缘板安装在测试夹具上时，将绝缘板的四个销与测试夹具侧的

孔对准。 

步骤 4. 该图显示了绝缘板安装在 N1265A 测试夹具上后的图片。 
 
 
 

图 8-3. UHVU 的 N1265A 夹具设置。 
 

 
 
 
 
 
 
 

安装销 

2 
3 
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8-1-3. 取消选择或取消激活 UHC 和 HVMCU 配置 

首先取消选择或停用 UHC 和 HVMCU 以释放 MCSMU。 

步骤 1. 通过单击左右方向箭头，可以滚动 Configuration 菜单选项卡。 
使用此按钮并查找必要的配置选项卡（如果该选项卡在窗口中隐藏）。 

步骤 2. 单击 UHC Expander/Fixture 选项卡。 

步骤 3. 取消选中 Enable Ultra High Current Unit 复选框。 

步骤 4. 取消选中 Enable Selector 复选框。 

步骤 5. 单击 Apply。 

步骤 6. 单击 HVSMU Current expander 选项卡。 

步骤 7. 取消选中 Enable High Voltage medium Current Unit 复选框。 

步骤 8. 单击 Apply。 
 

图 8-4. 
EasyEXPERT 配置。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2
 

1
 

3
 

4
 

5
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2. 1. 

3. 
 
4. 

5. 

先打开 N1285A 电源， 
然后再按 Apply 按钮。 

6. 

◆ UHVU 配置 

按照以下步骤和图 8-5 中的编号配置用于 UHVU 的 EasyEXPERT。 

步骤 1. 通过单击左右方向箭头，可以滚动 Configuration 菜单选项卡。 
使用此按钮并查找必要的配置选项卡（如果该选项卡在窗口中隐藏）。 

步骤 2. 单击 UHV Expander 选项卡。 

步骤 3. 选中 Enable Ultra High Voltage Unit 复选框。 

步骤 4. 如图所示设置电压和电流控制 SMU。 

步骤 5. 单击 Apply。 
在此操作之前，请记住打开 N1268A 电源。 

步骤 6. 单击 Close 按钮。 
 

图 8-5. 
UHVU 的 EasyEXPERT 配置。 
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2 1 

3 

演示 6. 高压二极管击穿测试 
 

◆ UHV 电缆设置和夹具中的二极管设置演示： 

如图 8-6 所示，在 N1265A 测试夹具的输出端子面板之间布线，并夹住测试

二极管。 
 

按照以下步骤和图中所示的编号进行操作。 

步骤 1. 使用弹簧夹将 SHV 电缆连接至 N1265A 夹具的 UHV 的低压输出接头。 

步骤 2. 使用弹簧夹将 UHV 电缆连接至 N1265A 夹具的 UHV 的高压输出接头。 

步骤 3. 如图所示，连接串联二极管，将阴极侧（一端带有白色带子）连接到

高压侧弹簧夹，另一端连接到低压侧弹簧夹。 

注意：要将二极管串联起来，可扭转二极管引线，使二极管的电流方向变为

相同的。 
将二极管串联的原因是使击穿电压增加两倍左右，以在非常接近 10 kV 
最大输出时显示 UHVU 能力。 

步骤 4. 关闭 N1265A 夹具盖。 
如图 8-7 所示，确保二极管侧的高压和低压端子的任何金属部分没有

接触到 N1265A 夹具的盖子。 
 

图 8-6. 夹具内的 UHV 二极管设置。 
 

低压侧夹子 

高压侧夹子 
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确保测试电缆和 DUT 不会接触到夹具内部（绝缘板除外）。 

 
 
 

 
开始测量前按下 HV ON 键。 

图 8-7. N1265A 夹具盖关闭时的二极管视图。 
 

 
 
 
 

◆ 激活 N1268A 高压放大器的输出的步骤： 

如图 8-8 所示，在开始任何测量之前，按下 HV 按钮激活 N1268A 高压放大器

的输出。 
 

图 8-8. UHVU 激活时，HV 指示灯/按钮将亮起。 
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4 

◆ 设置二极管击穿追踪仪测试的步骤： 

按照以下步骤和图 8-9 中的编号设置二极管击穿追踪仪测试。 

步骤 1. 单击 Tracer Test 选项卡。 

步骤 2. 单击 Sample Setups 图标。

步骤 3. 按 Diode 

步骤 4. 按 IR-VR 以测量击穿特性。 
 

图 8-9. IR-VR 二极管击穿样本菜单。 
 

 
 

◆ 设置和测量 10 kV 击穿测试的步骤： 

按照以下步骤和图 8-10 所示的编号进行操作。 

步骤 1. 确保在 Unit 字段中设置了 UHVU。 

步骤 2. 设置停止电压： 
- 例如 1V，作为测量的启动检查。 

步骤 3. 如图所示设置参数。 
- NOS:  101 
- Compliance: 100 uA 

步骤 4. 如图所示设置参数。 
- 测量Time:  10 µs 
- Step Time:  500 µs  

步骤 5. 将 X 轴最大值设置为 10 kV。 

步骤 6. 将 Y 轴最大值设置为 100 uA。 

步骤 7. Y 轴最小值为 0 A。 

可选：如果泄漏电流测量值显示负值，且显示器上未显示轨迹，

则将 Y 轴最小值设置为 -10 uA 以显示轨迹。 
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请参考图 8-11 中从步骤 8 开始的步骤。 

步骤 8. 单击停止条件设置图标（黄色信号灯点亮）。 

步骤 9. 拖动要在测量数据到达区域时停止扫描的区域。 

步骤 10. 按 Repeat Measurement 按钮。 

步骤 11. 单击 Stop voltage 以激活输入 

步骤 12. 向右旋转旋钮以增加扫描最大电压。 
扫描宽度向右方增长。 

步骤 13. 扫描轨迹向右方增长。 
 

图 8-10. UHV 10 kV 测试参数设置 1。 

图 8-11. UHV 10 kV 测试参数设置 2 和旋钮扫描。 
10 

 
 

9 

11 
 
 
 

拖动以设置停止条件区域 
 
 

13 

 
8 

 
 

12 
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请参考图 8-12 中从步骤 14 开始的步骤。 

步骤 14. 最后，当测量到达停止条件区域时，二极管将击穿，扫描将自动停止。 

步骤 15. 单击 Marker 图标。 
标记将显示在测量起点上。 

步骤 16. 将标记移动到击穿起点。 

步骤 17. 您可以读取标记的击穿电压和电流。 

步骤 18. 单击 Replay Traces 图标。 

步骤 19. Replay Trace 控制窗口将打开。 

步骤 20. 抓住短条并将其移到左侧将回调测量轨迹，直到发生击穿为止。 
回放轨迹功能非常有用，尤其是当器件损坏或无法重新创建相同的

测试时。 
 

注意：您可以保存轨迹，并在以后回调以进行离线查看。 
 

回顾： 

● 该示例显示在 9.4 kV 左右发生的击穿。 
由于二极管规格中的击穿电压最小为 4 kV，因此在两个二极管串联的情况

下，演示示例中的 9.4 kV 击穿电压是合理的。 
 
 
 
 

图 8-12. UHV 10 kV 击穿测试示例和分析。 
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目录： 

 
 
 

目标： 
 
 
 

 
特性： 

 
 
 
 
 
 
 
 

 
 

使用的器件： 

演示 7. 使用热触发进行 Vth 偏移测量 
 
 
 

本章的目的如下： 

● 了解热触发功能。 

● 使用热触发功能，体验 Vth 偏移与外壳温度测量值的关系。 
 

● 使用热触发功能可以轻松获取温度相关参数。 

● 温度相关参数示例： 
- 传输特性（Vth、Vgs-off） 
- 饱和电压 
- 导通电阻 
- 击穿电压 
- 正向压降（二极管）

IRFP4004 HC MOS 

 
 
 
 

 
Vth 与从 IRFP4004PbF 数据表中提取的温度数据的关系 

 
 
 

  

  

Vg
s(

th
) (

V)
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使用热触发功能进行 Vth 偏移测量的测试流程： 

热触发演示测量功率 MOSFET 的 Vth 漂移。 

测试过程如图 9-1 所示。 

参考图中所示的编号按照以下步骤进行操作。 

步骤 1. 首先，利用 Ig-Vd 重复测量的自加热功能来加热 MOSFET 的外壳/ 
主体温度。 

步骤 2.在温度上升约 8 °C 后，我们使用热触发功能开始 Vth 测量。 

步骤 3.每个 Vth 测量都是通过遵循预定义的热触发列表来触发的。 

步骤 4. 在演示中，使用了两个热电偶，一个用于测量 MOSFET 主体温度，

另一个用于测量测试夹具温度，以作为测量 MOSFET 相对温升的 
参考。 

 
图 9-1. Vth 偏移测量的测试流程。 

 

IRFP4004 
HC MOS 
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3.发射极/ -- 
源极 

+ -- + 

1 2 
N1265A-041 

热电偶（3m 导线） 
Force Sense Force Sense Force Sense 

2. 集电极/ 
漏极 

1. 基极 
栅极 

基极       集电极       发射极 
栅极 漏极 源极 

直插式封装插座（3 针） 

1  2  3 

如图所示，在 N1265A 测试夹具的输出端子面板和直插式封装插座模块之间

布线。 
 

◆ 接线说明： 

SMU 接线与第 3-1 节中的 Vth 测量相同。参考第 3-1 节设置测

试夹具内的接线。 

将热电偶设置到 N1265A 夹具的步骤： 

- 如图 9-2 所示，将两个热电偶设置到“K”热电偶编号 1 和编号 2 输入

插座。 
注意：详情如下所示。 

 

图 9-2. 热触发接线。 
 

 

图 9-3. 热电偶设置。  
 

K 型热电偶插头 

1 2 
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◆ 热电偶设置： 

按照以下步骤和图 9-3 所示的编号设置热电偶。 

步骤 1. 将热电偶 K 插座插到 N1265A 编号 2 热电偶输入插座上。 

步骤 2. 图片显示了放大的插座。 
步骤 3. 如图所示插入热电偶插座。 

插座有厚（- 标记）端和薄（+ 标记）端，在与插座模块匹配时要

符合相同类型。 
步骤 4. 图片显示了放大的插座背面。 
步骤 5. 用透明胶带把编号 2 热电偶固定在插座模块的底座上。 

步骤 6. 将另一个热电偶插到 N1265A 的编号 1 插座上。 
步骤 7. 将编号 1 热电偶插在 MOSFET 的后板上。 

 
◆ EasyEXPERT 配置设置 

在使用 UHCU 开始测量之前，需要进行 UHC 扩展器/夹具配置。 

配置 UHCU 的步骤： 

按照图 9-4 所示步骤完成后面说明的操作。 

步骤 1. 单击 Configuration 图标。 
步骤 2. 单击 UHC Expander / Fixture 选项卡。 
步骤 3. 单击并选中 Enable Ultra High Current Unit 复选框。 

注意：电压/电流控制 SMU 的设置应已完成。 
步骤 4. 单击并选中 Enable Selector 复选框。 

步骤 5. 确保选中 Enable Gate Control。 

步骤 6. 选择 SMU1:MP 作为默认输出。 

步骤 7. 对 Thermometer 字段选择 Channel 1 和 2。 
步骤 8. 单击 Apply 按钮。 

单击 Apply 按钮更新活动的选定模块。 
步骤 9. 单击 Close 按钮关闭 Configuration 窗口。 

 

图 9-4. 
EasyEXPERT  
配置：UHC。 

2. 

3. 
 

4. 
5. 

6. 

7. 

8. 

9. 
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◆ “Vth Vgs(off)”应用测试的设置： 

为了测量 Vth，我们使用了第 3 章演示 1 中使用的相同设置，如图 9-5 所示。 

按照图 9-5 所示的步骤进行操作。

步骤 1 至 5： 

使用“演示 1 Vth 测量”的相同设置。 
注意：确保以下两点： 
- MeasMode：Vth 
- 在 Id= 250 uA 时指定 Vth。 

步骤 6. 单击 Single Measure 按钮，查看得到的 Vth 是否合理。 
 
 
 
 
 

图 9-5. Vth Vgs(off) 应用测试的 Vth 设置。 
 

3. 6. 
 

1.  

4. 

2. 5. 
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◆ 设置热触发列表的步骤： 

按照以下步骤和图 9-6 中的编号进行操作。 

步骤 1. 单击 Application Test 选项卡。 

步骤 2. 单击 Run Options 按钮。

Run Option 窗口将打开。 

步骤 3. 选中 Record Test Data Automatically 复选框。 
注意：如果设置了此复选框，并且执行了除追踪仪测试模式以

外的重复测量，则单击 Repeat Measure 按钮时将打开 Repeat 
Measurement Setup 窗口。 

步骤 4. 单击 Repeat Measure 按钮。 

步骤 5. Repeat measurement Setup 窗口将打开。 

步骤 6. 选中 Automatically fill in Device ID 复选框。 

步骤 7. 选中 Enable Thermo-trigger 复选框。 

步骤 8. 单击 N1265A Thermo-trigger List... 按钮。 

步骤 9. Thermo-trigger List 框将弹出。 

步骤 10. 单击 Temp 单元格的第 1 行。 

步骤 11. 单击 T1-T2 设置。 
 

按照图 9-7 所示的步骤进行操作，从步骤 12 开始。

步骤 12. 按如下方式设置第 1 行的参数： 
- Center： 5 deg. C 
- Radius： 0.5 deg. C 
- 将其他参数保留为默认设置。 

步骤 13. 单击 Add 按钮。 
将打开新输入字段。 
如图 9-7 的 Thermo-trigger List 第 2 列所示设置参数。 

图 9-6. 设置热触发列表 1。 
 

 
1. 

3.  

4. 
9. 

10
 

2. 
5. 

11
 

6. 

7. 8. 
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步骤 14. 对热触发列表的第 3 列至第 5 列重复步骤 13，并填写下表所示的

参数。 
 

 温度 中心 半径 延迟 操作 
1 T1-T2 5 deg. C 0.5 deg. C 0 s TRG 
2 T1-T2 4 °C 0.5 deg. C 0 s TRG 
3 T1-T2 3 °C 0.5 deg. C 0 s TRG 
4 T1-T2 2 °C 0.5 deg. C 0 s TRG 
5 T1-T2 1 °C 0.5 deg. C 0 s TRG 

 

步骤 15. 设置所有热触发列表后，单击 OK 按钮。 
现在，在 EasyEXPERT 菜单中设置了温度列表。 
注意：如果要重复使用该列表，则可以使用导出和导入功能。 

步骤 16. 选中 Counter reaching to: 复选框。 

步骤 17. 将计数器数设置为 5。 
由于热触发列表为 5，因此测量停止条件设置为 5. 

步骤 18. 选中 Reset counter before repeating 复选框。 
通过此设置，重复计数器在开始重复测量时将重置为零，并且计数

器在每次重复测量时增加 1。 

步骤 19. 现在，我们要在此时单击 Cancel 以返回设置，因为必须先开始自加热

测量。 
 
 

图 9-7. 设置热触发列表 2。 
 
 
 
 
 
 

14. 
 
 
 
 
 
 
 
 

16. 
18. 

13. 

12
 

15. 

17. 

19. 
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◆ 自加热的 ID-VDS 追踪仪测试设置： 

按照以下步骤和图 9-8 所示的编号设置 ID-VDS 追踪仪测试。 

步骤 1. 通过选择 ID-VDS 样本菜单设置以下 VAR1 和 VAR2 测试参数。 
 

VAR1 
 
 
 
 
 
 
 
 

VAR2 

 

模式 起始 停止 NOS 隔行 合规性 功率补偿 
输出电压 

补偿 

LIN-SGL 0 V 60 V 21 1 501 A 3 kW 35 V 

脉冲 

基底 

脉冲 

延迟 

脉冲 

宽度 

双 

极性 

 
保持时间 

 

0 V 0 s 100 µs OFF 0 s 

 
 

起始 
 

停止 
 

NOS 
 

合规性 
 
功率补偿 

脉冲 

基底 

脉冲 

延迟 

脉冲 

宽度 

 

保持时间 

4.5 V 6.5 V 5 100 mA OFF 0 V 0 s 120 µs 0 s 
 

步骤 2. 现在，热电偶温度在该字段中是实时显示的。 
单击该字段并设置为显示 dT: T1-T2 deg. C。 

步骤 3. 单击 Repeat Measure 按钮。 
重复测量将开始，MOSFET 的温度开始升高。 

步骤 4. 温度上升在 Thermometer 字段中实时显示。 
当 dT 达到约 8 °C 时，单击 Stop Measure 按钮以更改为热触发 Vth 
测量。 

注意：MOSFET 的温度开始冷却，我们必须在 MOSFET 冷却到 6 摄氏度 dT 之
前开始热触发 Vth 测量。 

 

图 9-8. 
ID-VDS 追踪仪

测试设置。 

4`. 
1. 

3. 

2. 
4. 
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6. 

8. 

9. 
7. 

10
 

11
 

12
 

◆ 开始热触发 Vth 测量的步骤： 
 

按照图 9-9 所示的步骤进行操作，从步骤 5 开始。

步骤 5. 单击 Application 选项卡。 
此处应该是 Vth 测量设置。 
如果不是，您可以从 My Favorite setup 或 Result 数据区域进行回调。 

步骤 6. 单击 Repeat Measure 按钮。 
Repeat Measurement Setup 窗口将打开，其中包含先前设定的条件。 

步骤 7. 单击 Run 按钮。 

步骤 8. 当在目标温度的半径范围内到达 dT 时，第一次测量将开始。 

步骤 9. 等待触发温度时，将显示目标温度。 

步骤 10. 将显示实时温度。 

步骤 11. 将重复 Vth 测量，并将热触发列表的状态更新为最新状态。 

步骤 12. dT 也会更新。 
 
 

图 9-9. 热触发 Vth 测试。 
 

5. 
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2. 

3. 
1. 

图 9-10 显示了 Vth 测量的示例数据显示。 

#1. 由热触发列表触发的 Vth 测量值保存在 Results 区域中。 

#2. 每次测量都会在 Parameter 字段中提取 Vth。 

#3. T1、T2 和 dT (=T1-T2) 将自动保存在 Device ID 字段中。 
 

我们可以很容易地提取 Vth 和 T1 数据，图 9-11 显示了根据这个演示结果绘

制的 Vth 图示例。 

图 9-11 绘制了从演示测量中提取的 T1 与 Vth 的关系。 

绘制了线性回归线，显示 IRFP4004 的 Vth 温度系数为 -9.2 mV/°C。 
 

图 9-10. 通过热触发的 Vth 显示数据。 
 

 

图 9-11. Vth 偏移与外壳温度的关系。 

IRFP4004 Vth 与外壳温度的关系 
3.21 

3.205 
3.2 

3.195 
3.19 

3.185 
3.18 

3.175 
3.17 

3.165 

Vth 

y = -0.0092x + 3.4803 

29 30 31 32 33 34 

温度 (°C) 

Vt
h 

(V
) 
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回顾： 

● 图 9-11 中提取的 Vth 温度系数为 -9.2 mV/°C。数据表中的值（参见

第 9 章第 1 页）可以读取为：在 25°C 左右的外壳温度下，ID=250 µA 
曲线的温度系数约为 -9 mV/°C。 

● 这与 B1505A 的测试结果非常吻合。 

● 我们使用自加热来提高 MOSFET 的温度，但还有另一种选择，例如使用

吹风机来预热 MOSFET。 
 
 
 

演示 7 摘要 
 

通过演示说明了以下项目： 

● 如何使用热电偶。 

● 如何操作热触发功能。 

● 使用自动分析功能，应用测试中的自动 Vth 提取功能可以轻松提取

器件参数。 

注意：使用经典测试模式可以很容易地实现自动分析功能。 
下一章将演示这样一个示例。 

● 使用数据表参数，演示结果会很好。 



第 10 章. 演示 8：追踪仪测试到经典测试的转换 

156 

 

 

 

第 10 章. 演示 8：追踪仪测试到经典测试的转换 

自动参数提取 
 
 

目录： 
 
 
 
 

目标： 
 

特性： 

10. 演示 8：追踪仪测试到经典测试的转换。 

自动参数提取。 

 
 

本演示介绍了追踪仪测试设置到新的经典测试模式测试定义的转换。 
 

通过将追踪仪测试转换为经典测试定义，可以获得以下优点。 

● 对电流测量应用自动调整量程模式（默认），量程更广，测量更准确。 
注意：追踪仪测试模式使用固定量程以保持最大速度。 

● 可以轻松添加自动分析。 

● 可以为每个测试添加更多的 X-Y 图形显示格式。 

● 列表显示可以检查许多数据和数据状态。 

● 可使用追踪仪测试样本设置菜单来设置经典测试模式定义的测量部分。 
通过使用这种方法，可以消除经典测试模式的基本测试设置的 

繁琐设置过程。 
 
 
 
 
 

 
标记读数： 

• 在 Id= 195 A 时 
Rds(on) = 1.65 mΩ 
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追踪仪测试模式 经典测试模式 
1 

4 
5 

2 

3 

6 

在演示 2-3-1 中，我们测量了 RDSon ID-VDS（参见上一页的追踪仪测试）。 

在本演示中，我们将追踪仪测试定义转换为经典测试定义，然后添加自动分

析功能。 

在经典测试定义中，我们添加了以下操作来提取 Rds。 

1. 激活标记。 

2. 将标记移动到 Id=195 A。 

3. 读取标记位置上的 Rds(on) 值。 

4. 在参数显示字段中显示 Rds (on)。 
 

◆ 将测试定义从追踪仪测试转换为经典测试的步骤： 

您可以轻松地将追踪仪测试模式定义转换为经典测试模式。 
请回调 Rds(on) 追踪仪测试设置，以将其转换为经典测试模式。 

按照以下步骤和图 10-1 所示的编号进行操作。 

步骤 1. 在 Setup Name 字段中设置适当的测试名称。(RDSon ID-VDS) 

步骤 2. 单击 My Favorite Setup 相应组上的 Save 按钮。 

步骤 3. 在本例中，追踪仪测试定义保存到 Rds_ON My Favorite 组。 

步骤 4. 单击 Classic Test 模式选项卡。

经典测试模式 GUI 将打开。 

步骤 5. 单击 My Favorite Setup 区域中的图标，选择目标追踪仪测试定义。 
在本例中，单击 RDSon ID-VDS 追踪仪测试图标。 

步骤 6. 单击 Recall 按钮。 
追踪仪测试模式定义将自动转换为经典测试模式定义。 

 

 
图 10-1. 追踪仪测试模式到经典测试模式的测试定义转换。 
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1 

4 

2 

5 

3 

6 

让我们看看转换后的经典测试定义。 

如图 10-2 所示，以下选项卡的所有参数均已转换。 

步骤 1. Channel Setup， 

步骤 2. Measurement Setup。 

步骤 3. 扫描状态相同。 

步骤 4. ADC 时间为 50 us。 

步骤 5. 脉冲设置相同。 

步骤 6. User Function：RDSon 已转换。 

步骤 7. X-Y 图形的显示设置已转换。 
请注意，为 X-Y 图形的相同参数添加了列表显示。 

 

图 10-2. 追踪仪测试模式到经典测试模式的测试定义转换。 
 

 

 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 

 
 

7 
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可以在经典测试模式中添加自动分析功能。 

◆ 添加自动分析功能的步骤： 

按照以下步骤和图 10-3 中的编号添加自动分析功能。 

步骤 1. 单击 Auto Analysis Setup 选项卡。

步骤 2. 如图所示设置标记： 
- 选中 Enable Maker 复选框。 
- 将标记分析条件输入为 ID = 195 A，这是功率 MOSFET 的规格条件。 

步骤 3. 单击 Interpolation Mode 复选框，将其设置为活动状态。

步骤 4. 单击 Function Setup 页面。 

步骤 5. 如图所示设置分析函数。 

注意：@MY1 函数读取标记的 Y1 轴数据，方程式将 @MY1 值设置为 
Rds_on 变量。 
我们将在 Parameter Display 字段中显示这些数据。 

 
 

图 10-3(a). 对经典测试定义添加自动分析。 
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从上一页继续。 

步骤 6. 单击 Display Setup 选项卡以打开其页面。 

步骤 7. 添加 X-Y 图形参数，如图 10-3(b) 所示。 

步骤 8. 在 List Display 中添加参数。 

步骤 9. 在 Parameters 字段中添加 Rds_on 参数。 

步骤 10. 设置正确的经典测试设置名称。 
示例中的“CT”表示经典测试。 

步骤 11. 单击 Save 按钮。 

步骤 12. 此操作将在经典测试模式下将新测试定义保存到 My Favorite 
Setup 组中。 

步骤 13. 单击 Single Measure 按钮。 
 
 
 

图 10-3(b). 在 Display Setup 选项卡上添加显示参数。 
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ID-VDS CT 经典测试结果如图 10-4 所示。 

按照以下步骤和图 10-4 所示的编号说明演示示例输出。 

步骤 1. X-Y 显示绘制 RDS0n - ID 曲线。 

步骤 2. 标记自动位于指定的 ID=195 A 点处。 

步骤 3. 标记 Y1 轴数据在 Parameters 字段中显示为提取的参数。 
导通电阻为 1.64 mΩ，低于 ID=195 A 处的 1.7 mΩ 规格。 

步骤 4. List display 列出所有指定的参数，并突出显示标记位置。 
 

现在，您可以方便地引用这些参数，不需要任何额外的操作。 

步骤 5. 注意，可选： 
单击 Show Graph Legend 可在 X-Y 图形上显示设置参数。 

 

图 10-4. Rds_on 与 Id 特性的关系：具有自动分析功能的经典测试结果。 
 

 
 
 

结论： 

● 将追踪仪测试转换为经典测试定义非常简单。 

● 添加自动分析和显示参数也是一项非常简单的任务。 

● 追踪仪测试模式和经典测试模式的结合使用为 B1505A 提供了易于使用的

环境。 
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第 11 章. 演示 9：报告 
在 PC 上进行数据分析 

 
目录： 演示 9：报告 

本演示处理与报告相关的主题。 

当您进行报告时，诸如分析数据、转换数据和在应用程序软件之间传输数据

等活动是必要的。 
 

演示 9 包含以下主题。 

1. Desktop EasyEXPERT 

2. 显示/回调数据 

3. 复制图形 

4. 复制列表数据 

5. 导出/导入结果数据 

6. 导出/导入我的收藏夹预设组 
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选件：使用 Desktop EasyEXPERT 

使用 Desktop EasyEXPERT 进行报告是一个不错的选择。 

● 因为它是离线的，如果您的测量数据从 B1505A 导出并导入到 Desktop 
EasyEXPERT，则可以随时访问这些测量数据。 

● 由于您可以使用 PC，因此可以使用熟悉的应用程序进一步分析测量数据

并创建报告。 

● 如果您的桌面面积很大，它肯定会改善 Desktop EasyEXPERT 和应用程序

内部的数据处理环境。 

 
注意：本演示不需要 Desktop EasyEXPERT。 

如果要使用 Desktop EasyEXPERT，请参考附录 2。 
 
 
 
 

注意：联机使用 Desktop EasyEXPERT 软件 

如果您的 PC 和 B1505A 是通过 GPIB 连接的，则可以通过与 B1505A 上的 
EasyEXPERT 完全相同的方式联机使用 Desktop EasyEXPERT。 

因此，您可以访问 B1505A 测量资源，而无需导出在离线 PC 上开发的测

试库或新设置。 

测量数据自动保存在 Desktop EasyEXPERT 上，无需从 B1505A 导出结果数

据并导入到您的 PC。 

 

1. 使用 Desktop EasyEXPERT 
 

• 离线* 测试和分析环境 
• 优点： 

• 提高效率 

• 可以随时访问 EasyEXPERT 和测量数据。 
• 在您的 PC 环境中 

• 使用熟悉的 Windows 应用程序进行测量数据处理。 
• 也许还有大屏幕工作区 

• 离线 
• 无需 B1500A 硬件 
• 测试库开发。 

 
*：如果通过 GPIB 连接到 B1500A，则可联机使用 
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回调或重新显示结果测试数据以进行分析 

可以随时回调或显示保存在 EasyEXPERT 列表数据区域中的测试结果。 

在获取所有数据后或将数据移动到 Desktop EasyEXPERT 后，可使用数据回调

功能分析数据并生成报告。 

可使用以下两种方法显示测试结果。 

Display Data：在数据显示窗口中仅显示测试数据。 
您可以对显示的数据进行分析。 

Recall：回调数据显示窗口和设置数据。 

当您需要检查测量设置，或在检查数据后希望再次进行测量时，回调数据

非常有用。 
 

◆ 回调/显示数据的步骤： 

要在 Results 区域中回调/显示数据，请参考幻灯片中的编号按照以下步骤

进行操作。 

1. 右键单击数据行，或 
选择一行 -> 单击 Results 栏打开功能菜单。 

2. 单击 Display Data 或 Recall。 

2. 回调/显示数据 
 
 
 
 
 

2. 
 
 
 
 

1. 
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复制图形绘图 

上面的幻灯片显示了复制和粘贴操作的示例。 

可将数据显示窗口中显示的图形复制到剪贴板。 

您可以将图形图像粘贴到其他 Windows 应用程序，例如文字处理软件。 
 
 
 

◆ 复制图形的步骤： 

在上面的示例中，图形图像被粘贴到写字板。 
要复制图形，请参考幻灯片中的编号按照以下步骤进行操作。 

1. 打开要复制的数据显示窗口。 

2. 从文件菜单中，选择 Data Display 窗口上的 Edit > Copy Graph 菜单。 

3. 打开写字板（或其他应用程序） 
- 选择写字板上的 Edit > Paste 菜单。 

3. 复制图形绘图 
2. 

粘贴到写字板 
 
 
 

1. 
3. 
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复制列表数据 

上面的幻灯片显示了复制和粘贴操作的示例。 

可将数据显示窗口中显示的数据列表复制到剪贴板。 

您可以将数据粘贴到其他 Windows 应用程序，例如 Windows 记事本软件。 

 
◆ 复制列表数据的步骤： 

在上面的示例中，数据列表被粘贴到记事本。 

要复制列表数据，请参考幻灯片中的编号按照以下步骤进行操作。 

1. 打开要复制的数据显示窗口。 

2. 从文件菜单中，选择 Data Display 窗口上的 Edit > Copy List 菜单。 

3. 打开记事本（或其他应用程序） 
- 选择记事本上的 Edit > Paste 菜单。 

 

注意：复制的数据与列表显示区域中显示的格式相同。 
如果您将数据传输到电子表格进行分析，则可能需要更改列表区域

中的数字格式。 
（参见下一页。） 

 

注意：复制参数功能 
与复制列表功能相同，复制参数功能用于复制参数区域中的数据。 

4. 复制列表数据 
2. 

粘贴到记事本 
 
 

1. 

3. 
 
 
 
 
 
 
 

 
通过电子表格软件打开 
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复制不同格式的列表数据以用于电子表格应用程序 
 

List Display 中有几种显示格式。 
上面幻灯片中显示的对话框用于设置 List Display 区域中的数据显示格式。 

◆ 打开 List Display Properties 对话框的步骤： 

要打开 List Display Properties 对话框，请参考幻灯片中的编号按照以下步骤

进行操作。 

1. 单击 List Display 区域中的 Properties... 按钮，或 

2. 选择 Data Display 窗口的 Edit > List Display Properties... 菜单。 

3. List Display Properties 框将打开。 

显示区域： 

选中以下复选框可将数据状态或物理单位添加到数据中。取消选中该框

可将其删除。 

• 数据状态：在数据之前添加或删除状态代码。 

• 物理单位：在数据之后添加或删除物理单位。 

数字格式区域： 

从以下格式中选择数据显示格式。 

• 工程格式（带单位前缀）： 
显示的数据带有小数点、SI 前缀和单位。 
示例：-1.2345 mA 

• 科学记数法： 
显示的数据带有小数点、指数部分 
（E、+/- 符号和三位数）和单位。 
示例：-1.23456789012345E-003 A 

注意： 
对于电子表格计算，使用以下属性：（仅选中 
Scientific Notation） 

4-1. 更改列表显示属性 
2. Edit > List Display Properties… 1. 

数据状态 
3. 

物理单位 

示例： C    -1.2345    V 
 
示例：-1.2345 mA 
示例：-1.23456789012345E-003 A 
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导出测量数据记录 

可将测量数据以其他应用程序可以使用的格式导出到外部文件。 

◆ 导出测试记录的步骤： 

要导出测试结果记录，请参考幻灯片中的编号按照以下步骤进行操作。 

1. 指定要导出的数据记录。 

2. 单击 Result 按钮并显示功能菜单。 

3. 从菜单列表中选择 Transport Data > Export As xxxx。 
xxx 表示可用格式。 
Windows 资源管理器将打开。 

4. 指定要保存数据的文件名和目录。 

注意：使用 Transport Data > Folder Export... 菜单，可将多个测试记录导出到一个文件中。 

可使用以下五种格式导出测试记录： 

• （压缩）测试结果文件：用于在 EasyEXPERT 之间传输。 

• CSV 文件：逗号分隔的文本文件。 

• XML 电子表格文件：使用指定的 XML 样式表创建的 XML 文件。 

• 我的格式：使用筛选器文件删除部分不必要的数据。 

• 文本文件格式：使用基于 GUI 的筛选器仅导出必要的数据。 

◆ 导出文件建议： 

有许多导出文件格式和筛选器组合。可使用筛选器从 EasyEXPERT 内部数据库中提取必

要的数据元素。 

为了便于初级用户使用并获得满意的结果，建议使用以下格式。 

• Export as Compressed Test Result...：用于在 EasyEXPERT 之间传输。 

• Export as Text File...：用于在 Windows 应用程序之间传输数据。 
使用此格式时，务必设置 Text File Export Setting...。 

5-1. 导出测试记录 
导出测试记录的 
建议格式。 

 
 

文本文件导出筛选器 GUI 
 
 
 
 

4. 
3. 

2. 

1. 
 

1. 选择要导出的数据记录，然后单击鼠标右键。 
2. 选择 Transport Data > Export As xxxx。 
要导出多个数据，请选择 Transport Data > Folder Export。 
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将测试记录导入 EasyEXPERT 

可将测量数据导入 EasyEXPERT。 

当您将数据移动到 Desktop EasyEXPERT 进行离线分析并创建报告时，此操

作非常有用。 
 

注意： 
只能导入导出为“测试结果”或“压缩测试结果”格式的文件。 

 

◆ 导入测试记录的步骤： 

要导入测试结果记录，请参考幻灯片中的编号按照以下步骤进行操作。 

1. 单击 Result 按钮并显示功能菜单。 

2. 从菜单列表中选择 Transport Data > Import...。 
Test Result Import 对话框将打开。 

3. 选择要导入的文件。 

5-2. 导入测试记录 
 
 
 

3. 
 
 
 
 

2. 
1. 
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导出/导入我的收藏夹预设组 

您可以导出/导入您的预设组。 

当您在 B1505A 和 Desktop EasyEXPERT 之间移动预设组时，此操作非常有用。 
 

◆ 导出步骤： 

要导出当前预设组，请参考幻灯片中的编号按照以下步骤进行操作。 

1. 单击 My Favorite Setup 按钮 

2. 单击 Preset group 

3. 选择 Export This Preset Group...，并指定要导出的预设组的文件夹和名称。 

◆ 导入步骤： 

要导入预设组，请参考幻灯片中的编号，按照以下步骤进行操作。 

1. 单击 My Favorite Setup 按钮 

2. 单击 Preset group 

3. 选择 Import Preset Group...，然后指定要导入的预设组。 

6. 导出/导入您的预设组 

1. 
2. 

3. 我的收藏夹设置 
按钮 
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演示 9：摘要 
 

我们了解了上面幻灯片中列出的主题/项目。 

 

演示 9：摘要 
 

我们在这个实验室学到了以下内容： 

1. Desktop EasyEXPERT 
- 离线数据处理在许多方面对提高工作效率很重要。 
- 它也可以联机使用（从 PC 控制 B1500A）。 

2. 显示/回调数据对于数据的后期处理至关重要。 
 

3. 可使用以下功能生成报告： 
- 复制图形 
- 复制列表数据 
- 导出/导入结果数据 
- 导出/导入我的收藏夹预设组 
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关闭 B1505A 
 

◆ 关闭 B1505A 的步骤： 

如果这是今天 B1505A 的最后一次演示工作， 

1. 从测试夹具上取下演示器件。 

2. 然后关闭 B1505A。 

2A. 按下待机开关（前面板右下角），或从 Start 菜单执行 
Windows 关机操作。 

2B. EasyEXPERT 关闭，Windows 将安全关闭，Keysight 
B1505A 将进入待机状态。 
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目录： 
 

附录 1. 更新 EasyEXPERT 版本 A.05.00 的应用测试库 
A1-1. 从是德科技网站下载示例文件集 A1-2.修改 Vth 测量应用测试 

附录 2. Desktop EasyEXPERT 软件  

附录 3. 退回演示 B1505A 之前 
A3-1. 保存测量的数据 
A3-2. 删除工作区和测量数据 

 

附录 4. 退回演示 B1505A 
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附录 1. 准备工作的补充信息 
 

早期的 B1505A 演示版本不包括演示中使用的版本 A.05.01 EasyEXPERT 应
用测试库。我们还需要修改两个现有的应用测试库才能满足演示要求。 

如果您的 EasyEXPERT 版本为 A.05.00，请从是德科技网站下载必要的文件，

并在开始演示之前安装它们。 
 

● 检查 EasyEXPERT 版本 

打开 EasyEXPERT 的配置窗口，如图 A1-1 所示。 

以下部分说明下载和安装过程。 
请按照以下说明操作。 

 

图 A1-1. 
 

1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A1-1. EasyEXPERT 版本 A.05.00 的新应用测试安装 
 

A1-1-1. 从是德科技网站下载示例文件集 
 

按照以下步骤从是德科技网站下载应用测试定义文件集。 

步骤： 

- 网站： 
访问 www.keysight.com/find/B1505A 并转到“技术支持”区域。

查找“B1505A MB3 Demo”和压缩文件指示符。 

- 下载： 
单击链接，可以下载“B1505A_MB3_Demo_AT.zip”应用测试库文件。 
将其保存到 B1505A Windows 系统的相应文件夹中，例如 D:/tmp 或桌面。 

2 

3 

http://www.keysight.com/find/B1505A
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5. 压缩文件已提取 

4. 按 Extract 

2. 选择 Extract All 

3. 选择/设置提取压缩

文件的文件夹 

1. 右键单击压缩文件 

A1-1-2 从 zip 压缩文件提取 

下载的文件必须提取为常规 Windows 文件格式，以便从 EasyEXPERT 读取。 

按照图 A1-2 所示的步骤，从下载的压缩文件提取文件。 

步骤 1：右键单击 B1505A_P-BJT_HB_Library.zip 文件。

步骤 2：从弹出窗口中选择 Extract All... 菜单。 

步骤 3：提取窗口将打开，然后单击 Next。 

步骤 4：选择桌面以保存从下载的压缩文件提取的文件。 
然后单击 Next。 

步骤 5：Windows 资源管理器将打开。 
所有文件都将提取到指定的文件夹下。 
在本例中为桌面上的“B1505A_MB3_Demo_AT”文件夹。 

 
 

图 A1-2. 提取下载的压缩文件 
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6. 选中 
IGBT 和 
PowerMOSFET 
复选框。 

5. 按 Open 

7. 在搜索字段中 
输入“Ex” 

8. 新应用测试 
定义 

4. 查找导入的库集，然后选

择它们。 

1. 按 Application 
Test 

3. 选择 Import Test Definition 

2. 按 Library 

A1-1-3 将下载的应用测试文件设置到 EasyEXPERT 软件 

按照以下步骤将应用测试定义导入 EasyEXPERT。 
 

[步骤] - 参见图 A1-3 

步骤 1：按 Application Test 选项卡。 

步骤 2：按 EasyEXPERT 的 Library 栏。

Library 菜单将打开 

步骤 3：从 Library 菜单中选择 Import Test Definition。 
Windows 资源管理器将打开。 

步骤 4：找到提取示例文件集的文件夹。 
选择两个应用测试定义，如图所示。 

步骤 5：按 Windows 资源管理器的 Open 按钮。 
所有应用测试定义都导入到 EasyEXPERT 应用测试库中。 

步骤 6：选中 Application Category 字段的 IGBT 和 PowerMOSFET 复选框。 
这些类别中包含的所有应用测试定义都显示在 Library 字段中。 

步骤 7：在搜索框中输入“Ex”。 
只有测试名称中带有“ex”的应用测试定义才会显示在 Library  
字段中。 

步骤 8：新的应用测试定义将显示在 Library 窗口中。 
检查这些应用测试定义是否存在。 

 
 

图 A1-3. 导入应用测试定义。 
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1. 
1. 2. 

3. 

5. 6. 

4. 

A1-2. 修改 Vth 测量应用测试定义 
 

EasyEXPERT 版本 A.05.00 中包含的以下两个应用测试定义 
不支持演示中用于测量 IGBT 和功率 MOSFET 的 Vth 的 MPSMU。 

● Vth Vgs(off)：Vth 或 Vgs(off) 测量 (A.05.00) 

● Vth Vge(off)：IGBT Vth 或 Vge(off) 测量 (A.05.00) 

在演示之前，必须修改这两个应用测试定义。 
 

注意：MPSMU 在高于 EasyEXPERT 版本 E.A.05.01 的版本中受支持，您无需

进行这一部分所描述的修改。 
 
 

A1-2-1. 修改 Vth Vgs(off) - 功率 MOSFET： 
 

按照以下步骤和图 A1-4 中的编号修改 Vth Vgs(off) 的应用测试定义。 

步骤 1. 单击 Application Test 选项卡。 

步骤 2 和 3. 选中 IGBT 和 PowerMOSFET 应用类别。 

步骤 4. 在搜索字段中输入“Vth”。 

步骤 5. 右键单击 Vth Vgs(off) 测试定义。

Application Test definition 菜单将打开。 

步骤 6. 单击 Open Definition of This Test... 
测试定义编辑器窗口将打开（图 A1-5） 

 

图 A1-4. 打开应用测试定义。 
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步骤 7. 显示测试定义编辑器。 

步骤 8. 向下滚动 Test Parameter Definitions 区域的垂直条，直到显示 Drain 项。 

步骤 9. 单击漏极项的行区域以聚焦该控件。 

步骤 10. 单击 Resource Types 按钮。 

步骤 11. Define Resource Type 窗口将打开。

步骤 12. 单击 Add 按钮。 
将添加新的资源输入字段。 

步骤 13. 从资源菜单中选择 MPSMU。 

步骤 14. MPSMU 被设置为可用资源类型。 

步骤 15. 单击 Close 按钮。 

图 A1-5. 修改应用测试定义。 
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A1-2-1.修改 Vth Vgs 
(off)： 

步骤 16. 单击 File -> Save 

步骤 16. Confirm Test Definition Overwrite 窗口将弹出。 

步骤 17. 单击 OK 以确认覆盖测试定义。 
关闭应用测试编辑器。 

 
 
 

图 A1-6. 保存新应用测试定义。 
 

 
 
 
 

A1-2-2. 修改 Vth Vge(off) - IGBT： 
 

按照图 A1-4 至 A1-6 中 Vth Vgs(off) 的相同步骤修改 Vth Vge(off) 应用

测试定义，按如下所示更改步骤 8： 
 

用以下步骤替换图 A1-5 的步骤 8 行。 

步骤 8. 向下滚动 Test Parameter Definitions 区域的垂直条，直到 
显示 Collector 项。 
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2. 

4. 

附录 2. Desktop EasyEXPERT 软件 
 

您可以在 Windows PC 上安装 Desktop EasyEXPERT 软件。 

Desktop EasyEXPERT 拥有与 B1505A 的 EasyEXPERT 完全相同的功能，它在以

下方面扩展了您的 B1505A 演示： 

1. 您可以保留在演示 B1505A 上所完成的所有测量结果，并在退

回演示 B1505A 后甚至在离线状态下回调测试结果。 

2. 您可以离线检查 EasyEXPERT 功能。 

3. 在使用 PC 软件分析数据时，您可以使用更大的 PC 窗口区域。 

4. 如果需要，您可以从 PC 控制 B1505A，就像本地 B1505A 的 
EasyEXPERT 一样。 

 

● 安装 Desktop EasyEXPERT 软件 
按照 Desktop EasyEXPERT 安装的说明操作。 

 

● 启动 Desktop EasyEXPERT（离线模式）的步骤： 

1. 单击 Windows 桌面上的 Desktop EasyEXPERT 图标。 

2. Start EasyEXPERT 窗口将打开。 
 

 
1. 

 
 

3.  
 

3. 在启动 Desktop 5. 
EasyEXPERT 之前， 
我们设置了 
Desktop EasyEXPERT  
选项，如下所示。 

步骤 1. 单击 Option。 

步骤 2. 单击 Execution Mode... 
Execution Mode 窗口将打开。 
Desktop EasyEXPERT 具有以下两种操作模式： 

1. 联机模式： 
例如 B1505A、B1500A 和 4155/56 B/C 可以通过 GPIB 控制。 

2. 离线模式： 
可以创建应用库并进行数据分析。 
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步骤 3. 我们将选择离线模式。 
选中 Offline。 

步骤 4. 选择测量型号：单击 B1505A 

步骤 5. 单击 OK，并关闭 Execution Mode 窗口。 
 
 

4. 单击 Start EasyEXPERT 按钮。 
 

离线模式 B1505A Desktop EasyEXPERT 将打开。 
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附录 3. 退回演示 B1505A 之前 
 

如果您使用 Keysight 演示 B1505A 来练习本测量手册，您可能希望保留测量数

据以供将来参考，并希望在将演示 B1505A 退回是德科技之前从中删除您的使

用记录。 

本节提供有关此主题的信息。 
 
 

A3-1. 保存测量数据 
 

可以通过多种格式保存测量数据。 
本节介绍如何将数据保存为 EasyEXPERT 格式，以便将数据导入 B1505A 或 
Desktop EasyEXPERT，从而在最大程度上对数据进行灵活管理。 

您可以下载 Desktop EasyEXPERT 软件并安装到 Windows PC。 

如果要将数据导出为 EasyEXPERT 格式，则保留本测量手册的原始应用测试库。 
在将数据上传到 Desktop EasyEXPERT 软件时，如果 EasyEXPERT 中未安装父

应用测试库，则需要在导入测量数据之前先安装应用测试库。 
 
 

[导出步骤] 

按照图 A3-1 所示的说明进行操作。图中的数字对应于以下步骤编号。 

步骤 1. 单击向上箭头以展开结果区域。 

步骤 2. 结果区域将展开，如右图所示。 

步骤 3. 选择要导出的数据。所选数据的背景颜色将更改为蓝色，如图所示。 

步骤 4. 左键单击 Results 栏。

Result 区域菜单将打开。 

步骤 5. 选择 Transport Data。 
将显示下一个菜单。 

步骤 6. 选择 Export As Compressed Test Result...。 
然后 Compressed Test Result Export 资源管理器将打开。 
输入文件名并将数据保存到适当的记录介质。 

 
 

注意：您保存的数据格式与本测量手册中使用的示例结果数据相同。 
在不同的 EasyEXPERT 软件中恢复数据时，可使用相同的步骤。 
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图 A3-1.展开 Results 区域并选择测量数据集。 

3 

2 
5 

6 

4 

1 
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2 
3 

4 
5 

6 

A3-2. 删除工作区和测量数据 
 

从演示 B1505A 中删除使用记录最简单的方法是从工作区管理页面中删除工作区。 

您可以通过标准启动过程或使用第 2-5-1 部分情况 1 的图中所示的方法打开工作

区管理页面。 

图 A3-2 显示了删除现有工作区的步骤。 
按照以下说明步骤进行操作。说明步骤与图中的编号相对应。 

请在工作时多加小心，因为数据一旦被擦除就无法恢复了。 
 
 

[删除步骤] 

步骤 1. 选中 Your Workspaces:。 

步骤 2. 按 Manage Workspace 按钮。 

步骤 3. Workspace manager 子窗口将打开。 

步骤 4. 从 Available Workspaces: 列表中选择工作区名称。 

步骤 5. 按 Delete 按钮。Confirmation 子窗口将弹出。 

步骤 6. 按 Confirmation 子窗口中的 OK 按钮。 

将从 EasyEXPERT 删除您的工作区以及所有数据和设置。 
 

图 A3-2. 从 EasyEXPERT 删除现有工作区。 
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附录 4. 退回演示 B1505A 
 

在退回演示 B1505A 时，请确保所有物品都已按照交付给您的方式包装好。 

请确保删除为演示创建的工作区，以保护您的任何私人数据。 
有关删除工作区的信息，请参考附录 B 部分。 

 

此外，请务必删除存储在 EasyEXPERT 或 Windows 文件系统中的任何机密数据。 
 
 
 

注意： 

是德科技在将演示 B1505A 出租给下一个用户时不会删除任何数据。 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

本信息如有更改，恕不另行通知。 
© 是德科技 2014 
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